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Mundarija 
 

     I Bulim: Corel DRAWda ishlash 
          1. Hujjatni yaratish va ochish 
          2. Vektorli va nuqtali (rastrli) grafika 
          3.  Obyektlar bilan ishlash 
           4. Matnlar bilan ishlash 
           5. To’ldirish (Fill) va chegaralash (Outline) parametrlari 
                                 6. Qatlamlar bilan ishlash 
                                 7. Rangli va vektorli effektlar 
           8. Tasvirlarni import va eksportlash 
             9. Rasrtli tasvirlar bilan ishlash, o’zgartirish. 
          10. Ko’p sahifali hujjatlar bilan ishlash 
 

II Bulim:  Macromedia Flash 
          11. Web-dizayn, Web – sayt tushunchasi va sayt tuzilishi 
          12. Macromedia Flashning asboblari 
          13 Obyektlar bilan ishlash  
          14. Ranglar bilan ishlash 
          15. Harakat 
          16. Boshqarish elementlari 
          17. Rolikni namoyish qilish 
  III Bulim:  Adobe PhotoShop grafika va fotomontaj  
        muxarriri.  

18. Adobe Photoshop dastur xakida umumiy malumot. 
19. Adobe Photoshop dasturning ish kurollari. Soxa tanlash. 
20. Adobe Photoshop dasturning ish kurollari. Rasm 
taxrirlash. 
21. Adobe Photoshop dasturning ish kurollari. Matn va grafik 
shakllar yaratish. 
22. Adobe Photoshop dasturning menyusi. Menyu Image - 
Obraz, Select - Vıbor va Edit - Redaktirovanie.Elektron 
blankalarda ruyxatlar. 
23. Adobe Photoshop dasturning menyusi. Menyu Layer - Sloi 
va Filtr - Filtr 



 3 

III   BBBuuullliiimmm   :::   CCCooorrreeelll   DDDRRRAAAWWWdddaaa   iiissshhhlllaaassshhh   
111...   HHHuuujjjjjjaaatttnnniii   yyyaaarrraaatttiiissshhh   vvvaaa   oooccchhhiiissshhh   

CorelDraw dasturi ishga tushirilgandan keyin 
ekranda COREL DRAWga XUSH KILIBSIZ 
(welcome to Corel DRAW) suzi nomayon bo’ladi va 
dasturni ishga tushirishning  bir nechta variantlarini 
tanlashni suraydi: Yangi hujjat (New Graphic), oxirgi 
ishlangan hujjatni ochish (Open Last Edited), Hujjatni 
ochish (Open Graphic), tayyor shablonlarni ochish 
(Template), dastur urgatuvchini ishga tushirish 
(CorelTUROR), Nima yangilik? (What is New?)  

Yangi hujjatni yaratish uchun menuning Fayl 
(File) va Yangi hujjat buyrugi (New) yoki 
instrumentlar panelidagi maxsus tugma bosiladi. Hujjatni ochish uchun, menuning 
Fayl (File) va Оchish (Open) buyruglari yoki instrumentlar panelidagi maxsus 
tugmalar yordamida amalga oshiriladi. 
 CorelDRAW dasturida bir vaqtning uzida bir nechta hujjatlar bilan ishlash 
imkoniyatlari bor, shu bilan birga kerak bo’lmagan hujjatlarni yopib qo’ysa ham 
bo’ladi. Bu esa menuning Fayl Yopish(Close) buyrugi erdamida amalga oshiriladi. 
DDDaaassstttuuurrr   iiinnnttteeerrrfffeeeyyysssiii   

Dast
ur ishga tushirilgandan keyin ekranda dastur oynasi nomayen bo’ladi, bu oyna 
foydalanuvchi interfeysi (user interface) yoki ishchi joyi (workspace) deb ataladi. 
Interfeys foydalanuvchi va komputer orasidagi mulahotni o’rnatadi, ishlash uchun 
kerak bo’lgan barcha sharoyotni yaratadi. 
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Shuni nazarda tutish kerakki, interfeys foydalanuvshi tomonidan uzgartilgan 
bo’lib uz ko’rinishidan o’zgacha bo’lishi ham mumkin. 

.  
Foydalanuvchi interfeysi quyidagilardan tashkil topadi: sarlavha, bosh menu, 

hujjarlarni ko’rish ushun ishchi oynalar, tasvirlarni redaktorlash ushun bir nechta 
panellar yigindisidan. 

Oynaning markazidagi katta bo’sh joy iiissshhh   jjjoooyyyiii deb nomlanib har bir hujjat 
uchun yangi ochiladi. 
BBBooossshhh   mmmeeennnuuu   

Ekranning yuqorigi qismida bosh menu buyruqlari (menu bar) joylashgan bulib 
u quyidagilardan tashkil topadi: 
• Fail (File)  
• Muharirlash (Edit) 
• Ko’rish (View) 
• Kоmpanovkalash (Layout) 
• Boshqarish (Arrange) 
• Effektlar (Effects) 

• Rastrli tasvirlar(Bitmaps) 
• Matn (Text) 
• Servis (Tools) 
• Oyna (Window) 
• Yordam (Help) 

 

 
Har bir guruh bir–biriga yaqin amallarni bajaruvchi buyruqlar yigindisi, 

masalan, Menu Matn (Text) matnlar ustida amallar bajaradigan buyruqlar, Menu 
Effektlar (Effects) – vektorli va rastrli grafikalar uchun har xil effektlar qilish va 
muharrirlashda foydalaniladigan buyruqlardan tashkil topgan. 

Shu bilan birga qo’shimcha menu (Context-sensitive menu)da kiritilgan bu 
menu vazifasi joriy bo’lgan instrumentning obyektlari haqida malumot beradi. 
VVVooosssiiitttaaalllaaarrr   sssaaatttrrrlllaaarrriii   

Menu satri tagida asboblar satri (Toolbars) joylashgan.   Asboblar satrini 
ekranning hohlagan joyida va har xil ko’rinishda joylashtirish mumkin. 

Ekranga kerakli oynalarni joriy qilish uchun menuning Oyna (Window) 
yordamida amalga oshiriladi va ular ustida quyidagi amallar bajariladi: Asboblar 
(Toolbars) satriga  sichqonchani o’ng tononi bilan chertib muloqat oynasini paydo 
etamiz va Parametrlar (Options), Rostlash dan kerakli bo’lgan asboblar tanlanadi. 
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СССвввооойййссстттвввааа    (((PPPrrrooopppeeerrrtttyyy   BBBaaarrr)))   vvvooosssiiitttaaalllaaarrr   sssaaatttrrriii   

Свойства (Property Bar) asboblar satridagi maydonlar va tugmalar yigindisi 
foydalanilayatgan asboblar yoki tanlangan obyektga bogliq bo’ladi, masalan, 
asboblar satridagi matn bloki tanlanganda matnning  parametrlari ko’rsatiladi. 

 Cвойства (Property Bar) satridagi asboblardan birontasi tanlanmagan holda 
hujjatning umumiy parametrlari ko’rsatiladi, masalan, sahifa formati, unuig 
orientatsiyasi va h. ko’rsatadi. 

 
HHHooolllaaattt   sssaaatttrrriii   (((SSStttaaatttuuusss   BBBaaarrr)))   

Ekrandagi ishchi oynaning pastgi qismida holat satri (Status Bar) joylashgan, 
bu qatarda obyektlar haqida malumotlar berilad, yoki quyidagi parametrlar: обводки 
и заливки, параметров shrift turi, tanlangan obyekt haqida malumot va joriy 
asboblar haqida malumotlar. Holat satrining ko’rinishi va tuzilishini o’zgartirish ham 
mumkin. 

 
AAAsssbbbooobbblllaaarrr   pppaaannneeellliii   (((TTToooooolllbbboooxxx)))   

Asboblar paneli ishchi oynaning chap tomoniga joylashtirilgan bo’ladi. 
Asoblar panelida grafik obyekt ustida quydagi amallar bajariladi – obyektlarni 
yaratish, obyektlarni  ajratish, muharrirlash va ko’chrish asboblari joylashtirilgan. 

Asboblar bilan ishlash paytida kursor tanlangan obyektga qarab formasini 
o’zgartiradi. Shu bilan birga, asboblar panelidagi bazi bir asboblar guruhini 
«Suzuvchi» panel ko’rinishida yoki  Flyout ko’rinishida sozlash mumkin. 

 
 
 
 

 
 

 
 
 

DDDoooccckkkeeerrr   tttiiipppiiidddaaagggiii   pppaaannneeelll   

Docker tipidagi panel mulohat oyna ko’rinishida bo’ladi. Bu panellar har doim 
ekranda mavjud bo’ladi va ishchi oyna yonida joylashadi. Ekranga kerakli bo’lgan 
panelni chaqirish uchun menuning Oyna (Window) va Docker  (Dockers…) tipidagi 
panel buyrigi va ochilgan ruyhatdagi panellardan bittasi tanlanadi. 

• Object Manager paneli (Диспетчер объектов) — obyektni parametrlarini 
tasvirlaydi, obyekt yerarhiya va qatlamlarini boshqaradi. 

• View Manager paneli (Диспетчер видов) — «tasvir ko’rinshlari» tasvirlaydi 
va boshqaradi. 
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• Graphic and Text Styles paneli (Стили текста и графики) — grafik va matnli 
stillarini yaratadi va o’zgartiradi. 

• Color Styles paneli (Цветовые стили) — obyektlar bilan ishlashda ranglarni 
tanlaydi  va ular ustida amallar bajaradi. 

• Symbols and Special Characters paneli (Символы и специальные знаки) - 
mavjud bo’lmagan belgilarni tasvirlashda foydalaniladi. 

• Internet Bookmark Manager paneli (Диспетчер закладок Internet) — 
gipermatnlarni boshqarish va yaratishda ishlatiladi. 

• HTML Object Conflict paneli (Анализатор конфликтов объектов HTML) – 
Internetda nashr etishdan avval hujjatlarni to’griligi tekshiradi va 
noto’g’rilarini tuzatadi.  

• Script and Preset Manager paneli (Диспетчер макросов и готовых образцов) 
—  makrodasturlarni oyzishda foydalaniladi. 

 
• Object Data paneli (malumotlar jamgarmasi) — har bir obyektga jadvaldagi 

malumotlar berkitiladi, masalan, narhi, o’lchami va h.malumotlar 
• Object Properties paneli (Свойства объектов) — hujjatdagi obyektlarning 

barcha parametrlarini haqida malumot beradi va uzgarish kiritadi. 
• Link Manager paneli (Диспетчер связанных изображений) — hujjatda 

mavjud emas faqat u bilan boglangan tasvirlarni boshqarish. 
• Bitmap Color Mask paneli (Цветовая маска точечного изображения) – 

rastrli tasvirlar bilan ishlashda ranglar maskasini yaratish. 
• Lens paneli (Линза) — linza turini tanlash va uning parametrlarini o’rnatish. 
• Artistic Media paneli (Имитация) — vektorli qalamning  murakkab turlari 

bilan ishlash. 
• Transformation paneli (Трансформирование) — obyektlarni siljitishning har 

xil turlari bilan ishlah. 
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• Shaping paneli (Изменение формы) — bir nechta obyektlarni uch hil 
ko’rinishda biriktirish. 

• Color (Цвет) va Color Palette Browser (Цветовые палитры) panellari — 
ranglar bilan ishlash. 

• Browse (Обзор) paneli — hujjatlarni boshqarish va ularni har hil 
ko’rinishlarda ko’rish. 

• Cliparts (Векторные изображения), Photos (Фотографии), 3Dmodels 
(Трехмерные модели) panellari — dastur bilan birgalikda o’rnatilgan 
kompakt disklar bilan ishlash (CD-ROM).  

• FTP Sites (Сайты FTP) paneli — FTP saytlarini saqlash va katta massivli 
malumotlarni ko’chirish uchun ular bilan tez boglanish. 
Agarda yuqorida ko’rsatilgan menuda qandaydir buyruq bo’lmasa u holda 

menuning (Menu) Parametrlar (Options) yordamida qo’shish mumkin. 
IIInnnttteeerrrfffeeeyyysssnnniii   sssaaaqqqlllaaassshhh   vvvaaa   ooo’’’zzzgggaaarrrtttiiirrriiissshhh   

 
CorelDRAW dasturi interfeysini foydalanuvchi uzi hohlaganday qilib rostlash 

va uni xotiraga saqlash imkoniyati bor. 
Uning uchun quyidagi amallar bajariladi: Menuning (Tools) dan Оptsii… 

(Options) buyruq tanlanadi va ochilgan dialog oynasidan Interfeys (Workspace) 

 
tanlanadi Yangi... (New) tugmasi ekranga Yangi interfiysni (New Workspace) 
chiqaradi. Yangi interfiysni (New Workspace)da interfeysning yangi parametrlarini 
kiritish uchun foydalaniladi; masalan, Nomi-maydonida-yangi interfeys nomi (Name 
of new workspace). kiritiladi va yangi interfeysni joriy qilish uchun belgi (Set as 
current) qoyiladi  
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HHHuuujjjjjjaaatttlllaaarrrnnniii   xxxoootttiiirrraaagggaaa   sssaaaqqqlllaaassshhh   

CorelDRAW dasturida hujjatlarni xotiraga bir-nechta usul bilan saqlash 
mumkin. 
Menuning Fayl (File) va Saqlash (Save) buyrugi yordamida joriy hujjatni joriy jildga 
saqlaydi. Bu amal asboblar panelidagi maxsus tugma yordamida ham amalga 
oshiriladi. 

Сохранить как … (Save As) buyrugi esa joriy hujjatni boshqa nom va boshqa 
jildga va boshqacha formatda saqlash imkoniyatini beradi. Bu amalni bajarilganda va 
yangi hujjatni xotiraga saqlaganda ekranga Tasvirni saqlash (Save Drawing) ni 
beradi. 

• Versiya (Version) ruyhatidan CorelDRAW dasturining avvalgi variantlaridan 
birini  yoki yangi variantini tanlab hujjatni mos formatda xotiraga saqlaydi. 
Faqat dasturning eski variantlarida hujjatlarni saqlaganda bir nechta 

parametrlar yoqalib ketishini esta tutish lozim. 

 
• Thumbnail ruyhatida xotiraga saqlashning bir-nechta variantlarini beradi: 

hujjatlarni o’lchamini bir qancha kichik qilib berish ham mumkin, faqat 
keyinchalik fayllarni qidirganda qiyinchilik tug’diradi. 1K (mono),  2K 
(mono), 4К (color), 8K (color) oq-qora yoki rangli tasvirlarni har xil sifatda 
xotiraga saqlasa bo’ladi. Agarda hech biri tanlanmagan bo’lsa, u holda  
maksimal sifatli tasvirli hujjat xotiraga saqlanadi. 

• Selected only (Faqat tanlangan obyektlar) tanlanganda yangi faylga ajratilgan 
obyektlar saqlanadi, shu bilan birga boshqa faylga obyektning alohida qismini 
ham saqlash mumkin. 

• ICC profile (ICC profilini joylashtirish) hujjatdagi ranglarni boshqarish. Dastur 
faqat СРТ CDR, TIFF, JPEG, PICT и EPS formatli fayllar bilan ishlaganda 
ishlaydi. 

• No white spaces, special characters (Bosh joy va maxsus belgilarsiz) belgisi 
hujjatni xotiraga saqlaganda bo’sh joy tagini chizizsh bilan , maxsus belgilarni 
Web standartindagi belgilar bilan almashtiradi. 

• Embed Fonts using TrueDoc (Shriftlarni TrueDocdan foydalanib yozish) 
hujjatda TrueDoc tehnologiyasini foydalangani haqida malumot beriladi. 
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• Keywords (kalit suzlar) и Notes (Tuchunsha berish) hujjatlarni tez topish 
uchun ularga tuchintirish suzlari yoziladi. 

•   Advanced tugmasi... (Quchimcha) ekranga Save (saqlash) dialog oynasini va 
Options (parametrlar), parametrlari o’rnatilgan bo’ladi. 

•  Save presentation exchange (Boshqa redaktorlar  formatlida saqlash) CMX 
formatda ishlaydigan boshqa redaktorlarda faylni ochich. Buni ishga 
tushirganda faylning o’lchami katta bo’ladi. 

 
• Use current thumbnail (Использовать существующую миниатюру) birinchi 

saqlaganda rastrlangan hujjatni miniatyura yordamida saqlashni t’aminlayda. 
Bu faylni saqlashga mo’ljanlangan vaqtni m’alum miqdorida kamaytiradi, 
ammo hatolikka olib kelishi mumkin, agarda hujjat ko’p qayta ishlangan 
bo’lsa. 

• File optimization maydonida (faylni optimallashtitish) ikki xil turdagi fayllarni 
saqlaydi, rastr tasvirli (Use bitmap compression) va vektor tasvirli (флажок 
Use graphic object compression) faylning u’lchamini kichik qiladi. 

•  Textures maydoni (Текстурные заливки) va Blends and extrudes 
(«Пошаговый переход» и «Экструдирование») narkibiga qaraganda bir hil: 

  Save ... with the file (fayl bilan saqlash) fayl o’lchami katta bo’ladi 
fahat hujjat o’qilganda tez vaqtda ochiladi; 

 Rebuild ... when opening the file (Построить ... при открытии файла) 
— yuqaridagiga teskari faylni oqishda ko’p vaqt talab etadi, o’lchami 
katta bo’ladi. 

EEEkkkrrraaannndddaaa   tttaaasssvvviiirrrlllaaassshhh   

Vektor grafikasi muharrirlarida ekranda (ishchi maydonda ) qanday tasvirlar bo’lsa 
bosmadan shu ko’rinishta chiqariladi. Ekrandagi ishchi oynada tayor bo’lgan 
tasvirlarni ko’rish uchun 
menuning Ko’rish 
(View) dan foydalaniladi. 
Dasturda besh xilda 
ko’rinishda ko’rish 



 10

mumkin.: Oddiy konturli (Simple Wireframe), Konturli (Wireframe), Chernovoy  
(Draft), Normal (Normal), Yaxsh (Enhanced).  
Agarda hech biri tanlanmasa u holda normal (Normal) holatini komputer uzi tanlaydi. 
EEEkkkrrraaannnnnniii   mmmaaasssssshhhtttaaabbblllaaassshhh   

Ekrandagi tayor bo’lgan rasmlarni katta va kichik hollarda ko’rish funktsyalari 
mavjud. Uning uchun asboblar panelidagi  (Toolbox) Mashtab (Zoom) tanlanib 
kattalashtirish yoki kichiklashtirish parametri ko’rsatiladi. 
Standart asboblar panelida masshtablash parametrlari berilgan va ular quyidagilar: 
Ajratilgan obyektlar(To Selected), hamma obyektlar (To Fit), Sahifa (To Page), 
Sahifa eni boyicha (To Width), Sahifa boyi boyicha (To Height), 10%, 25%, 50%, 
75%, 100%, 200%, 400% ga masshtablashga bo’ladi.  

 
Ekrandagi tasvirlar kattalashtirilganda hujjatdagi 
ko’rinmaydigan obyektlar bilan ishlashga to’gri kelib qoladi 
u holda shu obyektlarni siljitishga to’gri keladi. Buning 
uchun quyidagi ikkita imkoniyatlardan foydalanilsa bo’ladi: 

1. vertikal va gorizontal silzitgishlardan.  
2. Maxsus asbob Panoramadan (Pan). Bu holda 

ekrandagi kursor qo’l shaklini oladi va obyektni 
hoqlagan tomanga silzititsh mumkin.  

 
CCChhhiiizzzgggiiissshhh   

Chizgish ekranda ko’rinib turadi agarda u yoq bo’lsa menuning Ko’rish (View) 
tanlanib Chizgish (Rulers) buyrugi ishga tushirish kerak bo’ladi, ekkinchi marta bu 
amal bajarilsa ekrandan chizgish olib tashlanadi. 
Chizgishni ekranning hoqlagan joyoga qo’yish mumkin. Bu uchun  <Shift> tugmasi 
bilan birgalikda sichqoncha bilan olib hoqlagan joyga qoysa bu’ladi. Agarda <Shift> 
tugmasi bilan birgalikda chizgishga ekki marta sichqoncha bilan chertilsa avvalgi 
holiga qaytariladi. 
Agarda <Shift> tugmasisiz ekki marta chertilsa u holda chizgishning (Rulers) 
Parametrlari (Options)  ekranda nomaion boladi. 
CorelDRAW dasturidagi chizgish har xil ulchob birliklarida beriladi Ulchov birliklari 
(Units) qoyidagilar iborat: 
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• inches (dyumlar),1 (engliz) dyumi 24,5 мм teng; 
• millimeters (millimetrlar); 
• picas; points (pikalar), 1 pika  12 punktga teng; 
• points (punktlar), 1 punkt 1/72 engiz dyumiga teng (24,5 мм); 
• pixels (pixellar), nisbiy ulchov birlik (absolyut qiymatga ega emas); 
• ciceros; didots (tsitsero), 1 tsitsero 12 punktga teng; 
• didots (Dido punktlari), 1 Dido punkti 1/72 farang dyumiga teng (27,06 мм); 
• feet (futlar), 1 fut 304,8 мм ga teng; 
• yards (yardlar), 1 yard 914,4 мм ga teng; 
• miles (milar), 1 mil 1609 м ga teng; 
• centimeters (santimetrlar); 
• meters (metrlar); 
• kilometers (kilometrlar). 

ujjatning umumiy ish maydoni  45 x 45 metrga teng. Bu esa dasturdan ko’rgazmalar 
va katta hajmli obyektlar bilan ishlaganda juda qol keladi 
SSSaaahhhiiifffaaalllaaarrrnnniiinnnggg   pppaaarrraaammmeeetttrrrlllaaarrriii   

 
 

Ekrandagi hujjatning sahifa formati to’griturtburchak shaklidagi 
ko’rinishta bo’ladi. Agarda sahifa formatini o’zgartirmoqchi 
bo’lsangiz Свойства (Property Bar) foydalansa bo’ladi.  
Agarda Kitob (Portrait) tanlansangiz hujjatning boyi  buyicha 
ko’rinishta , Albom (Landscape)ni tanlasangiz  hujjatning  eni 
buyicha ko’rinishta sahifalaydi.  
Yoqaridagi sahifalashninig 
o’lchamlarni bosmadan 
chiqariladigan payttagi bilan 
shalkashtirmaslik kerak. 
Agar tayor bo’lgan hujjatni 
bosmadan chiqarmoqchi bo’lsangiz 
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menuning Ko’rish (View) tanlanib bosmaga chiqishi kerak bo’lgan maydon 
tanlanadi (Printable Area), va ekranda shtrix shiziqlar bilan bosmaga chiqadigan 
maydon chegaralangan bo’ladi.  
 

222   VVVeeekkktttooorrrllliii   vvvaaa   rrraaassstttrrrllliii   gggrrraaafffiiikkkaaa   
Rastr grafikasida obyektlar bit kartasidagi to’rda ranga ega bo’lgan nuqtalar 
(piksellar) erdamida tasvirlanadi. 
Rastrli tasvirlar bilan ishlash uchun rastr muharriridan foydalanamiz. Rastr 
tasvirlarni tasvirni rastr ko’rinichiga o’tkazish (Convert to Bitmap) yoli bilan olamiz. 
Rast tasvirlarni muharrirlaganda piksellar ranglarini da o’zgartirish imkoniyati 
tugiladi, fahat ranglarni o’zgartirganimizda obyektning formasi uzgarishiga uz 
tasirini tegizadi. 
Vektor grafikasi matematik obyektlar ustida tashqi qurilmalarga (monitor,printer) 
bogliqsiz holda amallar bajaradi.Vektor grafikasida birinch navbatda  obyektning 
formasi uzgaradi rangi esa ekkinchi darajali bo’ladi. Sababi vektor grafikasida rang 
bilan forma bir-biriga bogliq emas bulib, forma birinchi darajali, rang bo’lsa 
ekkinchi bulib, foxat toliqtiruvch xizmatini bajaradi.  

333   OOObbbyyyeeekkktttlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   
CorelDRAW dasturi vektorli tasvirlarni yoratishda yupqa chiziqlardan tortib 

har xil formaga ega kistlardan foydalanadi. 
Vektor grafikasi “qul yordamida” chizishdan yiroq shuning uchun avval 

obyektning vektor konturini chizish kerak keyin esa uni qanday qilib muharrirlashni 
oylab ko’rish kerak. 

Shuni nazarda tutib CorelDRAW dasturi geometrik figuralarni 
(to’griturtburchak, ko’pburchak, ellips, spiral va h.) chizish va muharrirlash 
emkoniatiga ega va yanada “erkin chizish” (pero, kalligrafik pero, va h.), gradient 
torlar (Mesh Fill) va har xil egri chiziqlarni chizish uchun Bezie (Bezier) asboblariga 
ham ega  

Vektor kontorlarinin muharrirlashda qanday asbob bilan yaratilganidan qattiy 
turda Forma (Shape) va maxsus muharrir paneli (Node Edit) (tuginlarni muharrirlaydi 
) foydalaniladi. 
Konturlar va tayonich nuqtalar 
Kontur- bu dasturning obyektlarni 
chizichda foydalaniladigan to’gri chiziq 
bulib obyektning strukturasini tashkil 
qiladi. Kontur keyinchalik To’ldorish 
(Fill) va Chegaralash (Outline), sifatida 
foydalanilib bosmaga ham chiqarilishi 
mumkin.Agarda konturning bazi bir 
parametrlari yoq bolsa oddiy holda 
kontur ko’rinmaydi fahat maxsus holda 
ko’rish imkoniyati bor va bosmaga 
chiqarilmaydi. 

Forma (Shape)asbobi yordamida ajratiladigan kontur alhida obyekt   
(object) bulib hisoblanadi. 
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Kontur qoplagan segmentlardan tashkil topgan bulib u Bezie 
egri chizigi ,tayonich nuqtasi,va tuginlar(nodes) iborat. 
CorelDRAW dasturida konturning uch turi mavjud. Agarda bitta 
tayonich nuqtasini o’zgartirilsa u bilan bogliq forma ham uzgaradi. 
Segmantning  formasi uzgatirilgan deganimiz boshqarish nuqtalari 
ham uzgarishini beradi. 
Standart obyektlar asboblari 
Standarrt geometrik obyektlar (to’griturburchak, 
kvadrat,ellips,aylana, va h.) yordamida murakkab geometrik 
obyektlarni chizish mumkin. 
TTTooo’’’gggrrriiitttuuurrrtttbbbuuurrrccchhhaaakkk   aaasssbbbooobbbiii   (((RRReeeccctttaaannngggllleee)))   

To’griturburchak asbobi (Rectangle) to’griturburchaklar,kvadrat va chetlari aylana 
chaklidagi to’griturtburchaklarni chizishda foydalaniladi. 
 To’griturburchak chizish uchun asbobni ishga qoshib sichqoncha tugmasini kerakli 
razmerga ega bo’lgancha ushlab turilib qoyib yuberiladi. 
Agarda markazdan to’griturtburchak chimoqchi bo’lsak <Shift> turmasi bilan birga 
ishlatiladi. Kvadrat chizish uchun <Ctrl> tugmasi bilan birgalikda ishlatiladi. 
Obyektning parametrlarini o’zgartirish uchun obyekt 
ajratilib sichqonchani ong tomoni bosiladi va menu 
oshiladi bu erda Xossalar (Properties) dan obyektning 
Xossalari (Object Properties) tanlanadi. Agarda 
to’griturtburchak uchlarini aylana shakliga keltirmoqchi 
bo’lsangiz Xossalar (Properties )dan foydalanilib (Corner 
roundness) da har bir uchining qancha foyzga aylana 
qilinishini ko’rsatish kerak. Har bir uchining alohida 
aylana qilish imkoniyati ham mavjud bulib u Xossalar 
(Property Bar) yordamida amalga oshiriladi. 
EEElllllliiipppsss   aaasssbbbooobbbiii   (((EEElllllliiipppssseee)))   

 Ellips asbobi  (Ellipse) ellips va aylanalarni chizish 
uchun ishlatiladi. 
 Ellipsni ekran markazida chizish uchun <Shift 
>bilan birga , aylanani chizish uchun esa <Ctrl> bilan 
birgalikda ishlatiladi.  
 Obyektnin  xossalari da ellipsni har xil o’zgartirichlar qilish 
mumkin. Bu erda ellips tiplarini tanlash mumkin: Ellips (Ellipse), 
Sektor (Pie) yoki Yoy (Arc). 

 
Obyekt (Object) guruhi asboblari 
Uchta asbobdan tashkil topgan bulib ular quyidagilar: 
Ko’pburchak (Polygon), Spiral (Spiral), Korrdinat qo’goz 
(Graph Paper) 
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KKKooo’’’pppbbbuuurrrccchhhaaakkknnniiinnnggg      aaasssbbbooobbbiii   (((PPPooolllyyygggooonnn)))   

Ko’pburchakni tomonlari berilgan geometrik obyekt deb tuchinilsa bo’ladi. 
Ko’pburchak turlaridan biri yulduzcha xisoblanadi,uning uchlari qavariq ko’pburchak 
ishiga joylashgan va maydonni kesib utib tutashtirilgan tomaonlardan iborat figura 
bo’ladi. 
Ko’pburchaklarni chizish tepada keltirilganlardan farhi yoq. 
 Agarda <Ctrl> bilan birgalikda chizilsa to’gri ko’pburchak chiziladi yani 
hamma tomonlari neng bo’lgan ko’pburchak. 
Parametrlarini o’zgartirich uchun Obyektning Xossalaridan  (Object Properties) 
foydalaniladi. 
Ko’pburchaklarni chizganda (Polygon) tanlaniladi va ushlari,tomonlari soni 
ko’rsatiladi. Ung tomonda joylashgan oynada obyektning qanday ko’rinichtaligi 
ko’rsatiladi. 
Ushlarining qanaqa ko’rinichda bulichi keratligini (Sharpness) yordamida beriladi, 
yani obyektning tomonlari qancha ko’p bo’lsa ushlari uchqir bo’ladi. Ko’pburchak 
(Polygon) va Yulduz (Star) turlaridan birini tanlash uchun ko’rsatgich berilgan. 
Bu ko’rsatgichlar asboblar panelida Xossa (Property Bar). 
 berilgan bo’ladi. 

 
Bu erda shuni nazarda tutish kerakki dasturda asboblar paneli dagi (Polygon Tool) 
ko’pburchalar parametrida ko’pburchakning yana bir turi yulduz ko’pburchak 
(Polygon as Star) ham mavjud. 
SSSpppiiirrraaalll   aaasssbbbooobbbiii   (((SSSpppiiirrraaalll)))   

Spiral asbobi (Spiral) asosan belgili radiusga va uramga ega 
geometrik obyektlarni chizashga muljallangan. 
Bu asbob bilan ishlash to’griturtburchaklarni chizishga 
uxshaydi. Bu erda spiral turini simmetrik (Symmetrical) va 
logarifmli (Logarithmic) turining bittasini tanlash kerak. 
Eni va uzunligi teng bo’lgan spirallar <Ctrl>tugmasini bosib 
turib chiziladi. 
Spiral parametrlarini  (Property Bar) o’zgartirsa bo’ladi.  
KKKoooooorrrdddiiinnnaaatttaaa   qqqooogggooozzziii   (((GGGrrraaappphhh   PPPaaapppeeerrr)))   
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Koordinata qogozi (Graph Paper) yordamida oldindan 
berilgan parametrlar bilan katakcha quruladi. Bu 
katakchalarni grafiklar,diagrammalar chizganda foydalansa 
bo’ladi. 
Katakcha chizish yoqaridagi asboblarga uqchach bo’ladi, 
masalan to’griturtburchak bilan ishlaganga uqchaydi 
Faqat bitta farhi katakcha o’lchami bo’ladi. U Koordinat 
qogoz asbobi (Graph Paper Tool) va dialog oyna 
Parametrlar (Options) orqali amalga oshiriladi.. 
Katakchalar soni eniga (Number of cells wide) eniga nechta 
katakch, katakchlar soni boyiga (Number of cells high) esa  
boyiga nechta katakch joylashtirishni ko’rsatadi. Agarda kvadrat shakldagi katakcha 
kerak bo’lsa u holda <Ctrl> tugmasi bilan birgalikda ishlatiladi. Parametrlarini esa 
Xossalar (Property Bar) o’zgartirsa bo’ladi.  
Egri chiziqlar guruhi asboblari (Curve) 
Egri chiziqlar guruhi (Curve) asboblar paneli : 
Chizish,(Freehand), Bezie (Bezier), Pero (Natural Pen), 
Ulchovli chiziq (Dimension), boglovchi chiziqlar(Connector 
Line) и boglagich (Connector) iborat.  
CCChhhiiizzziiissshhh   aaasssbbbooobbbiii   (((FFFrrreeeeeehhhaaannnddd)))   

Chizish (Freehand) asbobi asosan hoqlagan turdagi chiziqlarni chizishga 
muljallangan Вu asbob yordamida chizilganda avtomatik ravishta tayanich nuqtalari 
tanlangan vektor konturi payda bo’ladi. Kontur chizilghandan keyin konturni 
muharrirlashga bo’ladi. 
Bu asbob bilan chilganda mos chiziq qalinligi va rangi tanlanadi. 
Haqlagan paytda chizilgan chiziqni davom etib 
chizishga bo’ladi,buning uchun kursor chiziqning 
oxirgi nuqtasuga keltiriladi va kursor ko’rinichi 
uzgaradi shu paytda sichqoncha bilan chiziqni davom 
ettirsa bo’ladi. 
Chizish (Freehand) asbobi bilan asosan to’gri chiziq 
chiziladi uning uchun dastlabki va oxirgi nuqtalar 
ko’rsatilsa bos.  
IIImmmmmmiiitttaaatttsssiiiaaa   aaasssbbbooobbbiii   (((AAArrrtttiiissstttiiiccc   MMMeeedddiiiaaa)))   

Immitatsia (Artistic Media) asbobi rastr grafikasiga 
tegishli asboblardan biri bulib hisoblanadi. 
CorelDRAW dasturi ham bu asbobga ega.Bu asbob 
shtamp ko’rinishidagi peroga uxshaydi. 
Immitatsia asbobining qiyidagi turlari mavjud. 

• Образец (Preset) rejimi tayior formadagi namunalardan 
qalinligi uzgaradigan obyektlar chizish  Bu rejim 
obyektlarni figurali shtrixlar bilan shizadi. 

• Кисть (Brush) rejimi har xil murakkab shakldagi 
formalarni va matnlarni boyashda ishlatuiladi.  
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• Распылитель объектов (Object Sprayer) rejimi  har xil grafik elementlarni 
traektorya boyicha metodlardan foydalanib joylashtiradi Bu rejim asosan 
murrakab romlar ,girlayndlar,va h. yagatishda ishlatiladi. 

• Каллиграфия (Calligraphic) rejimi pero erdamida qiya ko’rinishdagi 
obyektlarni chizishda ishlatiladi. 

• Нажим (Pressure) rejimi har xil shtrixlarni yoartishda ishlatiladi. 
   ОООбббрррааазззеееццц    (((PPPrrreeessseeettt)))   rrreeejjjiiimmmiii   

Bu Образец (Preset) rejimi tanlanganda quyidagi parametrlar bilan ishlash 
inkoniatini beradi: 
 Сглаживание (Freehand Smoothing) maydonida (rasmda 1 rahami bilan berilgan ) 
0-100 gacha asosiy shtrixning silliqlanish darajasini ko’rsatadi. 
 Толщина (Width) maydoni (raham 2) dekorativ shtrixning  0,764 - 254 мм 
diapazondagi maksimal qalinligini aniqlaydi  
 Preset Stroke (Форма штриха) da (raham 3) dekorativ shtrixlarning har xil formalari 
berilgan. 

 
Bu asbob bilan ishlash  Рисование (Freehand) hech qanday farhi yoq. 
КККиииссстттььь   (((BBBrrruuussshhh)))rrreeejjjiiimmmiii   

Кисть (Brush) rejimi tanlanganda Свойства (Property Bar) ning asboblar 
satrida quyidagi parametrlar bilan ishlash imkoniyati togiladi: 
 Сглаживание (Freehand Smoothing) Maydoni (rasmda 1 rahami bilan berilgan) ) 0-
100 gacha asosiy shtrixning silliqlanish darajasini ko’rsatadi. 
Толщина (Width)maydoni (raham  2) dekorativ shtrixning  0,764 - 254 мм 
diapazondagi maksimal qalinligini aniqlaydi  
 Форма кисти (Brush Stroke) (raham 3) dekorativ shtrixlarning har xil formalari 
berilgan. 
 Сохранить (Save) tugmasi (raham 4) kistni berigan obyekt formasida hotiraga 
saqlash. Uning uchun bu obyektni ajratish kerak Имитация (Artistic Media) ishga 
tushiriladi ,keyin  Кисть (Brush) rejimi tanlanadi va Сохранить (Save) tugmasi 
bosilgandan keyin yangi kistga nom berishni soraydi va uni С MX.formatli faylda 
xotiraga yozadi. 
Удалить (Delete)-tugmasi (5 rahami) bosilganda ruyxatdagi varianlaridan tanlangani 
uchiradi 

. 
РРРааассспппыыылллииитттееелллььь   оообббъъъеееккктттоооввв   (((OOObbbjjjeeecccttt   SSSppprrraaayyyeeerrr)))   rrreeejjjiiimmmiii      
 Распылитель объектов (Object Sprayer) rejimi tanlanganda Свойства (Property 
Bar) ning asboblar satrida quyidagi parametrlar bilan ishlash imkoniyati togiladi : 
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Сглаживание (Freehand Smoothing) Maydoni (rasmda 1 rahami bilan berilgan) ) 0-
100 gacha asosiy shtrixning silliqlanish darajasini ko’rsatadi. 
Размер (Size) maydoni (raham 2)  1 dan 999% gacha maksimal va minimal dekorativ 
shtrix o’lchami foyz nisbatida aniqlaydi. 
 Перечень объектов (Spraylist) (raham 3) har xil formadagi dekarotiv ko’rinishdagi 
burkagishlar turlari. 
 Save (raham 4) yoqaridagi Кисть (Brush) ga uxshash vazifani bajaradi 
Удалить (Delete) tugmasi (raham  5) ruyhatdagi keraksiz bo’lganlarini uchiradi. 
 Порядок распыления (Spray Order) ruyhati (raham 6) kontur enida obyektlarni har 
xil ko’rinishda joylashishini bildiradi — Случайно (Ramdomly) hoqlagancha, 
Последовательно (Sequentially) ketma-ket, По направлению (By Direction) 
berilgan yonalshda . 
Добавить в список объектов (Add to Spraylist) (raham 7) yangi elementlarni 
qoshish. 
Активизация списка объектов (Spraylist Dialog) tugmasi (raham 8) ekranga yangi 
elementlar (Create Playlist) chiqariladi va u ekkita oyna: Barcha obyektlar ruyhati 
(Spraylist) va aktiv bo’lgan obyektlar ruyhatini chiqaradi (Playlist). 
Объекты/Интервалы (Dabs/Spacing) (raham 9) obyektlar nisbatini va intervalini 
o’zgartiradi. Интервалы (Spacing) pastgi qismida obyektlar orasidagi interval 
aniqlanadi, yoqargi Объекты (Dabs)da esa  — har bir interval nuqtasidagi obyektlar 
soni aniqlanadi. 
 Вращение (Rotation) tugmasi (raham 10) barcha obyektlarning aylanish 
parametrlarini o’zgartiradi. 
Смещение (Offset) tugmasi (raham 11) obyektlarning konturga nisbatan silzish 
qiymati va bagiti beriladi. 
Восстановить значения (Reset Value) tugmasi (raham 12) avval faylda saqlangan 
parametrlarini qayta tiklash. 

 
   КККаааллллллииигггрррааафффииияяя   (((CCCaaalllllliiigggrrraaappphhhiiiccc)))   rrreeejjjiiimmmiii      

Каллиграфия (Calligraphic) rejimi ishga tushirilganda asboblar panelidagi Свойства 
(Property Bar)da qiyidagilar bilan ishlash imkoniyati tugiladi: 
Сглаживание (Freehand Smoothing) (rasmda 1 rahami bilan berilgan), Толщина 
(Width) (raham  2) maydonilari yoqaridagi Кисть (Brush) rejimigaday xizmatni 
bajaradi. 

Angle (Угол) (raham 3) «пера»ning qialiq burchagini bildiradi. 

 
НННааажжжиииммм   (((PPPrrreeessssssuuurrreee)))   rrreeejjjiiimmmiii   

Нажим (Pressure) rejimi tanlanganda Свойства (Property Bar)siga quyidagi 
parametrlar bilan ishlash imkoniyatini tugdiradi: 
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Сглаживание (Freehand Smoothing) (rasmda 1 rahami bilan berilgan), Толщина 
(Width) (raham  2) maydonilari yoqaridagi Кисть (Brush) 
rejimidagiday xizmatni bajaradi. 
Kistning qalinligi tanlaganda < > (qalin qilish uchun) va 
< > (qalinligini kamaytirish uchun) tugmalaridan 
foydalaniladi. 

БББееезззьььеее   (((BBBeeezzziiieeerrr)))   aaasssbbbooobbbiii   
Bezie (Bezier) asbobi yordamida maksimal aniqliqdagi 
hoqlagan egri chiziqlarni chizish mumkin. Bu asbob 
yordamida hoqlagan formalarni chizish imkoniyati bor. 
TTTooo’’’gggrrriiiccchhhzzziiiqqqllliii   ssseeegggmmmeeennntttlllaaarrrnnniii   qqquuurrriiissshhh   

To’gri chziqni chizish uchun Bezie (Bezier) asbobidan 
foydalaniladi. Bunig uchun Bezie asbobi tanlanilib 
kursorni bochangish nuqtaga qoyiladi va sichqonchani 
chap tomoni bilan chertiladi.Chertilgan joyda qora rangli 
nuqta foyda bo’ladi ,bu segmentning birinchi tayanch 
nuqtasi ,bu nuqta kelasi nuqta tanlanganicha joriy bulib turadi. 
Kursoni keyinga nuqta joylashadigan joyga siljitamiz va sichqoncha bilan chertiladi 
natijada ekkita nuqta birlashtirilib to’gri chiziq payda qilinadi.  
TTTaaayyyaaannnccchhh   nnnuuuqqqtttaaalllaaarrr   tttuuurrrlllaaarrriii   

CorelDRAW dasturida segmentning bir nechta nuqtalarini 
birlashtirishining uchta tipi bor: 

1. Ekkita egri chziqni «egrilikga» birlashtiruvchi 
tayanch nuqta - burchak tayanch nuqta (cusp node) 
deyiladi. Bu tiptagi tayanch nuqtaning bochqarish 
to’grichiziqlarning “richaglarning” uzunliglari va 
yonalishlari bir-biriga bogliq bo’lmaydi. 

2.  Bo’lmay ekkita egri chiziqni birlashtiruvchi tayanch 
nuqta silliq tayanch nuqta (smooth node) deyiladi. Bu 
tipdagi tayanch nuqta boshqarich to’gri chiziqlari 
fahat uzunliqlari bilan farh qiladi, yonalishi esa 
umumiy bo’lgan urinma bo’ladi. Bitta boshqarish turgichiziqning silzitilishi 
ekkinchi to’grichiziqning silzishiga olib keladi. 

3. Bo’lmay ekkita egi chiziqni bir xil egrilig bilan birlashtirilgan bo’lsa simmetrik 
tayanch nuqta  (symmetrical node) deyiladi.  

Bu tipagi tayanch nuqtaning boshqarich to’gri chizigi va yonalishi bir-biriga bogliq 
bo’ladi. 
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EEEgggrrriii   ccchhhiiizzziiiqqqllliii   ssseeegggmmmeeennntttlllaaarrr...   

Bezie asbobi erdamida egri chiziqli segmentlarni ham yaratsa bo’ladi. Bu uchun 
asbobni ishga qoshib , kursorni bochlangish nuqtaga olib kelinadi  va sichqonchani 
chap tomoni chertilib en tomonga suriladi. Paydo bo’lgan tayanich nuqtadan 
boshqarich to’grichizigi olinadi. Boshqaruvchi to’grichiziq uzinligi va qialiq 
burchagini segment egriligidan aniqlanadi. 
Qavariq segmentni olish uchun birinchi tayanch nuqtani qavariq tomanga 
ekkinchisini esa teskari tomanga surish kerak. 
Agarda ekkinchi nuqtani ham shu tomanga surilsa S-ko’rinishidagi egrichiziq paydo 
bo’ladi. 

Murrakab konturni hosil qilishda kamroq tayanch nuqtalarni hosil qilgan 
maqsadga muvafiq bo’ladi. 

• Bitta yonalishga ega egri chiziq bitta tayanch nuqtani talab qiladi. 
•  Uz yonalishini sekin o’zgartiradigan egri chiziq ekkita tayanch nuqta talab 

qiladi (boshida va oxirida). 
• Yonalishini burchak ostida uzgartuvch egri chiziq ushun har bir egilishda 

tayansh nuqta kerak bo’ladi. 
   РРРааазззмммееерррнннаааяяя   лллииинннииияяя   (((DDDiiimmmeeennnsssiiiooonnn)))   aaasssbbbooobbblllaaarrriii...   

 
Chizmalar va sxemalar bilan ishlaganda formalarining to’gri chizilishi bilan bir 
qatorda ularning razmerlarining to’gri bo’lishi katta ahamiatga ega.Vektor grafikasi 
dasturlari sxemalar chizish uchun qul keladi. Dasturda bu amallarni bajarish uchun 
oltita asbob mavjud: 

1. Автоматическая размерная линия (Auto Dimension) asbobi sichqonchni 
qaysi yonalishda silzuishiga qaray ulchjamli to’grichiziq 
chizadi.(Vertikal,gorizontal o’lchamli to’grichiziqlarida bir biriga utishga 
<Tab> tugmasi erdamida amalga oshiriladi). 

2. Вертикальная размерная линия (Vertical Dimension) asbobi fahat vertikal 
o’lchamli to’grichiziq paydo etadi. 

3. Горизонтальная размерная линия (Horizontal Dimension) asbobi fahat 
gorizontal o’lchamli to’grichiziq paydo etadi. 

4.  Наклонная размерная линия (Slanted Dimension) asbobi fahat qia bo’lgan 
o’lchamli to’grichiziq paydo etib obyekt uzgarishi bilan u da uzgaradi. 
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5.  Выноска (Callout) asbobi obyektlarga beriktirilgan yarliqlarni yaratadi. 
6. Угловая размерная линия (Angular 

Dimension) asbobi burchakning qiymatini 
ko’rsatadigan ulchagish duga yaratadi. 

Hoqlagan turdagi o’lchamli to’grichiziq yaratish 
uchta etabdan tashkil topadi:  
• Birinchi chertich boshlangish nuqta ni aniqlaydi; 
• Ekkinchi chertish oxirgi nuqtani aniqlaydi; 
• Uchinchi chertish o’lcham eziladigan erdan 

to’grichiziqgacha oraliqni bildiradi.  
Obyektga o’lchamli yoki ulanuvchi to’grichiziqni 
boqlash uchun joriy bo’lgan nuqtalar biriga kursor 
olib kelinib, sichqoncha bilan chertiladi. 
Burchakni ulchiovchi chiziqni payda etish 
turtta etabdan eborat: 
• Birinchi chertilish burchakning 

dastlabki nuqtasini aniqlaydi; 
• Ekkinchi va uchinchi  chertilishlar 

nurda burchak nuqtalarni belgilaydi; 
• turtinchi chertich esa nurdagi 

nuqtalardan o’lcham ezilgan 
ezuvgacha masofa. 

   ВВВыыыннноооссскккааа    (((CCCaaallllllooouuuttt)))   aaasssbbbooobbbiii   

 Выноска (Callout) asbobi obyektning 
bironta nuqtasi bilan matnli yoki 
tuchuncha suz bilan boglaydi.Shu bilan 
birga  <Выноски>lar obyektga boglangan 
bo’ladi. 
Bu amal quyidagicha bajariladi dastlabki 
chertish obyektning tayanch nuqtasiga 
boglashni bildiradi, ekkinchi chertish 
egilish nuqtasini ko’rsatadi va nuhoyat 
uchinchi chertish matn kiritish uchun ishlatiladi. 
   СССоооееедддииинннииитттеееллльььнннаааяяя   лллииинннииияяя   (((CCCooonnnnnneeeccctttooorrr   LLLiiinnneee)))   vvvaaa      ИИИнннтттеееррраааккктттииивввннныыыййй    сссоооееедддииинннииитттееелллььь   
(((IIInnnttteeerrraaaccctttiiivvveee   CCCooonnnnnneeeccctttooorrr)))   aaasssbbbooobbblllaaarrriii   
Соединительная линия (Connector Line) asosan xizmati ekkita obyektni bir-biri 
bilan boglash uchun ishlatiladi. Bu esa birlashtirilgan obyektlarni surish va 
transformatsia qilish imkoniyatini beradi. Agarda obyektlar mavjud bo’lmasa oddyi 
to’grichiziqga oylanib qoladi.Agarda fahat bitta obyekt bo’lsa u holda ekkinchi 
tomoni sahifaga boglangan bo’ladi. 
Biriktiruvchi chiziqni hosil qilish uchun obyektlarning mos tayanch nuqtalariga 
sichqoncha erdamida chertiladi. Chiziqning parametrlari (rangi, qalinligi) uzgartililsa 
ekkita obyektnikida uzgaradi. 
 Интерактивный соединитель (Interactive Connector) asbobi har xil blok sxemalar 
yaratishga muljallangan. Соединительная линия (Connector Line) asbobidan farhi 
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fahat vertikal va gorizontal chiziqlar yaratadi. Shu bilan birga obyektlarni siljitganda 
tayanch nuqtalarga boglanich saqlanadi, agarda kerak bo’lsa uni olib tashlasa ham 
bo’ladi. 
Интерактивный соединитель (Interactive Connector) asbobi yordamida ekkita 
obyektni boglash uchun dastlab kursor birinchi obyektning tayanch nuqtasiga olib 
kelinib sichqoncha bilan chertiladi va ekkinchi obyektning tayanch nuqtasigacha 
chiziq tortiladi. 
Berilgan obyektni transformatsya qilganda biriktiruvchi chiziq abtomat ravishta 
uzgaradi va boglanishni uzmaydi. 
Agarda biriktirilgan obyektlardagi tayanich nuqta uchirilganda eng yaqin nuqta 
tayanich nuqta qilib olinadi. 

 
   СССтттрррееелллкккааа    (((PPPiiiccckkk)))   aaasssbbbooobbbiii   

Obyektklar ustida qanaqa amal bajarilmasin oxirgi 
obyekt bashqalaridan ajratilgan bo’lishi kerak.  
Bu amalni bajarish uchun mahsus ajratish asbobi 
Стрелка (Pick) ishlatiladi. 
Obyektning ajratilganligini obyektning enidagi 
markerlardan va obyekt markazidagi krestdan bilish 
mumkin.Agarda bir nechta obyektlar ajratilgan bo’lsa 
markerlar katta turtburchak shaklida bo’ladi. 
OOObbbyyyeeekkktttlllaaarrrnnniii   aaajjjrrraaatttiiissshhh   uuusssuuullllllaaarrriii   

 Стрелка (Pick) asbobi yordamida obyektlar bir-nechta 
usullar bilab ajratiladi. 

• Alohida obyektni sichqonchani chertish bilan 
ajratsa bo’ladi. 

• штриховой рамкa (marquee) yordamida obyektlarni ajratganda belgilangan 
maydondagi obyektlar ajratiladi va ular shtrixlangan ramka ko’rinishida 
bo’ladi. 

• Obyektlarni ajratishda klaviaturadan ham foydalanilsa bo’ladi. <Tab> 
tugmasini bosish orhali obyektlarni ketma-ket, <Shift> + <Tab> — tugmalari 
bilan birgalikda ishlatilsa teskari holattada ajratiladi. 

• Hamma obyektlarni ajratish uchun Объекты (Objects) buyrugi va menuning 
Редактировать/Выделить все (Edit/Select All) tanlanadi. Bu amalni Стрелка 
(Pick) asbobining tugmasin ekki marta bosish bilan amalga oshirsa bo’ladi. 
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Ajratishni bekor qilish uchun ish joyining boas eriga 
sichqoncha bilan chertiladi yoki  <Esc> tugmasi 
bosiladi. 

   СССтттрррееелллкккааа    (((PPPiiiccckkk)))aaasssbbbooobbbiiinnniiinnnggg   bbbooossshhhqqqaaa   fffuuunnnkkktttsssiiiaaalllaaarrriii   
Стрелка (Pick) asbobi ishlatganda obyektlarni 

ajratilganligi  markeri fahat ajratilganlik belgisini belbirib 
qolmay boshqa da maqsadlarda ham qullaniladi.  
Marker yordamida obyektlarni masshtablash mumkin. <Shift> 
tugmasi bilan ishlatilsa markazdan masshtablaydi. <Ctrl> bilab birga ishlatilsa bir 
butunga kattalashadi. En tomondagi markerlar esa noproportsonal masshtablaydi. 

Ekkinchi marta obyektlarni ajratganda markerlar yonalish shaklini oladi. 
 Burchkdagi yonalishlar yordamida obyektni oq otrofida oylantiradi 
 En tomondagi yonalishlar esa obyektni gorizontal yoki vertikal tomonga 

qiyshaytirishni bildiradi. 
Shuning bilan birga Стрелка (Pick) asbobi obyektlarni yoki obyektlar yigindisini 

ko’chrish mumkin unuing uchun obyektni olib kerakli tomonga surish mumkin. 
   ФФФооорррмммааа    (((SSShhhaaapppeee)))   aaasssbbbooobbbiii   

 Форма (Shape) asbobi vektor 
konturlarini muharrirlashga 
muljallangan. Bu asbob  obyektning 
shklini o’zgartiradi yani tayanich 
nuqtalari kushiradi,yangi tayanich 
nuqtalar qo’shadi va h.  amallar 
bajarish orhali amalga oshiriladi.  
 Форма (Shape) asbobi yordamida 
ajratilgan obyektning hamma 
tayanch nuqtalari ko’rsatiladi, kursor 
olib borilgan  nuqtalari esa joriy 
bo’ladi. 

 
 

ФФФооорррмммааа    (((SSShhhaaapppeee)))   aaasssbbbooobbbiii   yyyooorrrdddaaammmiiidddaaa   ssstttaaannndddaaarrrttt   vvvaaa   hhhoooqqqlllaaagggaaannn   ooobbbyyyeeekkktttlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   

Прямоугольник (Rectangle) asbobi yordamida yoratilgan obyektlarnining tayanich 
nuqtalarini o’zgartirish natijasida aylana shaklini olishi mumkin. 
 Эллипс (Ellipse) asbobi bilab yasalgan obyektlar esa sektor yaki duga shakliga 
keltirilishi mumkin. 
 Многоугольник (Polygon) asboblari bilan yasalgan obyektlar esa simmitrik tarizda 
obyektning boshqa turiga  uzgaradi. 
Matnli obyektlar bilan ishlashda esa harflar orasidagi va suzlar orasidagi intervallarni 
o’zgartirish inkoniati tugiladi.  
   РРРееедддаааккктттоооррр    ууузззлллоооввв   (((NNNooodddeee   EEEdddiiittt)))   pppaaannneeellliii   
Hamma tayanch nuqtalar, segmentlar bilan ishlaydigan Редактор узлов (Node Edit) 
panelida joylasgan. Bu panel menuning Docker (Window/Dockers) tipidadi 
Oкно/Панелиdan Редактор узлов (Node Edit) ishga tushiriladi yoki  <Ctrl> + 
<F10> tugmalari yordamida ishga tushiradi. 
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Форма (Shape) asbobini ishga tushirganda Редактор Узлов (Node Edit)ning 
malumot berish satrida (Свойства (Property Bar)) bu panelning barcha buyruqlari 
nomayon bo’ladi. 

 
TTTaaayyyaaannnccchhh   nnnuuuqqqtttaaalllaaarrriiinnniii   qqqooossshhhiiissshhh   vvvaaa   ooollliiibbb   tttooossshhhlllaaassshhh...   
Egri ko’rinishidagi obyektlarga hoqlaganch tayanch nuqtalarini qoshishga bo’ladi. 
Buning uchun segmentning nuqta qo’yish joyiga sichqoncha bilan chertiladi va paydo 
bo’lgan nuqta qora doyra shakli ko’rinishidagi potentsial nuqtaga ega bulamiz. Bu 
potentsial haqiqiy nuxtaga aylanish uchun yana panelning xossasidagi “+” tugmasi 
bosiladi (rasmda 1 rhami bilan berilgan)  
Keraksiz tayanch nuqtani uchirich uchun avval uchiriladigan nuqtalar ajratiladi va “-” 
belgisi bosiladi (2 raham). 
TTTooo’’’gggrrriiiccchhhzzziiiqqqllliii   ssseeegggmmmeeennntttlllaaarrrnnniii   eeegggrrriiiccchhhiiizzziiiqqqllliii   ssseeegggmmmeeennntttlllaaarrrgggaaa   uuutttgggaaazzziiissshhh      

Har qanday segment ekki xilda bo’lishi mumkin to’gri yoki egri chiziqli. Форма 
(Shape) asbnobi yordamida tayanich nuqta ajratilganda holat satrida segment tipi —
To’gri (Прямой) (Line) yoki Egri( Кривой )(Curve) ko’rsatiladi. 

Segmentning bir turidan ekkinchi turiga utich uchun segment tanlanadi 
Свойства (Property Bar)dagi ekkita halatdan biri tanlanadi: To’griga utich (To Line) 
( 5 raham ) yoki  Egriga (То Curve) utich( 6 raham). 

Egrichiziqli segmentda to’grisiga utich tez amalga ochiriladi, teskarisi bir 
muncha vaqtni talab qiladi — segment egriligi qol yordamida bajariladi.  
KKKooonnntttuuurrrnnniii   bbbiiirrrlllaaassshhhtttiiirrriiissshhh   vvvaaa   uuuzzziiissshhh   

Ochiq konturni yopiq konturga aylantirish uchun boshdagi va oxirgi nuqtalar 
biriktiriladi,bu amal ekkita usul bilan bajariladi: 

1. Ekkita nuqtani birlashtirish uchun avval nuqtalar ajratiladi va Свойства 
(Property Bar)ning asboblar satridagi Соединить два узла (Join Two Nodes) ( 
3 rahamli) tanlaniladi. Agarda ekkita nuqta ustma-ust joylashgan bo’lsa ekkita 
nuqta bitta nuqtaga aylanadi. Agarda qandaydir masofada joylashgan bo’lsa 
usha masofani markazida birlashtiriladi. 

2.  Chetdagi nuqtalarni birlashtirish to’grichiziqli segment bilan amalga 
oshiriladi.Bunig uchun Свойства (Property Bar) asboblar satridagi 
Автоматическое замыкание контура (Auto-close) ( 13 rahamli) tugmasi 
bosiladi 

3. Agarda konturni uzmoqchi bo’lsangiz avval usha nuqtalar ajratiladi Свойства 
(Property Bar) asboblar satridagi Разорвать кривую (Break Curve) ( 4 
rahamli) tugmasi bosiladi va natijada bitta nuqta urnida ekkita nuqta paydo 
bo’ladi . 

Konturni bir nechta konturlarga ham ajratishga bo’ladi, buning uchun obyektning 
kamida bitta tayanch nuqtasi tanlanilib  Извлечь подконтур (Extract Subpath) 
tugmasi bosiladi.  
TTTaaayyyaaannnccchhh   nnnuuuqqqtttaaalllaaarrrnnniii   ttteeekkkiiissslllaaassshhh   
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Shriftlarni yoki maxsus belgilar bilan ishlaganda nuqtalarni gorizontal yoki vertikal 
joylashtirishga to’gri keladi. 
 Свойства (Property Bar) satridagi Выравнивание узлов 
(Align Nodes) tugmasi (16 raham) mulohot oynasini 
ekranga chaqiradi.  
Bu oynada hoqlagan sondagi tayanch nuqtalarni gorizontal 
va vertikal holatda joylashtirishlar mavjud. 
Boshqarish nuqtalari bilan birgalikda tayanch nuqtalarini 
tekislash (флажок Выравнивание управляющих точек 
(Align Control Points)) amali bilan bajariladi. 
SSSeeegggmmmeeennntttlllaaarrrnnniii   mmmaaasssssshhhtttaaabbblllaaassshhh   vvvaaa   aaayyylllaaannntttiiirrriiissshhh   

CorelDRAW dasturida obyektlarni transformatsialash bilan cheklanib qolmay bazi 
bir segment bulimlari bilan da ishlash imkoniyati bor. Bu amal Свойства (Property 
Bar) asboblar satridagi ekkita tugama bilan bajariladi. 
•  Растяжение и масштабирование узлов (Stretch And Scale Nodes) ( 14 raham) 

tugmasi bosilganda ajratilgan segment atrofida markerlar paydo bo’ladi. 
Masshtablash amalida Стрелка (Pick) asbobidagi amallar bajariladi. 

• Вращение и наклон узлов (Rotate And Skew Nodes) ( 15 raham) tugmasi 
bosilganda tugmasi bosilganda ajratilgan segment atrofida markerlar paydo 
bo’ladi. Atrofida aylanish amalida Стрелка (Pick) asbobidagi amallar bajariladi. 

•  Эластичный режим (Elastic Mode) (17 raham) ajratilgan obyektlarga ayriqcha 
transformatsia beradi. 

   НННооожжж   (((KKKnnniiifffeee)))   vvvaaa      ЛЛЛааассстттиииккк   (((EEErrraaassseeerrr)))   aaasssbbbooobbblllaaarrriii   

Форма (Shape) asbobi oynida - Нож (Knife) va Ластик (Eraser) asboblari 
joylashgan bulib , berilgan vektorli obyektni bir nechta bulaklarga bo’ladi . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Нож (Knife) asbobi obyektni bir-nechta konturlarga 
yaki bir-nechta obyektlarga bo’ladi. Konturni kesish 
uchun dastlad birinchi tayanch nuqta tanlanadi va pishoq 
ko’rinishidagi kursor vertikal ko’rinichga kelgan holda 
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chertilishi kerak. Ekkinchi nuqtaga «резиновая линия» tortiladi. Ekkinch marta 
chertilishi esa kesishni bajaradi. Bu amalni rasm chiaish orqalida bajarsa bo’ladi, 
unuing uchun birinchi nuqtada kursorni qoyib sichqoncha tugmasi bosilib turib 
hoqlagan chiziq chiziladi.Tugma ekkita kontur birlashganda qoyib yubariladi.  
(Property Bar) ning asboblar panelida ekkita tugma mavjud: 
•  Сохранить как один объект (Leave as one object) bitta obyekt qilib saqlash. 
• Автоматическое замыкание контура (Auto-Close On Cut) Нож (Knife) asbobi 

bilan ishlashni tugatgandan song  avtomat ravishta yopiq konturni chizadi. 
 Ластик (Eraser) asbobi vektor obyektinig kerak emas joylarini uchiradi. Agar bu 
asbob bilan kesilsa ekkita bir-biriga bogliq bo’lmagan obyektlar paydo bo’ladi.. 
O’chirish kengligini 0,025 мм dan 2540 мм gacha o’zgartirilsa bo’ladi. Bu amal 
Свойства (Property Bar)  asboblar satridagi  Ширина ластика (Eraser Thickness) da 
bajariladi. 
СССвввоообббооодддннноооеее   тттрррааанннсссфффооорррмммиииррроооввваааннниииеее   (((FFFrrreeeeee   TTTrrraaannnsssfffooorrrmmm)))   aaasssbbbooobbbiii      
Bu asbob ishga tushirilganda Свойства (Property Bar)da tortta turma 
bilan ihlash imkoniyati tugiladi: Свободное вращение (Free 
Rotation) erkin holda aylanish (1 rahami), Свободное отражение 
(Free Angle Reflection) (2 raham) erkin holda akslanish, Свободное 
масштабирование (Free Scale) ( 3 raham) erkin holda masshtablashtirish va 
Свободный наклон (Free Skew) erkin holda qia qilish ( 4 raham). 
Свободное вращение (Free Rotation) asbobi da obyektni uzu atrofida aylantirish 
uchun avval sichqolcha yordamida tayanch nuqta tanlanadi, va undan aylanich 
richagi paydo bo’ladi 
yonalish aylanish burchagidan 
aniqlanadi, buerda  
ko’rsatilgan kursor esa burich 
burchagi.Agar burchar 
markazdan qancha olis 
masofada joylashgan bo’lsa 
aniqligi ham yaxshi 
bo’ladi.Burchakning qiymati 

holat satrida 
ko’rsatilib turadi.  

Свободное 
отражение (Free 
Angle Reflection) 
asbobining ishlash printsipi da yoqaridagiga 
uxshash fahat shtrixlangan chiziq aкslanish 
chizigi hisoblanadi. 
Свободное масштабирование (Free Scale) 
asbobida yoqargi ekki asboblarga uxshash 
ishlatiladi fahat shtixlangan richag bo’lmaydi. 
Свободный наклон (Free Skew) asbobi yoqargi 
asboblarga uxshash ishlatiladi, faxat holat satrida 
o’qlarga nisbatan silzish ko’rsatgishi, asklanish 
burchagi va masofasi beriladi.  
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444...MMMaaatttnnnlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   

CorelDRAW dasturining eng etishgan tomonlaridan biri bu matnlar bilan ishlash 
bo’ladi. Dasturda matnni har xil garniturada,ranglarda, keglda,va shiriftlarda berish 
emkoniati bor. Shirtftlarni sirtqi ko’rinishlarini bezashning cheksiz turlari bor. 
Matn ishchi oynada  Редактирование текста (Edit Text) yordamida kiritiladi. 

CorelDRAW dasturida matn ko’rinishi ekki turda bo’ladi:sarlovhz (artistic) va 
abzats (paragraph). Matn tipi Текст (Text) asbobi yordamida kiritiladi. 
 
SSSaaarrrlllooovvvhhhaaa   mmmaaatttiiinnniii   (((AAArrrtttiiissstttiiiccc   TTTeeexxxttt)))   

Текст (Text) asbobi yordamida hoxlagan joyga hoqlagan matnni kititish inkoniatimiz 
bor.  
 Sarlovha matinini  kiritish uchun Текст (Text) asbobi ishga tushuriladi,va  kursorni 
matn kiritiladigan joyda olib borilib sichqoncha bilan bir marta chertiladi natijada 
ekranda matn kiritish kursori paydo bo’ladi. 
Satrni yangi qatordan boshlash uchun  <Enter>tugmasi yordamida kursor ko’chriladi.  
AAAbbbzzzaaatttsss   (((bbbllloooaaakkkllliii)))   mmmaaatttnnn   (((PPPaaarrraaagggrrraaappphhh   TTTeeexxxttt)))   

Asosiy matn (main text) katta xajmga ega bulib kolonka ichiga olib yoziladiva oni 
blokli matnlar deb ataydi.Ekkinchi farhi unning kolonka eni boyicha avtomatik 
ravishta qoyiladi,agarda matnlar uchirilsa yoki qo’shilsa avtomat ravishta silziydi.Bu 
turdagi matnning asosiy elementlardan biri abzats xisoblanadi, va abzatsli matnlar 
deb ham aytiladi. Blokli matnlarni yaratish uchun Текст (Text) dan quyidagicha 
foydalaniladi: 
Asbobni ishga tushirib ,matn kiritiladigan 
to’griturtburchak yaki ellips ko’rinishlar 
tanlanadi.Matnli tugiturtburchak hech qanaqa 
parametrlarga ega bo’lmaydi va biosmadan 
chiqarilganda faxat matnning uzi chiqariladi. 
• Matnli to’griturtburchak yasalgandan 

keyinishga tayor ekanligini bilbiruvchi enib 
uchib turuvchi kursor chap tomonda paydo 
bo’ladi. 

Blokli matnlarni kirinish paytida dastur uzi 
avtomatik ravishda kelasi satrga utgazadi 
foydalanuvchi faxat abzats oxirida  <Enter> 
tugmasini bosishi kifoiya. 
Agarda belgilangan to’griturtburchakda matn 
ko’rsatilganda ko’payib ketsa ,to’gritutburchak tagida maxsus belgi qizil rangli 
uchburchak shaklidagi yonalish ko’rsatiladi. 
Matn turtburchagini o’lchamlarini o’zgartirich uchun Стрелка (Pick) asbobdan 
foydalaniladi. 
Dastur tomonidan matnning xojmiga va parametrlariga qaray balandligini tanadi. 
Bu rejimga utish uchun  Абзацный текст (Paragraph Text) bulimidagi Параметры 
(Options) oynasida matnningh xajmiga qaray to’griturtburchakni katta yoki kichkina 
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qilish  (Expand And Shrink Paragraph Text Frames To Fit Text) da belgi qo’yish 
orqali amalga oshiriladi. 
SSSaaarrrlllooovvvhhhaaa((((((AAArrrtttiiissstttiiiccc   TTTeeexxxttt)))   mmmaaatttnnnnnniii   aaabbbzzzaaatttsss   mmmaaatttnnngggaaa      (((PPPaaarrraaagggrrraaappphhh   TTTeeexxxttt)))   uuutttgggaaazzziiissshhh   

Sarlovha ko’rinishida ezilgan matnni abzats ko’rinishiga yoki teskari abzats 
ko’rinishida ezilgan matnni sarlovha ko’rinishiga ezishga to’gri kelib qoladi. Bu 
hollarda dastur tomonidan bir turidan ekkinchi turiga utgazich imkoniyatlari bor. 

Sarlovha matini ajratgan holda Текст (Text) menusida abzats matnga ugirish 
(Convert to Paragraph Text), abzats matini ajratilganda esa sarlovhz matniga ugirish 
(Convert К Artistic Text) suzlari chiqariladi. 

 
Bir turidan ekkinchi turiga uzgazishni tezlatish ushun Свойства (Property Bar) 

da joylashgan Конвертировать текст (Convert Text) tugmasini ishlatsa. 
MMMaaatttnnnnnniii   fffooorrrmmmaaatttlllaaassshhh   (((FFFooorrrmmmaaattt   TTTeeexxxttt)))   

CorelDRAW dasturi  shiriftlning parametrlarini boshqarish imkoniyatiga ega.Matnni 
kiritmastan avval parametrlarini belgilab olsa ham bo’ladi, kiritilgandan song matnni 
formatlasas ham bo’ladi. 
Matnni formatlash menuning Текст (Text) va Форматирование текста (Format 
Text)buyrugi bilan amalga oshiriladi. Mulohat oynasida abzats matnlar uchun oltita 
parametrlar berilgan bo’ladi: Шрифт (Font), Выключка (Align), Интервал (Space), 
Табуляция (Tab), Рамки и колонки (Frames and Columns); Эффекты (Effects) 
yoki sarlovha matini uchun uchta : Шрифт (Font), Выключка (Align), Интервал 
(Space) beriladi. 
ШШШрррииифффттт   (((FFFooonnnttt)))   bbbooo’’’llliiimmmiii   

 Шрифт (Font) bo’limi bu 
matindagi shiriftning 
garniturasini,keglini va boshqa 
parametrlarini tanlashni bildiradi. 
Shrift garniturasi deganda nomiga, 
tasviriga ega bo’lgan belgilar 
majmuasini tushiniladi  
masalan,Times, Helvetica, Декор, 
Лазурского garnituralari va h.  

Шрифт(Font) ruyhatida 
operatsion sistemaga o’rnatilgan 
shiriftning bitta garneturasi 
tanlaniladi. Начертание (Style) –
esa quyidagi torttasidan bittasi 
tanlanadi: Нормальное прямое 
(Normal), Нормальное курсивное (Normal-Italic). Полужирное прямое (Bold) и 
Полужирное курсивное (Bold-Italic). 
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Size (Кегль)  ruyhatida esa от 0,001 dan 3 000 punktgacha bo’lgan kegl 
tanlanadi  

Ulchov birligini Единицa maydonidan o’zgartiriladi. Подчеркивание 
(Underline), Перечеркивание (Strikethru) и Надчеркивание (Overscore) matnni 
muharrilaganda foydalaniladigan chiziqlarni bildiradi va u qyiudailarni uz ishiga 
oladi: Без линии (None), Одиночная тонкая (Single Thin), Одиночная толстая 
(Single Thick). Двойная тонкая (Double Thin). Двойная толстая (Double Thick). 

Редактировать (Edit...) tugmasi esa chizilganlarni muharrirlashni bildiradi. 
Толщина (Thickness) va Смещение относительно базовой линии (Baseline Shift) 
moydanlari chiziq qalinligi va joylashini bildiradigan son qyimatlar. 
QQQooo’’’ssshhhiiimmmccchhhaaa   ВВВыыыккклллююючччкккааа    (((AAAllliiigggnnn)))   

Выключка (Align) faxat abzats matnga tegishli. Bu erda matnning qantay 
tartibda terilish parametrlari berilgan.  

Tekislanishlar (Align)  chap 
tomondan , ung tomondan, markazdan, va 
berilgan format boyicha turlari mavjuv. 
Выключка (Alignment) maydonida yangi 
tipni paydo qilasada bo’ladi.  
 Format boyocha va tuliq turida shegaraviy 
intervakllarini aniqlash kerak.: Suzlar 
orasida maksimal bosh joy qoldirish (Max. 
word spacing), Suzlar orasida minimal 
bosh joy qoldirish (Min. word spacing ), 
Harflar orasida maksimal bosh joy 
qoldirish  (Max. char. spacing) 
parametrlari dastur uchun matn terilganda avtomatik 
verstka qilinadi. 
Abzats tushunchasi matnning chetidan joy 
qoldirishini bildiradi. Bosh joy qoldirish deganda matnning ung,chap tomonidan va 

su’z boshidagi bush joy qoldirish tushiniladi.  
 Отступы (Indents) maydonida shu 

parametrlarni o’zgartirish imkoniyati bo’ladi: 
Красная строка (First line) suz boshi , Слева 
(Left) chapdan , Справа (Right) ungdan. 

Bir yoki bir nechta belgilarni ajratganda 
Смещение символа (Character shift) maydoni 

bilan ishlash imkonioti tugiladi. Bu 
erda (поле Horizontal)  gorizontal 
silzis , vertikal silzish (поле 
Vertical), (поле Rotation) berilgan 
burchakga burilish amallari 
bajariladi. 

Qatordagi barcha belgilar 
(baseline) chizigiga qaray 
to’grilanadi va unuig parametrlari 
,har bir belgi uchun shiriftlar 
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faylida saqlanadi.Bu esa birinchidan matnning satrlarini to’gri kiritishni taminlaydi, 
ekkinchidan bazabiy chiziqdan vertikal yonalishda bazi –bir masofaga silzitishni 
taminlaydi. 

Vertikal silzishda shiriftlarni kichiklashtirganda har xil indekslar ( pastki, 
yoqargi) avtomat ravishta fotmatlanadi yanada tasviriy sanatda bu amalni foydalansa 
bo’ladi.  
ИИИнннтттееерррввваааллл    (((SSSpppaaaccceee)))   bbbooo’’’llliiimmmiii   

 Интервалы (Space) da har xil intervallarni qo’yish yana avtomat ravishta keyingi 
satrga utishni taminlaydi. 
 Символы (Character) moydanida suzlar orasidagi masofalar beriladi, yani  (Word) 
— foyz nisbatida shriftning orasidagi masofani beradi, Интерлиньяж (Line) 
maydonida –foyz nisbatida shriftning kegili va shrift balandligi beriladi. 
 интерлиньяжем (leading) da matn terilganda qo’shni qatorlar orasidagi masofani 
bildiradi. Bu matnlarni kiritganda katta ahamiatga ega. 
 Абзац (Paragraph) moydanida abzatsning 
atrofidagi masofalarni bildiradi, До абзаца 
(Before paragraph) abzatsdan oldin va 
abzatsdan keyin (After paragraph) 
Agarda bu ikkitasi qo’shni abzatslarga tegishli 
bo’lsa ular qo’shiladi. 
 Автоматический перенос (Use automatic 
hyphenation)ga flag quyilsa  Установки 
переноса (Hyphenation Settings...) 
tugmasi bilan ishlash imkoniyati 
tugiladi.  
Горячая зона (Hot zone) maydoni 
matnni ko’chrish maydoni bildiradi, 
ulchov birligi enidagi maydonlarda 
kiritiladi. 
   ТТТааабббуууллляяяцццииияяя   (((TTTaaabbb)))   bbbooo’’’llliiimmmiii   

Bo’limi Табуляция (Tab) 
asosan jadvallar bilan ishlaganda 
kerak bo’ladi, sababi uning 
yordamida ustinlarni tekislash amali 
bajariladi.  
Mulohat oynasining chap tomonida 
hujjatda o’rnatilgan tabulyator ruyhati keltirilgan.  Табуляторы (Tabs) ustunida   
gorizontal chiziq boyicha koordinatalari ko’rsatilgan. Bu koordinatalarni asangina 
o’zgartirsa bo’ladi kerakli katakchaga chertilib koordinatalar uzgartiladi. 
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Выравнивание (Alignment) 
ustunida tabulyator tipi 
o’rnatiladi. Uni o’zgartirish 
uchun kerakli katakcha 
tanlanilib sichqoncha bilan 
chertiladi va u ruyhat 
ko’rinishiga keladi: Левый 
(Left), Правый (Right), 
Центральный (Center). 
Десятичный (Decimal). 
Mulahat oynasidagi tugmalari 
bitta tabulattsya kiritish 
inkoniatini beradi (кнопка 
Добавить (Add tab)), agarda 
tabuliattsya soni bir nechta 
bo’lsa (Установить 
табуляторы каждые (кнопка Set tabs every)) yordamida  teng bo’lgan masofalardan 
berilgan o’lchamda qoyiladi. 
 Удалить табулятор (Delete tab) va  Удалить все (Delete All) tugmalari bitta yaki 
ajratilgan ruyhatdagi tabuliatsialar uchiriladi. 
РРРааамммкккиии    иии    кккооолллооонннкккиии    (((FFFrrraaammmeeesss   aaannnddd   CCCooollluuummmnnnsss)))   bbbooo’’’llliiimmmiii   

Рамки и колонки (Frames 
and Columns) bo’limi fahat 
abzats matniga ishlaydi. Bu 
yordamida ko’p kolonkali 
maydonlar bilan ishlash 
imkoniyatini beradi.  
 Число колонок (Number of 
columns) maydonida kolonkalar 
soni kiritiladi. 
Большое поле Ширина 
колонки и пробелы (Column 
width and gutter) lar kolonka 
o’lchamini va ular orasidagi 
masofani bildiradi. Номер 
колонки (Column #) ustunida  
kolonka tanlanadi,  Ширина (Width) kolonka eni beriladi, Пробел (Cutler) – 
ustunida kolonkalar orasidagi bush joylar beriladi.. 

Равная ширина колонок (Equal column width) flag qoyilgan bo’lsa kolnkalar 
o’lchami bir hil bo’ladi fahat bitta kolonka parametrlarini kiritish kifoya. 

Ширина абзацной рамки (Paragraph frame width) maydonida ish 
maydonidagi barcha kolonkalar xajmi 
Вертикальное выравнивание (Vertical justification) toliq bo’lmagan kolonkaning 
joylashishi beriladi: Сверху (Тор), По центру (Center), Снизу (Bottom) и По 
формату (Full). 
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ЭЭЭффффффеееккктттыыы    (((EEEffffffeeeccctttsss)))   bbbooo’’’llliiimmmiii   

Эффекты (Effects) bo’limi ruyhatlarni bezashda ,bosh harflarni (drop caps) 
yozishda qullaniladi.  

Тип эффекта (Effect Type) ruyhatida quyidagilarni tanlashimiz ga bo’ladi:  
• Маркер абзаца (Вариант Bullet), matn boshiga joylashtirilgan boshqacha 

ko’rinishta ezilib matndan ayrixsha bulib turadi. 
• Вариант Буквица (Drop cap), Suzning birinchi harfi katta turda yozilgan 

bo’ladi. 
Отступы (Indents) ni matnni kiritilishdagi shegarasi belilash, bu matnga 

nisbatan qoyiladi.  Простой маркер (Bulleted) varianti abzats ichidagi markerning 
joylashishi, Выступающий маркер (Hanging Indent)varianti esa abzatsdan 
tashqaridagi joylashishi bildiradi. 

 
Abzats markerlari fahat abzats matniga qoyiladi. 

Расстояние от текста (Distance from text) maydonida katta harf bilan  
orasidagi masofani bildiradi. 
  Простая буквица (Dropped) varianti harfni butun matn boyicha joylashtiradi, 
Выступающая буквица (Hanging Indent) varianti esa asosiy matndagi suz boshini 
bildiradi. 

Свойства объекта (Object Properties) panelidagi Свойства (Property Bar) 
yordamida formatlash  

 
Shriftning parametrlarini Свойства (Property Bar) 
malumot satri yirdamida ham formatlash mumkin.  
MMMaaatttnnnnnniii   iiihhhtttiiiyyyooorrriiiyyy   ssshhhaaakkklllllliii   ooobbbyyyeeekkktttdddaaa   jjjoooyyylllaaassshhhtttiiirrriiissshhh      
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CorelDRAW dasturi kolonkalarning hoqlagan turini yoratish imkoniyatiga ega. 
Buning uchun yopiq grafik konturni matn uchun konteyner qilib olinadi.Matnni 
konteynerga joylashtirish nushun Текст (Text),  asbobini ishga tushirish kerak va 
kursorni obyektning konturiga olib kelib sichqoncha bilan chertiladi. Shtrixlangan 
kontur yuzaga kelgandan keyin matnni kiritib boshlash kerak. 
MMMaaatttnnnnnniii   iiihhhtttiiiyyyooorrriiiyyy   tttrrraaaeeekkktttooorrriiiyyyaaa   bbbooo’’’yyylllaaabbb   
jjjoooyyylllaaassshhhtttiiirrriiissshhh      
Obyekt bilan boglangan matn hafahat obyekt 
ishga silzitilishi mumkin, kontur boyicha 
hoqlagan shalnga ham keltirish  mumkin. 
Matn bilan egri chiziqni boglash ushun  avval 
ekkalasini ajratish kerak va menuning Текст 
(Text), аправить текст по траектории (Fit 
Text to Path...) buyruqlari bajariladi. 
Matnni kontur traektoriasida korinadigan holga 
keltirish uchun Текст (Text) tanlanilib,va 
kursorni konturga olib kelganda kontur shakli uzgaradi oxirida sichqoncha bilan 
chertiladi. Matn kursori paydo bo’lgandan keyin matin keritilib boshlanadi. 

Boglangan dinamik obyektlarni boshqarich uchun menuning Окно/Панели 
типа Docker (Window/Dockers) , Направить текст по траектории (Fit Text to 
Path) buyrugi yordamida amalga oshiriladi. 

 
Ориентация текста (Text Orientation) (1 raham) traektoryaga nisbatan matnning 
yonalishini aniqlash  
Вертикальное выравнивание (Vertical Alignment) (2 raham) vertikal traektoryaga 
nisbatan matnni joylashishi. 
Agarda matn ochiq kontur boyicha joylashgan bo’lsa  Направить текст по 
траектории (Fit Text to Path) panelida Горизонтальное выравнивание (Horizontal 
Alignment) da payda bo’ladi,bu esa matnni gorizontal boyicha jpylashtirishni 
bildiradi. 

Горизонтальное выравнивание (Horizontal Alignment) yopiq kontur uchun 
matn kvadrat shakl ichiga olib yoziladi (3 raham). 

 Редактировать (Edit...) buyrugi  Направить текст по траектории (Fit Text 
to Path) panelida joylashgan bolib ekranga mulohot oynasini chiqaradi. Bu oynada  
matnni traektoria boyicha  (Fit Text P Offset) gorizontal yaki vertikal silzishini 
bildiradi. 
MMMaaatttnnnnnniii   eeegggrrriii   ccchhhiiizzziiiqqqlllaaarrrgggaaa   ooo’’’tttqqqaaazzziiissshhh   

Grafika va verstka dasturlarida 
shrift har xil transformatsyaga uchraydi 
fahat harfning qismlarini o’zgartirish 
imkoniyatiga ega emas. 
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Shriftlar maxsus dasturkarda yoratiladi, shu dasturlar yordamida shriftlar qayta 
muharrirlanadi va belgili formatlarda faylga yoziladi.Operatsion sistemaga 
o’rnatilgandan keyin barcha amaliy dasturlarda ishlash imkoniyatiga ega bo’ladi. 
Harfni alohida egri chiziqqa aylantirihsni qarab utaylik, uning uchun belgilangan 
matnni menuning Управление 
(Arrange) dan Преобразовать в 
кривые (Convert to Curves) buyrigi 
yirdamida amalga ochiriladi va 
natijada alohida bo’lgan 
obyektlarga ega bulamiz.Bu buyruq 
grafik dizainda keng 
foydalaniladi.Logotiplarni 
yoratishda avval mas keluvchi shrift 
tanlanadi va firma nomini kiritamiz, 
formatlashning barcha usullari ishlatiladi, keyin har bir shrift egrichiziqga 
konvertizatsya qilinadi, natijada olingan matnga hohlagancha ishlov berishga bo’ladi. 
GGGrrraaafffiiikkk   ooobbbyyyeeekkktttnnniii   mmmaaatttnnn   bbbiiilllaaannn   jjjoooyyylllaaassshhhtttiiirrriiissshhh      

CorelDRAW dasturida obyektli matnlar  bilan ishlaganda obyektga matn 
boglanmaydi, grafik obyektga faqat chegaralash beriladi shu sababli abzats matnda 
obyektni joylashtirganda avtomatik ravishta chegaralash bajariladi. 

Obyektni «обтекаемый» qilish uchun kursorni obyektga olib kelib sichqoncha 
ong tomoni bilan chertiladi,keyin Обтекать абзацным текстом (Wrap Paragraph 
Text) buyrugi bajariladi. Asboblar panelidagi Свойства (Property Ваг) da Обтекать 
абзацным текстом (Wrap Paragraph Text) nugmasi ham shu amaalni bajaradi. 

Obyekt bilan matn orasidagi masofani o’zgartirish uchun: kursor obyektga olib 
kelinib sichqoncha ong tomoni chertiladi, va Свойства (Properties...) buyrugi 
bajariladi. Bu quyidagicha amalga oshiriladi Свойства объекта (Object Properties) 
panelidan  Общие (General) tanlanilib  Смещение обтекания текста (Text wrap 
offset)ga  masofa uzunligi kiritiladi. 
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EEEdddiiittt   TTTeeexxxttt   dddiiiaaallloooggg   oooyyynnnaaasssiii   

 CorelDRAW Maxsus matn maharrir bo’lmagani bilan matn 
muharriridagi barcha funktsyalar mavjud bo’lgan maxsus 
muharrirlash oynasi Редактирование текста (Edit Text) 
ega. Bu oyna menudagi Текст (Text) yordamida ishga 
tushiriladi. 
Oynadagi katta joy matnni kiritish, muharrirlash, va 
formatlash uchun  muljallangan. Bu oynaga matn fayllarini 
(кнопка Import...) tugmasi yordamida import qilish 
imkonioti ham bor. 
Oynaning yoqargi qismida matnni formatlash amallari 
(garniturni tanlash, kegl, abzatslarni markerlash va h.) 
joylashgan. 
Форматирование текста (Format Text...) tugmasi 
yordamida matnni tashqi bezashlariga muljallangan.Опции 
(Options) tugmasi esa asosan matnni imlosini tekshirishga 
bogishlangan. 
Grafik obyektlarni matnga joylashtirish 
Dastur grafik obyektlarni matnnli blokga joylashtirish imkoniotlari mavjud, bu 
obyektlar shriftlarga proportsional ravishda masshtablanadi. Bu funktsiyalar matnga 
grafik elementlarni joylashtiriganda juda qol keladi, masalan lagatiplar bila 
ishaganda. Grafik elementlarni matnli blokga qo’yish paytida Clipboard bilan 
ishlanadi yoki menuning  Редактировать (Edit)dagi Копировать (Сору), Вырезать 
(Cut) Вставить (Paste)  amallaridan foydalaniladi. 
BBBeeelllgggiiilllaaarrr   vvvaaa   mmmaaaxxxsssuuusss   bbbeeelllgggiiilllaaarrr   

CorelDRAW dasturida Символы va  Cпециальные знаки (Symbols and Special 
Characters) panelleri mavjud bulib, ekranga menuning Окно/Панели типа Docker 
(Window/ Dockers) orqali chaqiriladi. 
Bu panelning obyektlari ekki qil xossaga ega: agarda hujjatga alohida qoyilsa grafik 
obyekt hisoblanadi, matga qoyilsa belgi hisoblanadi. 
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Символы va специальные знаки (Symbols and Special Characters) panelning yoqri 
qismida shrift fayllari ruyhati beriladi, tagida maydonda esa  tanlangan fayldagi 
belgilar ko’rinishi beriladi. 
Belgini tanlash ushun sichqoncha bilan tanlanilib chertiladi yoki Клавиша 
(Keystroke)da maxsus Alt-код kiritiladi. 
Belgi ulchovi Кегль (Symbol Size) yordamida tanlanadi. 
 Декоративная сетка из символов va специальных знаков (Tile Symbol/Special 
Character) buyrugi  palitradan bitta belgini bir xil 
masofada joylashitadi. 
Torning parametrlari Параметры декоративной 
сетки (Tile Options) yordamida uzragtiladi.  
Размеры сетки (Grid size) maydonoda torning 
gorizontal va vertikal parametrlari o’rnatiladi. 
IIImmmlllooonnniii   ttteeekkkssshhhiiirrriiissshhh   
CorelDRAW dasturi matnlar bilan ishlashning 
barcha funktsialari bilan ishlaydi, shu 
funktsyalardan biri matnning imlosini 
tekshirishi.Imloni tekshirganda suzni to’gri 
yozilishi,noto’gri suzlarni uchirib to’grisi bilan 
olmoshtiriladi. 
 

555   ZZZaaallliiivvvkkkaaa   (((FFFiiillllll)))   vvvaaa   ooobbbvvvooodddkkkaaa   (((OOOuuutttllliiinnneee)))   pppaaarrraaammmeeetttrrrlllaaarrriii   
Zalivka va obvodka parametrlari bilan ishlashda CorelDraw dasturi biriktirilgan 
ekkita guruh asboblariga  ega: Заливка (Fill) Обводка (Outline). 

 
Agarda yoqaridagi  asboblardan foydalanmaydigan bo’lsak Без заливки (No Fill) 
(Fill Flyout  6 rahami bilan berilgan) va  Без обводки (No Outline) ( Outline Flyout 3 
rahami bilan berilgan) tanlaniladi. 
BBBiiirrr   xxxiiilll   rrraaannngggllliii   zzzaaallliiivvvkkkaaalllaaarrr   

Obyektlarni rangli qilib boyashning (zalivka) eng tez usuli 
Палитра Цветов (Color Palette) panelidan foydalanish 
bo’ladi, bu panel ekranning ung tomonida  hamma vaqt 

chiqarilib turadi. Agarda foydalanuvchiga ranglar eqmasa 
menudagi Окно (Windows) buyrugi va Цветовые 

палитры (Color Palettes) orqali boshqa panel tanlaniladi. 
Tanlanilgan obyektga zalivka qilish uchun sichquoncha 
chap tomoni chertiladi,obvodka qilish uchun ung tomoni 
chertiladi. Bu amalni «перетаскивания» usuli bilan ham 
amalga oshirsa bo’ladi. Buning uchun kerakli rangni 
tanlaymiz va obyektga olib borib tashlaymiz,agarda  
<Shift> tugmasi bosilgan holda bajarilsa zalivka qilinadi, 
<Alt> tugmasi bilan amalga oshirilsa obvodka boyaladi. 
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ОООддднннооотттоооннннннаааяяя   зззааалллииивввкккааа    (((UUUnnniiifffooorrrmmm   FFFiiillllll)))   dddiiiaaallloooggg   oooyyynnnaaasssiii   
Rangning spektrlari va inkoniotlari bilan 
ishlash Однотонная заливка (Uniform 
Fill) oynasi yordamida amalga oshiriladi. 
Bu Заливка (Fill Flyout) panelidagi 1 
rahamini bosish orqali bajariladi. Обводка 
(Outline Flyout)ga rang berish uchun 
paneldagi 2 rahamiga chertiladi va  Цвет 
обводки (Outline Color) oynasi paydo 
bo’ladi. 
Bu oynaning tortta rejimi mavjud: 

• Цветовые модели (Models). Bu 
ranglar maydonidan berilgan ranga 
mos rangni tanlashni taklif qiladi. 

• Смесители (Mixers). Bu amal 
birinchadan ranglar seryasini to’rtta rangdan olishni, ekkinchidan  «garmonik 
akkordlar» ranglarni yoratishni taklif etadi. 

•  Стандартные (Fixed Palettes) va Пользовательские палитры (Custom 
Palettes). Obyektlarga ranglarni berishni taklif etadi. 

•  Цветовое поле Исходный цвет (Old) obyektning rangini o’zgartirmasdan 
avvalgi rangni, Новый цвет (New) maydoni esa joriy mulohat oynasidagi 
rangni bildiradi. Составляющие цвета (Components) maydonida tanlangan 
ranglar modelidan rang parametrlari tanlanadi. 

•  Имя (Name) ruyhatidagi yangi  rangga nom beradi. 
   ЦЦЦвввеееттт    (((CCCooolllooorrr   )))pppaaannneeellliii   

Цвет (Color) paneli asboblar panelidagi mos bo’lgan Заливка (Fill) turmasi (7 
rahami bilan berilgan) bosish yoqarida ko’rsatilgan amallarni bajaradi. 
ГГГрррааадддиииееенннтттннныыыеее   зззааалллииивввкккиии    (((FFFooouuunnntttaaaiiinnn   FFFiiillllll)))   oooyyynnnaaasssiii   

Gradient zalivkalar bitta tonli ranglardan bo’lgan zalivkalardan farh qiladi. Qullanishi 
oddiy rang parametrlari bilan ishlashga uxshash. 
Градиентная заливка (Fountain Fill) oynasini ekranga chaqirish uchun Заливка 
(Fill) panelidagi tugmani bosish kerak ( 2 rahami bilan berilgan)  
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Gradient zalivkalarning tortta tipu mavjud bulib ular  Тип (Type) rayhatidan 
tanlaniladi. 

• Заливка Линейная (Linear) tipi to’grichiq boyicha boyash. 
• Заливка Радиальная (Radial) aylana shakli boyicha boyash. 
• Заливка Коническая (Conical) konus shakli boyicha boyash. 
• Заливка квадратная (Square) kvadrat shakli boyicha boyash. 

Shu bilan birga gradient zalivkalar oddiy (bitta berilgan rang ustida )va murakkab (bir 
nechta ranlardan bir –biriga utishi ) bo’ladi 
Agarda Двухцветная растяжка (Two color) joriy bo’lsa ,u holda  birinchi va pxorgi 
ranglar От (From) va До (To) tugmalaridan aniqlaniladi. Ekkita rangning bir xil 
proportsiada olinishi surgish markazda holida bo’ladi,agar zarur bo’lgan holda buni  
Средняя точка (Mid - point) yordamida o’zgartirilsa bo’ladi. 
ДДДееекккооорррааатттииивввннныыыеее   зззааалллииивввкккиии    oooyyynnnaaasssiii   

Декоративная заливка (Pattern Fill) mulohat 
oynasi ekranga shaqirish uchun asboblar 
panelidagi Заливка (3 raham bilab berilgan) 
tugmasi bosiladi. Декоративная заливка 
(Pattern Fill) uchta turi mavjud:ekkita 
rangli,toliqrangli va nuqtali. 
ДДДвввууухххцццвввееетттннныыыеее   дддееекккооорррааатттииивввннныыыеее   зззааалллииивввкккиии    oooyyynnnaaasssiii   

Ekkita rangli dekorativ zalivka ishga tushirish 
ushun  2-цветная заливка (2-color) tanlanadi , 

va Декоративная заливка (Pattern Fill) 
mulohat oynasi quyidagi ko’rinishta bo’ladi. 

Mulohat oynasi markazida 2-цветная 
заливкаning tayor turlarini tanlaydigan tugma 
joylashgan. 
Ekkita rangli zalivkada  rasm rangi (Передний 
план (Front)) va  fon rangi (Задний план 
(Back)) bo’ladi.. (Create…) tugmasi va двухцветной заливки (Two-Color Pattern 
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Editor) muharriri yordamida yangi ekkita rangli 
zalivkalarni yoratish yoki eskilarini muharrirlash 
mumkin. Uning uchun chizilgan bit kartasida (o’lchami 
ni Размер битовой карты (Bitmap size) yordammida 
o’zgartirishga bo’ladi) «shtrix » o’lchami (Pen 
size)dagi pero o’lchamidan qoyiladi. 
 
ПППооолллннноооцццвввееетттннныыыеее   вввеееккктттооорррннныыыеее   иии    тттооочччееечччннныыыеее    зззааалллииивввкккиии    
oooyyynnnaaasssiii   
Toliq rangli zalivkada uz ning dekorativ maydoniga ega bulib ,u 
alohida .pat kengaytgichga ega bo’lgan vektor elementlaridan 
tashkil topadi. Agarda Полноцветная заливка (Full color) yoki 
Полноцветная точечная заливка (Bitmap) joriy bo’lsa , u holda 
Декоративная заливка (Pattern Fill) oynasi quyidagicha bo’ladi.  
 
 
ТТТееекккссстттууурррннныыыеее   зззааалллииивввкккиии    oooyyynnnaaasssiii   

CorelDRAW dasturidagi matn 
zalivkalari nuqtali tasvirlardan tashkil 
topgan bo’ladi, ular hoqlagan 
tasvirlardan ixtimollyi ravishda 
tanlanishi fraktal  asosida olinadi, 
masalan – oynadagi soviqning 
ko’rinishi. 
Matnli zalivkalarning parametrlari 
Текстурная заливка (Texture Fill) 
oynasida beriladi. Bu oyna asboblar 
panelidagi Заливка (Fill) ( 4 rahami 
bilan berilgan)tugmasini bosish bilan 
paydo bo’ladi. 
Mantnni ezish uchun Библиотека 
текстур (Texture library) maydonidan  
bittasini tanlash kerak , keyin  

Текстуры (Texture list) ruyhatidan matnni tipi tanlaniladi.Mulohat oynasini pastki 
qismida boshqarish maydonida har bir matn turi haqida malumot beriladi va u har bir 
matn turi uchun alohida ko’rsatiladi. 
Har bir maydon ung tomonida qilf ko’rinishidagi belgiga ega Buning vazifasi 
quyidagicha agarda qulf ochiq bo’lsa u holda matnni tanlash ixtomoliy bo’ladi. 
Agarda belgili bir qiymatda uzgarmaydigan bo’lsa masalan,rangi, yoki  parametrlar 
foyz nisbatlari uzgarmasa. 
Hamma parametrlar uzgartilgandan keyin tasvirni oynada ko’rish ushun Просмотр 
(Preview) tugmasi bosiladi va tasvirni dastur qayta ishlab ekranda ko’rsatadi 
 
PPPooossstttSSScccrrriiipppttt---зззааалллииивввкккиии    oooyyynnnaaasssiii   
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PostScript-zalivka parametrlarini 
aniqlash  uchun PostScript-заливка 
(PostScript Texture) muohat oynasidan 
foydalaniladi,bu oyna Заливка (Fill) ( 5 
rahami) paelidagi maxsus tugma orqali 
ishga tushiriladi. 
Zalivkani tanlash uchun ruyhatdan 
hoqlagan bittasini tanlash kerak. Agarda 
Просмотр заливки (Preview fill)ga 
belgi qoyilgan bo’lsa ,oynada zalivkani 
real ko’rinishi nomayon bo’ladi. 
PostScript- zalivkalar matn zalivkasidan 
parametrlar berilishi bilan bir-biridan 
farh qiladi. Agarda qandatdir parametri o’zgartirilgan bo’lsa yangi parametrlarni 
uzlashtirish ushun  Обновление (Refresh) tugmasi bosiladi.. 
ИИИнннссстттрррууумммееенннттт   ИИИнннтттеееррраааккктттииивввнннаааяяя   зззааалллииивввкккааа    (((IIInnnttteeerrraaaccctttiiivvveee   FFFiiillllll)))   oooyyynnnaaasssiii   

 Интерактивная заливка (Interactive Fill) Свойств а (Property Bar) asboblar 
paneli bilan birgalikda ishlatiladi.  
Bu asbobni ishga tushirish uchun obyektni belgilash kerak vaasboblar 
panelidan zalivka turini tanlaydi. Har bir zalivka turiga uzining parametrlari 
foydalaniladi. Muharrirlash uchun Свойства (Property Bar) asboblar panelida 
maxsus Редактировать (Edit…) tugmasi yordamida amalga oshiriladi.  
 

 

 
 
 

ПППааарррааамммееетттрррыыы   оообббвввооодддкккиии    (((OOOuuutttllliiinnneee   PPPeeennn)))   oooyyynnnaaasssiii   
Konturning barcha parametrlari Обводка (Outline) ( 1 rahami bilan berilgan) 
panelidagi Параметры обводки (Outline Pen) oynasidan kiritiladi  
Цвет (Color) obvodka rangini bildiradi. Bu tugmaga chertilganda quyidagicha 
palitra ekranga chiqariladi.Agarda boshqa palitra yoki rangning boshqa turini 

tanlash kerak bo’lsa  Другие (Other...) tugmasini bosish orqali amalga oshiriladi va 
ekranda . Цвет обводки (Outline Color) payda bo’ladi. Bu oynani boshqacha usul 
bilan ham chaqirish mumkin, uning uchun asboblar panelidan Обводка (Outline) (2-
rahami bilan berilagn) tugmasi bosiladi. 
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Толщина (Width)maydonida obvodka qalinligini o’rnatadi.Uning enida mos 
keladigan ulchov birliklarini tanlash mumkin. 
 Стиль (Style) chiziqning har xil stillarini tanlaydi -сплошной, пунктирной, 
штриховой, штрих пунктирной va h.  
 Добавить (Add) va Заменить (Replace) tugmalari ruyhatga yangi stillarni qo’shadi 
yoki ularni boshqa stil bilan o’zgartiradi. 
 Углы (Corners), Параметры обводки (Outline Pen)  mulohat oynasida joylashgan 
bulib utkir burchaklarni chizishda ishlatiladi. 
(Options) parametrlari burchakni kesishlarda ishlatiladi. 
Birinchi o’tkazgich utkir burchakni, ekkinchi o’tkazgich 
burchakning aylana shkliga kelishi, uchinchsi esa kesishni 
bildiradi. 
 Концы линий (Line Caps) maydoni chiziqlarni, 
shtrixlarni oxirini qanaqa bo’lishini bildiradi. 
Стрелки (Arrows) maydonidan yonalishning ekkitasidan 
bittasi tanlaniladigan tugmalar – biri kontur boshini , 
ekkinchisi esa oxirini bildiradi. Опции (Options) ruyhatni 
ochadi va yonalishlar bilan ishlashni bildiradi. 
BBBiiittttttaaa   ooobbbyyyeeekkktttnnniiinnnggg   pppaaarrraaammmeeetttrrrlllaaarrriiinnniii   bbbooossshhhqqqaaa   ooobbbyyyeeekkktttgggaaa      
Foydalanuvchi obyektga qanday parametrlar berganligi va 
uni ekkinchi obyektga qullash uchun CorelDRAW  
dasturida maxsus buyruq bor. 
Dastlab parametrlari beriladigan obyekt tanlanadi, keyin menuning Редактировать 
(Edit) va Копировать параметры у… (Copy Properties From...) buyruqlari 
bajariladi, ekranda Копировать параметры (Copy Properties) oynasi paydo bo’ladi. 
Oynadan kerakli bo’lgan parametrlar tanlaniladi: Параметры обводки (Outline Pen). 
Цвет обводки (Outline Color) Заливка (Fill) и Параметры текста (Text Properties). 
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666   QQQaaatttlllooommmlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   
Qatlam deganimizda obyektlar joylashtiriladigan прозрачную tekislik. Bu tekislikni 
barcha obyektlari bilan jilzitishga, o’chirishga,ekranda ko’rsatishga va bosmadan 
chiqarishga bo’ladi. CorelDraw dasturida hujjatlarni yoratganda tortta qatlom bo’ladi: 
birinchi qatlom– tasvirlanadigan (Layer 1), ekkinchisi –  (Master Grid) tori uchun, 
uchincuisi - (Master Guides) yonalish ushun va tortinchi –  «ish stoli » (Master 
Desktops) uchun. 
Yangi qatlamklarni qo’shish obyektlar bilan ishlashda qiyinchilik tugdirmaydi. 
Har bir sahifadagi qatlamlar soni bir xil parametrlarda va  bir xil nomida bo’ladi. 
Agarda qandaydir qatlam bitta sahifada ko’rinmas holiga kelib qolsa boshqa 
sahifalardagi qatlomlar ham ko’rinmas bo’ladi. Shu bilan birga barcha sahifada 
qatlomlarning joylashish tartibi ham birdan uzgaradi.  

 
   QQQaaatttlllooommmlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhhnnniiinnnggg   ДДДиииссспппееетттчччеееррр    оообббъъъеееккктттоооввв    
(((OOObbbjjjeeecccttt   MMMaaannnaaagggeeerrr)))   pppaaannneeellliii      
Qatlamlar ustidagi hamma operatsyalar (yoratish, 
o’chirish, to’grilash va h.) Диспетчер объектов 
(Object Manager) paneli yordamida bajariladi.Bu 
ekranga menuning Окно\Панели типа Docker 
(Windows\Dockers) va Диспетчер объектов (Object 
Manager)buyruqlari bilan chaqiriladi.  

Panel sarlovhasi tagida turtta tugma joylashgan 
(chapdan ung tomonga): 

1.  Новый слой (New layer) tugmasi yangi 
qatlamni Слой (Layer) nomi va mos raham nomeri bilan qo’shadi. 

2. Показать свойства объектов (Show Objects Properties) tugmasi obyektning 
xossalarini ko’rsatadi. 

3. Для редактирования  tugmasi barcha qatlamlar uchun tuzatish kiritish 
imkoniyati tugiladi agarda u uchirilgan bo’lsa faqat joriy qatlamda ishlashga 
bo’ladi. 

4. Вид диспетчера слоёв (Layer Manager View) tugmasi qatlomlar dispetcherini 
ko’rinishini ko’rsatadi. 

Piktogramma sichqonchani ung tomoni bilan chertilsa qatlamning xossasini 
bildiradigan menu chiqariladi, u yordamida qatlamni o’chirish yoki uning nomini 
o’zgartirish mumkin. 

YYYaaannngggiii   qqqaaatttlllaaammm   yyyooorrraaatttiiissshhh   

Yangi qatlam Новый слой (New Layer) tugmasi yordamida yaratiladi.Foydalanuvchi 
hoqlagancha qatlamlarni yaritish imkoniyatiga ega faqat chegaralanish komputer 
texnik parametrlariga bogliq bo’ladi. 
Qatlamga nom berish 
Yangi nom berish qatlam yaratilgan paytda beriladi,agarda qatlamga nom berilgan 
bo’lsa uni nomini o’zgartirish Переименовать (Rename) buyrugi bilan amalga 
oshiriladi. 
Qatlamni joryi qilish 
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Hoqlagan yangi yaratilga obyekt joriy qatlamga joylashtiriladi,shu sababli obyektni 
hoqlagan qatlamga oyish uchun, bu qatlamni Диспетчер объектов (Object Manager) 
panelida qatlam nomiga sichqonch bilan chertib belgilash kerak. Qatlamning joriy 
ekanligini bilish ushun qatlam nomi rangiga qarash kerak, agar  qizil rangda bo’lsa 
qatlam joriy deb tushiniladi.  

Qatlamlarning joylashish tartibini o’zgartirish 
Qatlamlarni tartibi Диспетчер объектов (Object Manager)dan uzgartiladi, uning 
uchun kerakli qatlamlarni sichqonsha yordamida pastga yoki yoqariga surib urnini 
o’zgartirish mumkin.  

QQQaaatttlllaaammmlllaaarrrnnniii   ooo’’’ccchhhiiirrriiissshhh   
Palitradagi ajratilgan qatlamni va undagi obyektlarni o’chirish quyidagicha bajariladi: 

• <Delete> tugmasini bosish orqali; 
• Menudan Удалить (Delete) buyrugini bajarish orqali; 
• Menudagi Диспетчер объектов (Object Manager) buyrigidan Удалить слой 

(Delete Layer) tanlanishi orqali 
 Master Grid, Master Guides, Master Desktop- standart qatlamlarini uchirich 
mumkin emas. 

QQQaaatttlllaaammmlllaaarrrnnniii   fffiiikkkssseeerrrlllaaassshhh   
Fikserlangan qatlam bitta butun hisoblanib unda joylashgan obyektlar 
ajratilmaydi,o’zgartirilmaydi, siljitilmaydi va uchirilmaydi. Fikserlanganlik belgisini 
Диспетчер объекта (Object Manager)  panelidan qatlamlar satrida «kuk rangdagi 
kalam» joylashganligidan bilishga bo’ladi. 
Qatlamlarni fiksarlash uchun qalamning piktogrammasiga sichqoncha bilan chertish 
kifoya, qalam uzinig rangini o’zgartiradi.Ekkinch marta chertilsa fikserlash olinadi. 
QQQaaatttlllaaammmlllaaarrrnnniii   vvvaaaqqqtttiiinnnccchhhaaa   eeekkkrrraaannndddaaannn   ooollliiibbb   qqqooo’’’yyyiiissshhh   
Fikserlangan qatlamni muharrilashga mumkin emas. Qatlamda joylashgan obyektlar 
ekranda ko’rinish beradi.Agarda foydalanuvchiga bu qatlam kerak bo’lmasa uni olib 
ekrandan qo’yish mumkin. Bu uchun qatlamni ekrandan vaqtincha ushirib qo’yish 
imkoniyatlari mavjud. 
Диспетчер объектов (Object Manager) panelidagi  Свойства слоя (Layer 
Properties) oynasidagi Видимыё (Visible) bayroqchasini belgilash (olib tashlash) 
orqali amalga oshiriladi. 
МММааассстттеееррр    ссслллооояяя   (((MMMaaasssttteeerrr   LLLaaayyyeeerrr)))dddaaannn      fffoooyyydddaaalllaaannniiissshhh   

Qatlamni xossasi Свойства слоя (Layer Properties) oynasidan Мастер слоя 
(Master Layer) ga bayraqcha qo’yish yoki kontekst menudagi Мастер-слой 
(Master) buyrugi  hoqlagan qatlamni Мастер-слой aylantiradi. Buning vazifasi 
ko’p sahifali hujjatlarda hamma sahifalaridagi joylashgan obyektlar ko’rinadigan 
holga keltiriladi. 
Agarda fahat joriy sahifada ko’rinadigan holga keltirish kerak bo’lsa Применить 
свойства слоя только к текущей страницы (Apply all property changes to the 
current page only) ga bayroqcha qo’yish orqali amalga oshiriladi. 
OOObbbyyyeeekkktttlllaaannniii   bbbiiittttttaaa   qqqaaatttlllaaammmdddaaa   eeekkkkkkiiinnnccchhhiii   qqqaaatttlllaaammmgggaaa   kkkooo’’’ccchhhrrriiissshhh   
Har xil qatlamklarda joylashgan obyektlarni ko’chrish va ulardan nusqasini olishga 
bo’ladi. Bu uchun menuning panelidagi Переместить на слой (Move To Layer…) 
va Копировать на слой (Copy To Layer…) buyruqlaridan foydalaniladi. Amal 
bajarilganda ekranda qarlam nomini ko’rsatish yonalishi chiqariladi. 
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Agarda obyektlarni joriy qatlamda ko’chrish kerak bo’lsa  bu sichqoncha bilan 
amalga oshiriladi. Bu uchun obyekt yoki obyektlar tuplamini tanlash kerak va 
sichqoncha yordamida ko’chrish kerak bukgan joyga qoyiladi. 

777...RRRaaannnggg   vvvaaa   vvveeekkktttooorrr   eeeffffffeeekkktttlllaaarrriii   
CorelDRAW vektor dasturida obyektning shaklini Форма (Shape) asbob 

yordamida o’zgartirsa bo’ladi, ko’pchilik hollarda obyektning har bir tayanch nuqtasi 
builan ishlashga to’gri keladi, bu esa qiyinchiliq tugdiradi. Bu masalani echich uchun 
effektlar ko’rinishi dagi maxsus dastur ishlab chiqilgan. 
OOOddddddiiiyyy   vvveeekkktttooorrr   eeeffffffeeekkktttlllaaarrriii   

Oddiy vektor efektlariga oddiy obyektdan murakkabga  yoki teskarisi 
murakkabdan oddiyga utadigan obyektlardan tashkil topadi. Natijada obyekt shakli 
hechqanday uzgarishga (deformatsya) uchramaydi fahat unig tashkil etuvchilar 
yigindisi uzgaradi. 
Комбинировать (Combine) buyrugi 

 
Комбинировать (Combine) buyrugi, Свойства (Property Bar) menuning 

tashkil etuvchisi Управление (Arrange)  yordamida bir yoki bir-nechta obyektlarni 
bitta obyektga birlashtiradi. Bu buyruqni obyektlarning tayanch nuqtalarini 
biriktirganda,nihabini olganda yoki teshikchalar paydo qilganda qullaniladi. 

Комбинировать (Combine) buyrugini foydalanishdan avval biriktirilishi kerak 
bo’lgan obyektlar ajratiladi. Agarda obyektlar har hil zalivkalarda bo’lsa 
biriktirilgandan keyin eng pastdagi obyekt zalivkasi olinadi. 

 
Bu buyruqning manasini yaqshi uzlashtirib olish kerak: obyektlar applikatsia 

printsipaga asoslangan holda uzining xossasiga ega bulib obyektlar bitta bosqishga 
olib kelinib boyaladigan va boyalmaydigan obyektning qismlarini qayta bo’lishtiradi. 
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Qayta bo’lishtirilganda kesishmaydigan obyektlar natijaviy obyektga kiradi, 
kesishadigan obyektlar esa ko’rinmas holga keltiriladi. 

 
Protsesni tushinish uchun shunday qoida bor. Agarda uzimizning fikrimizda chiziqni 
chapdan ungga utgazilsa u holda obyektni keib utgan birinchi konturdan boshlab 
zalivka boshlanib,ekkinchi konturda zalivka tugatiladi ( «techikcha» bo’ladi) undan 
keyingisida zalivka bo’ladi va h. 
РРРааазззбббииитттььь   кккооомммбббииинннаааццциииююю   (((BBBrrreeeaaakkk   AAApppaaarrrttt)))   bbbuuuyyyrrruuugggiii   

Управление (Arrange) menusida Комбинировать (Combine) buyrugi 
birgalikda Разбить комбинацию (Break Apart) buyrugi ham mavjud bulib , ko’p 
konturli obyektni obyektni tashkil etuvchi konturlarga ajratadi,va ular alohida bitta 
obyekt deb tushiniladi. Bu amalni Комбинировать (Combine) buyruqni bekor 
qilishda  yoki obyektni tashkil etuvchi konturlarga bulib ishlagan foydalaniladi. 

Obyektni belgilab Свойства (Property Bar) 

  
panelidagi Управление (Arrange) buyruqni tanlagandan keyin ishga 

tushiriladi. 
ИИИзззмммееенннеееннниииеее   фффооорррмммыыы(((SSShhhaaapppiiinnnggg)))   pppaaannneeellliii   

Управление (Arrange) da 
yanada uchta buyruq mavjud bulib 
,Комбинировать (Combine) 
buyrugining turlaridan bulib, 
birlashtirishning quchimcha turlarini 
uz ichiga oladi. Bu uchta buyruq  
Docker paneliga umumiy nomi 
Изменение формы (Shaping) qilib 
berlashtirilgan, yoki Свойства 
(Property Bar) panelida tugmalari ham berilgan . 
Buyruqning ayriqcha tomoniga etibor berish kerakki, berilgan 
obyektlarning guruhiga ham qullasa bo’ladi. (obyektlar belgilanib 
меню Управление (Arrange) menusidagi Сгруппировать (Group) 
buyrugi bajariladi). 
ОООбббъъъееедддииинннииитттььь   (((WWWeeelllddd)))bbbuuuyyyrrruuugggiii   

Управление (Arrange) menusidagi yoki Свойства (Property 
Bar) panelidagi Объединить (Weld) buyrugi yordamida hamma 
obyektlarni umumiy perimetrlari boyicha konturi chiziladi 
Obyektlarni birlashtirish uchun bir yoki ekkita obyekt tanlanilib 
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Объединить с… (Weld To...) tugmasini bosish kerak va ko’rsatilgan yonalish 
yordamida oxirgi obyektdagi obvodka , zalivkalarni yangi obyektga qullaydi. 

 
Сохранить оригинал (Leave Original) maydonida quyidagi amallar bajariladi. 

• Конечный объект(ы) (Target Object(s)) bayroqchasi belgilangan yoki 
yonalish ko’rsatilgan obyektni xotiraga yozishni taminlaydi. 

• Другие объекты (Source Object(s)) barcha obyektlarni xotiraga yozishni 
taminlaydi. 

ПППееерррееесссееечччеееннниииеее   (((IIInnnttteeerrrssseeecccttt)))   bbbuuuyyyrrruuugggiii   
Пересечение (Intersect) buyrugi yoki Свойства (Property Bar) panelidagi mos 

tugmalar yordmida obyektlar biriktirilib shkli barcha obyektlarning kesishidan tashkil 
topgan yangi obyekt yaratiladi 

 

 
Ishlash va bayroqchalarning vazifasi Объединить (Weld) buyrugiga uxshash bo’ladi. 

 
ОООтттсссееечччеееннниииеее   (((TTTrrriiimmm)))   bbbuuuyyyrrruuugggiii   

Отсечение (Trim) buyrugi yoki Свойства (Property Bar) panelidagi mos 
tugmalarning bazifasi  berilgan obyektlar ishidan keraksiz bo’lgan obyektlar 
birikmasini  kesib olib tashlash. 
Bu buyruqning  bajarilshi Объединить (Weld) buyrugiga uxshahs bo’ladi. 
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MMMuuurrraaakkkkkkaaabbb   vvveeekkktttooorrr   eeeffffffeeekkktttlllaaarrriii   

Murakkab turdagi vektorlar bilan ishlash menuning Эффекты (Effects)orqali 
bajariladi. Эффекты (Effects) ettida buyruqdan tashkil topgan bulib obyektlar yoki 
obyektlarnin yigindisi ustida har xil effektlar bajaradi. 
ПППееерррссспппеееккктттииивввааа    (((AAAdddddd   PPPeeerrrssspppeeeccctttiiivvveee)))   bbbuuuyyyrrruuugggiii   

 
Перспектива (Add Perspective) buyrugi Эффекты (Effects) menusida 

joylashgan bulib obyektlarni perspektivasini yaratish uchun obyektlarni har xil 
deformatsia qiladi. Bu buyruq ajratilgan obyektni shtrixlangan burchakalrida tortta 
markerli ramkaga oladi. To’griturtburchak ichida foydalanuvchi tomonidan 
gorizontal va vertikal chiziqlarga deformatsya berishga muljallangan tor 
joylashtirilgan 

Markerlarni silzitish orqali obyektni trnsformatsia qiladi va bir yoki ekki nuqtali  
perspektivasini olamiz. Perspektiva ko’rinishini o’zgartirish ucnun nuqtalarni 
surish kerak. 

Эффекты (Effects) menusidagi Копировать (Сору) buyrugi har xil effektlar 
ruyhati chiqariladi Bu buyruq yordamida perspektiva parametrlarini ekkinchi 
belgilangan obyektga qullasa bo’ladi. 

Berilgan buyruqda  Удалить < effekt nomi > (Clear < effekt nomi >) bilan 
effekt,perspektiva parametrlari uchiriladi. 

Obyektni ajratganda qanaqadir effekt foydalanilsa,dastur tomonidan uning nimini 
ko’rsatishni suraydi. 

EEEnnnvvveeelllooopppeee   bbbuuuyyyrrruuugggiii   
Эффекты (Effects) menudagi Оболочка (Envelope) buyrugi vektor 

obyektlarni qobiqga  qo’yishni bajaradi.. 
CorelDRAW dasturida bu amal quyidagicha bajariladi: 
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•  Docker turidagi panel; 
• Свойства (Property Bar) asboblar satri; 
• Интерактивная оболочка (Interactive Envelope) asbobi 

 

 
Dockers turidagi panelni ekranga chaqirish uchun:Windows menusidan Toolbars 
tanlaniladi va payda bo’lgan oynadan chap tomonda  Menus dan Customize menusi 
tanlaniladi.Oynani ung tomonida ekkinch kolonkada &Windows – &Dockers 
menusini ochamiz,birinchi kolonkadan Effects jildi ochiladi,va kerakli asbob 
tanlaniladi (bizlar & Envelope buyruqni tanlaymiz) va Add, OK tugmalarini bosish 
kerak. Shunday qilib bizlar Windows – Dockers menusiga Envelope buyruqni 
qo’shdiq.Amal bajarilganda ekranda Dockers turidagi Envelope paneli ko’rinadi.  

Интерактивная оболочка (Interactive Envelope) asbobni ishga tushirilsa 
ajratilgan obyekt atrofida turtburchak paydo bo’ladi, markerlarni silzitish orqali 
obyektni hoqlagan shaklga olib kelishga bo’ladi.Markerlarni silzitish torta 
muharrirlash rejimidan iborat: 

1. По прямой липни (Straight Line) rejimi qobiqning segmentlarini turgi chiziq 
ko’rinishida beradi.  

2.  По дуге (Single Arc) rejimi segmantlarni duga ko’rinishida beradi. 
3.  По двойной дуге (Double Arc) rejimi ekkita duga ko’rinishida beradi. 
4. Свободный режим (Unconstrained Mode) rejimi qobiq konturlarini Форма 

(Shape) asbobi bilan muharrirlaganday o’zgartirish mumkin. Bu deganimiz 
tayanch nuqtalar , va boshqarich richaglar bilan ishlash imkoniyati tugiladi. 
Obyektga tayanch nuqta qo’shish yoki uni olib tashlash mumkin bo’ladi. 
Yoqaridagi uchta rejimni maxsus tugmalar bilan 

amalga oshirsa bo’ladi: 
• <Ctrl> tugmasini ushlagan holda silzitish qarama-qarshi 

nuqtani berilgan yonalish boyicha  siljidi. 
• <Shift> tugmasini ushlagan holda silzitish qarama-

qarshi nuqtani berilgan yonalishga qarshi yonalishga 
siljitadi 

•  (<Ctrl> + <Shift>) tugmalari bilan ushlagan holda 
silzitish tayanch nuqta qolgan uchta nuqtalarni bir-
biriga teskari tomanga silzitishni taminlaydi. 

 Добавить готовую оболочку (Add Preset) tugmasi 
tayor qobiqlar ruyhatidan bittasini tanlshni bildiradi. 
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Dasturda qobiqni muharrirlashdan tashqari qobiqni haritalashning tortta usuli 
mavjud: 

1. Угловой (Putty) rejimi burchakdagi tayanch nuqtaga  markerlar qo’yishni 
bildiradi. 

2. Оригинальный (Original) rejimi burchak markerlari burchak tayanch 
nuqtalarda joylashtiriladi, boshqa tayanch nuqtalar qobiq chizigiga bulib 
beriladi. 

 
3. Горизонтальный (Horizontal) rejimi obyektni gorizontal chiziqlarini saqlagan 

holda joylashtiradi 
4. Вертикальный (Vertical) rejimi obyektni vertikal chiziqlarini saqlagan holda 

joylashtiradi  
Cохранить прямые (Keep lines) bayroqchasi obyektdagi to’grichiziqni 

saqlashni bildiradi. 
Har xil o’zgartirishlarni Свойства (Property Bar) panelidan yoki Эффекты 

(Effects) menusidan Отменить обводку (Clear Envelope) buyrugi bilan orqaga 
qaytariladi. 
ПППооошшшааагггооовввыыыййй    пппееерррееехххоооддд   (((BBBllleeennnddd)))   bbbuuuyyyrrruuugggiii   

Эффекты (Effects) menusidagi Blend (Пошаговый переход) buyrugi 
obyektning bir shaklidan ekkinchisiga utganda bajarilgan ketma-ketlikni ko’rsatadi. 
CorelDRAW  dasturida bu effektlarni quyudagicha boshqaramiz: 

 
• Docker tipidagi panel; 
• Свойства (Property Bar) asboblar satri; 
• Интерактивный переход (Interactive Blend) asbobi. 

Bu effektning eng yaxshi berilgani Docker tipidagi panelda ,u turtta : Шаги 
(Steps), Ускорение (Acceleration), Превращение цвета (Color Direction) и Разное 
(Miscellaneous) tugmalaridan iborat. 

Amaldi bajarish uchun asbob ishga tushiriladi kursor yordamida obyekt tanlanadi 
sichqoncha tugmasi bosilib shtrix chizigini oxirgi olingan obyektgacha suramiz. 
Natijada  bajarilgan amallar guruhi nomayon bo’ladi.  
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ШШШааагггиии    (((SSSttteeepppsss)))   tttuuugggmmmaaasssiii   
Пошаговый переход (Blend) panelidagi birinchi tugma Шаги (Steps) 

obyektlarni uzgarish soni va ular orasidagi masofa va biridan ekkinchisiga utish 
sonini bildiradi. 

Число шагов (Number of steps) kerakli bo’lgan aradagi obyektlar sonini 
bildiradi. 

Фиксированный интервал (Fixed spacing) Bir-biriga utich oraligini 
bildiradi.Bu amal fahat ketma-ket utish traektorya boyicha bo’lsa bajariladi. 

Вращение (Rotate) maydoni oradagi obyektlarni burishni bildiradi. 
Петля (Loop) bayroqchasi berilgan obyektlardan bir0biriga utishda ular 

orasidagi traektoriani burish xizmatini bajaradi. 
УУУссскккоооррреееннниииеее   (((AAAcccccceeellleeerrraaatttiiiooonnn)))   tttuuugggmmmaaasssiii   

Пошаговый переход (Blend) panelidagi Ускорение (Acceleration) tugmasi 
obyektlarni qaytatdan joylashtiradi va joylashish tartibini o’zgartiradi. 

 
Ускорение объектов (Accelerate objects) maydoni 

obyektlar  orasidagi utish oraligi teng bo’lmagan holatlarni 
yoratadi , arag chap tomonga surilsa berilgan obyektdan oxirgi 
obyektgacha bo’lgan vaqyalarni tezlashtiradi, ung tomonga surilsa 
oxirgi obyektdan boshlanadi . 
Ускорение заливки/ обводки (Accelerate fills/-outlines) 
yoqaridagi amalga uxshash bo’ladi fahat zalivka,obvodkalar 
ushun bajariladi. 
 Применять к размеру (Apply to sizing) Oradagi obyektlarni 
Ускорение объектов (Accelerate objects) nisbatan  
 o’lchamlarini o’zgartiradi. 
 Связь ускорений (Link accelerations) bayroqchsi Ускорение 
объектов (Accelerate objects) va Ускорение заливки/обводки 
(Accelerate fills/outlines)maydonlaridagi qiymatlarni 
sinxronlashtiradi. 
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ПППррреееввврррааащщщеееннниииеее   цццвввееетттааа    (((CCCooolllooorrr   DDDiiirrreeeccctttiiiooonnn)))   tttuuugggmmmaaasssiii   
Превращение цвета (Color Direction) tugmasi bir rangda ekkinchsiga utishni 

taminlaydi, bu amal Градиентная заливка (Fountain Fill) oynasidagi amalga 
ekvivalent bo’ladi. 

Berilgan uchta tugma bir rangdan boshqasiga utish yonalishini ko’rsatadi. 
Переход по прямой линии (Straight Line Blend) tugmasi 

berilgan ranglar doirasidan turgichiziq boylab boshqa rangag utishni 
taminlaydi 

Qolgan ekkitasi Переход по часовой стрелке (Clockwise 
Path) va Переход против часовой стрелки (Counterclockwise) 
mos yonalishga soat strelkasi boylab spiral boyicha ranglarning 
o’zgartirishni bildiradi. 
РРРааазззннноооеее   (((MMMiiisssccceeellllllaaannneeeooouuusss)))   tttuuugggmmmaaasssiii   
Разное (Miscellaneous) tortta tugmada iborat. 
 Картирование узлов (Map Nodes) tugmasi ishlaganda ekranga 
maxsus kursor chiqariladi. Bu kursor yordamida berilgan va oxirgi 
obyektlar tayanich nuqtalari tanlaniladi va dastur obyektning 
ekkinchi obyektga utichini ko’rsatadi. 
 Разбить (Split) tugmasida maxsus kursorni ekranga chiqaradi,unuig yordamida 
oradagi obyektni uzib olish imkoniyati bo’ladi. 

Восстановить начальный объект (Fuse Start) va Восстановить конечный 
объект (Fuse End)  tugmalari кнопки Разбить (Split) tugma xizmatini bekor qiladi. 
Bir –biriga utishdagi haqlagan bitta obyekt ni <Ctrl> tugmasi bosgan holda 
sichqoncha  chertiladi va joriy bo’lgan tugmalardan bittasini tanlaymiz. 
OOObbbyyyeeekkkttt   vvvaaa   tttrrraaaeeekkktttooorrriiiyyyaaalllaaarrr   tttuuugggmmmaaalllaaarrriii      

 
Пошаговый переход (Blend) panelining pastgi qismida uchta tugma - 

Начальный объект (Start), Конечный объект (End) va Траектория (Path) 
joylashgan. Bu amallarning barchasi berilgan obyekt va unig traektoriasini aniqlaydi. 
Tugmalardan hoqlaganinin tanlaganda ekkita buyruqdan iborat menucha ochiladi. 
Birinchi buyruq Новый (New) berilgan obyekt, oxirgi obyekt, yoki traektoria 
ekanligini ko’rsatadi. Ekkinchi buyruq Показать (Show) ajratilgan guruhdagi bir-
biridan utishi boshi,yoki oxirigisi,va traektoriasi ekanligini bildiradi. 

КККооонннтттуууррр    (((CCCooonnntttooouuurrr)))   bbbuuuyyyrrruuugggiii   
Effects (Эффекты) menusining  Контур (Contour) buyrugi yoki Интерактивный 
инструмент (Interactive Tool) joylashgan maxsus tugmasi berilgan obyektdan 
ishkari yoki tashqari yonaltirilgan kontsentrik shaklarni shizadi. 
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Contour (Контур) panelida ekkita tugma bulob ulardan bittasi konturlarning tashqi 
ko’rinishini, ekkinchisi esa kontur rang parametrlarini bildiradi. 

Birinchi tugma bosilganda Шаги (Steps) va Смешение (Offset) joriy bo’ladi. 
К центру (То center)   yordamida Смещение (Offset) maydonida berilgan intervallar 
bilan berilgan kontsentrik shakllar bilan tultiradi. Fahat, kuchish diamert boyicha 
bo’lmaydi,( teng ekkiga bulinmaydi), har bir chiziq oldingisidan berilgan masofaga 
siljitiladi,shu sababli ekki barabar kam kontur chiqadi (masalan, diametri 100мм 
doira, kushish —10 мм bo’lsa, xisob buyicha  10ta kontur bo’lishi kerak, bizda 5 ta 
chiqadi,sababi kushush ekki tomondan bo’lganligidan). 

Внутрь (Inside) kontsentrik shaklar bilan tuldiriladi,uning soni Шаги (Steps) 
maydanidan beriladi, Смешение (Offset) dan esa intervali aniqlanadi. 

Наружу (Outside) esa obyektning tashqarisadan kontsentrik shakl bilan 
tuldiradi  shaklar soni Шаг (Steps)da beriladi, intervallar soni esa Смещение (Offset) 
aniqlanadi. 

 
Rangni aniqlash tugmasi effektning ketma-ket utishidan farh qiladi, obvodkaga 
rang berish pero tugmasi bilan va zalivkaga rang berish kraskali chelak tugmasi 
bilan amalga oshiriladi..Agarda berilgan obyekt gradient zalivkani zalivka 
hisobida olgan bo’lsa, u holda ekkita tugma chiqariladi:gradientning dastlabki va 
oxirgi rangi  

 EEExxxtttrrruuudddeee   bbbuuuyyyrrruuugggiii 
Эффекты (Effects) menusidagi Экструдирование (Extrude) buyrugi eng 

qyiyn bo’lgan effektlardan, dastur ajratilgan obyektlarga en tomonidan tekislik 
qo’shadi va uch ulchovli ko’rinishni tashkil qiladi. Bu effektni boshqarish 
Пошаговый переход (Blend) effektiga uxshash. Uning ushun obyekt tanlaniladi 
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(kursor shakli uzgaradi), va sichqanchani rugmasi bosilib shtrix chizigi bosib tortiladi 
sichqoncha qoyib yubariladigan nuqta krest bilan belgilanib yigilish nuqtasi deyiladi. 

Экструдирование (Extrude) panelida beshta amal bor: Точка схода 
(Vanishing Point), Вращение (3D Rotation). Освещение (Lighting), Цвет (Color 
Wheel) и Фаска (Bevels). 
ТТТооочччкккааа    сссхххооодддааа    (((VVVaaannniiissshhhiiinnnggg   PPPoooiiinnnttt)))   tttuuugggmmmaaasssiii      

Экструдирование (Extrude) paneliga joylashgan 
bulib,yaratilayatgan obyekt hajmining parametrlarini aniqlaydi. 

Ko’rish oynadagi ruyhatda экструдирования usulini 
tanlsh berilgan:  

• Уменьшение в глубину (Small Back) obyektning 
yigilish nuqtasini obyekt orqa qismiga chiqaradi va orqa 
tomonini kichkina qilib beradi; 

• Уменьшение в перёд (Small Front) obyektning yigilish 
nuqtasini obyekt old qismiga chiqaradi va old tomonini 
kichkina qilib beradi 

• Увеличение в глубину (Big Back) obyektning yigilish 
nuqtasini obyekt old qismiga chiqaradi va orqa tomonini 
kichkina qilib beradi 

• Увеличение вперед (Big Front) obyektning yigilish 
nuqtasini obyekt orqa qismiga chiqaradi va orqa 
tomonini kichkina qilib beradi 

•  Параллельно в глубину (Back Parallel) ushkariga kirgan tomondagi en 
tomonlari paralleligini taminlaydi,va old tomonlarini tenligini saqlaydi; 

• Параллельно вперед (Front Parallel) oldga chqarilgan tomondagi en 
tomonlari paralleligini taminlaydi,old va orqa tomonlarini tenligini saqlaydi. 

Quyidagi ruyhatda yigilish nuqtalari tiplari berilgan: Точка схода привязана к 
объекту (VP Locked To Object), Точка схода привязана к странице (VP Locked 
To Page). Копировать точку схода от (Copy VP From...), Общая точка схода 
(Shared Vanishing point). 

Глубина (Depth) maydonida yigilish nuqtasidan yon tomonlari uzunligigacha 
bo’lgan masofa foyz nisbatida beriladi. 

(Н и V) maydonlari Глубина (Depth) terangligini va parametrlarini aniqlashni 
bildiradi. 

Точка схода (Measured from) maydonida obyektning markaziga nisbatan aniq 
yigilish koordinat nuqtalarini beriladi. 
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Вращение (Rotation) Fazoda obyektlarni aylanishlarini taminlaydi. 

Bu amal ekkita variantga ega, birinchisi aylanishni qul yordamida bajaradi, 
ekkinchishisi esa aniq sonli rahamlarni kiritish orqali. Berilgan son maydonlari  1, 2 
va 3lar X, Y и Z koordinat uqlariga mos keladi. 
   ОООсссвввееещщщеееннниииеее   (((LLLiiiggghhhtttiiinnnggg)))   

Освещение (Lighting) yordamida yarigliqning uchtasidan bittasini olib 
tashlash imkoniyati bor. 

Yariqliq tashkil etuvchilarinin mos rahamlariga qaray qo’shishga bo’ladi. 
Yarigliq tushishini kubdan karkas bilan qarash   yordamida olinadi. Har bir istochnik 
uzuning intantsivligiga egabulib Интенсивность (Intensity) maydonida beriladi. 
Keral bo’lgan istochnik tanlanilib va surgishni kerak tomanga surgandan keyin va 
Использовать полноцветный диапазон (Use full color range) bayroqchsini tanlash 
bilan soya va yoriqliqning tushishini aniqroq beradi. 
ЦЦЦвввеееттт    (((CCCooolllooorrr   WWWhhheeeeeelll)))   

Tekislikda fazoviy obyektlarni tasvirlashda ranglar katta rol uynaydi.Вкладка 
Цвет (Color Wheel) bir nechta ran zalivkalinintaklif etadi. 

Использовать заливку 
объекта (Use object fill) 
amali obyektning uzining 
rangini zalivka sifotinda 
foydalanadi. Ковровая 
заливка (Drape fills) 
tanlangan bo’lsa obyektni 
tula en tomonlarga 
ajratmasdan buyaydi. 

Сплошная заливка 
(Solid fill) fazoviy 
obyektning ust qismini bir xil 
rang bilan tultiradi, bunda 
rang palitradan tanlaniladi. 
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Плавная заливка (Shade) oyruglikni real immitatsiyalashda ravon 
tarqalishning t’amillash maqsadida foydalaniladi. Ranglar От (From) va До (То) 
tugmalari yordamida aniqlanib, yoruglikni hisobga olgan holda gradientli to’ldidrish 
imkonini beradi.  
   ФФФааассскккааа    (((BBBeeevvveeelllsss)))   

Fazoviy obyektning eng oxirgi shtrixi obyektning faskasini yaratish bo’ladi. 
 Фаска (Bevels) faskani yaratish va uning paramertlarini o’zgartirish amallarini 

bajaradi. Faskani yaratish uchun Применить фаску (Use Bevel) bayroqch qo’yish 
kerak va  uni parametrlarini aniqlash kerak.  

Глубина фаски (Bevel depth) maydoni faskani o’lchamini beradi, Угол фаски 
(Bevel angle)maydoni  — qialiq burchagini ko’rsatadi. 
   ЛЛЛииинннзззааа    (((LLLeeennnsss)))   bbbuuuyyyrrruuugggiii   

Effects (Эффекты) dagi Линза (Lens) buyrugi ajratilgan obyektni shklini 
o’zgartiradi , masalan , kattalashtiradi,yoki ranglarni filtrlaydi va h. Agarda linza 
obyektlar guruhi ustida tursa,u holda obyektni har birini alohida o’zgartiradi. 

Bu amal bajarilganda  Docker tipidagi panel paydo bulib ,unda linzalar ruyhati 
va ularni foydalanganda obyekt ko’rinishlari beriladi. Tanlangan linzaga turiga bogliq 
effekt paramertlari uzgaradi. 
• Linza - Прозрачная (Transparency) obyekt va linza ranglarni aralashtiradi,bu 

amal  Цвет (Color) tugmasi va Уровень (Rate) maydonidan linza tiniqligi foyz 
nisbatia tanlanadi, qiymat qancha katta bo’lsa linza tiniqligi yuqari bo’ladi. 

• Linza - Увеличение (Magnify) Коэффициент увеличения 
(Amount)maydonda berilgan qiymatga nisbatan obyektni kattalashtiradi. 

• Linza - Яркость (Brighten) obyektni  ravshaligini Уровень (Rate) maydonida 
beriilgan qiymatgan aniqlaydi .qyimatlar diapazoni:   

-100% dan +100%. Agar  +100% bo’lsa hamma ranglar oq ranga ega bo’ladi, 0% da 
linza - obyekt rangiga hesh qanday tasirini o’tkazmaydi,  – 100% da bo’lsa hamma 
ranglar qora ranga utadi. 

• Linza - Инвертировать (Invert) obyektni ranglarini invertizatsya qiladi: Qora 
rangni  — oq ranga, oq rangni — qaraga va h.. Agarda invertizatsya fonga ham 
tasir qilsa u holda Удалить фон (Remove Face) bayroqchasini qo’yish kerak 
shunda fahat obyekt gina invertizatsya qilinadi. 

• Linza - Цветной фильтр (Color Limit) buyrugi Цвет (Color)da o’rnatilgan 
linza rangidan boshqa obyektning barsha  ranglarini filtirlaydi.Filtratsya 
intentsivligi Rate (Уровень) maydonidan aniqlaniladi agarda u kam bo’lsa 



 55 

boshqa ranglarning natijaviy ranga tushishi ko’proq bo’ladi.Bu effektga 
Удалить фон (Remove Face)ni foydalansa ham bo’ladi. 

• Linza - Сложение цветов (Color Add) obyektning rangiga linza rangini RGB 
modeli bilan aralashtiradi. 

• Linza - Окрашенная серая шкала (Tinted Grayscale) Bu filtr rasmlar bilan 
ishlashda qullaniladi. 

• Linza - Инфракрасная шкала (Heat Map) obyekt rangini infra qizil shkala 
boyicha konvertatsya qiladi. 

• Linza - Цветовой фильтр с растяжкой (Custom Color Map) obyekt rangini 
silzitgish yordamida o’zgartiradi. От (From) va До (То) tugmalari yordamida 
ranlarni uzgartadi.Silzitgishning yonalishi quyidagi ruyhatda berilgan:  По 
прямой (Direct Palette) variantida to’gri chiziq buyicha, Прямая радуга 
(Forward Rainbow) varianti esa va  Обратная радуга (Reverse Rainbow) soat 
strelkasi ga nisbatan doyra shaklida uzgartiladi. 

• Linza - Контурный режим (Wireframe) Ovbodka va zalivkalarni rangini 
o’zgartiradi Обводка (Outline) va Заливка (Fill)  amallari bilan bajariladi. 

• Linza - "Рыбий глаз" (Fish Eye) obyektlarni kattalashtiradi yoki kishiklastiadi. 
Linza uzragish diapazoni  -1000% dan +1000% oraliqda bulib, bu Уровень 
(Rate) panelida joylashgan bo’ladi. 
Agarda  Без линзы (No Lens Effects) tanlansa 

linza olib tashlanib oddiy obyekt ko’rinishida 
beriladi. 

Заморозить (Frozen) bayroqchasi, linza 
tagidagi obyektni qatirgan holda boshqa joyga 
qo’yish mumkin. 

Точка зрения (Viewpoint) linzadan ko’rilgan 
obyektni silzitish imkoniyatga ega,bunda obyekt yoki 

linza siljitilmagan holda bajariladi. Bu amalga 
bayroqcha qoyilgandan keyin Редактировать (Edit) 

tugmasi paydo bo’ladi, tugma bosilgandan keyin 
krest shaklidagi marker chiqadi. Markerni silzitish 

tasvirni silzitishga olib keladi. 
Обтравочный клип (Power Clip) buyrugi 
Эффекты (Effects) menusidagi Обтравочный клип (Power Clip) buyrugi  
bajarilganda menuning buyruqlari va effektlarni muharrirlash chiqariladi. 
Kliopga kiradigan barcha obyektlar bitta obyekt bulib xisoblanadi. Klip ustida 
amallar bajarganda obyektni butunligicha yoki uni qismlarga bo’lgan holda amalga 
oshiriladi. Редактировать содержание (Edit Contents) yordamida muharrirlanadi.Bu 
amal  Эффекты (Effects) menusidagi Обтравочный клип (Power Clip)  ichida 
joylashtirilgan.Agarda ishma –ish clip bo’lsa muharrirlash bir necha marta bajariladi. 

Ishni tugatgandan song Закончить редактирование данного уровня (Finish 
Editing This Level)  amali bajariladi. Bu amal muharrirlangan obyektni qaytatdan 
konteynerga solib qoyadi. 
Agarda Параметры (Options) (Windows menusi Toolb asbobi) aynasidagi 
Редактировать (Edit) buyrugidagi Автоматическое центрирование gan bayroqcha 
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qoyilgan bo’lsa klipni taskil etuvchilari  markazdan joyalstirilgan holda ekranga 
chirqariladi  
ИИИнннтттеееррраааккктттииивввнннаааяяя   пппрррооозззрррааачччннноооссстттььь   (((IIInnnttteeerrraaaccctttiiivvveee   TTTrrraaannnssspppaaarrreeennncccyyy)))   aaasssbbbooobbbiii      

Интерактивная прозрачность (Interactive Transparency) asbobi yordamoda 
vektor grafikasi dasturiga rastrli grafika dasturlarining amallaridan biri bajariadi, bu 
amal asboblar panelidagi mos  tugmasi yordamida bajariladi. 

Bu amalning  rastrli tasvirlarni серого  ko’rinishidagi obyektlarni yaratadi. 
Интерактивная прозрачность (Interactive Transparency)asbobi Свойства 

(Property Bar) bilan birgalikda ishlab , hamma zalivkalardan foydalanish va 
ravshanlik parametrlarini oshiradi. Свойства (Property Bar) satr ko’rinishi tanlangan 
zalivka turiga bogliq. 

 

  
Edit (Редактировать) tugmasipanelning chap tomonida joylashgan bulib, mos 

zalivka rangdagi asosiy mulohat oynasini ekranga chiqarishga muljallangan. 
Bu yerda maskalarni biiktirishning rejimlariga itibor berish kerak, bu  un sakkizta 
ranlarning obyektlar bilan ishlash imkoniyatini beradi. 

Ruyhatda quyidagilar berilgan: Нормальным (Normal), Сложение (Add), 
Вычитание (Substract), Разница (Difference), Усиление (Multiply), Ослабление 
(Divide), Если светлее (If Lighter), Если темнее (If Darker), Текстуризация 
(Texturize), Hue (Цветовой тон), Насыщенность (Saturation), Яркость (Lightness), 
Обращение (Invert), Логическое «и» (And), Логическое «или» (Or), Логическое 
«исключающее или» (Xor), Красный (Red). Зеленый (Green), Синий (Blue). 
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ИИИнннтттеееррраааккктттииивввнннаааяяя   дддееефффооорррмммааацццииияяя   (((IIInnnttteeerrraaaccctttiiivvveee   DDDiiissstttooorrrtttiiiooonnn)))   aaasssbbbooobbbiii   

 
Интерактивная деформация (Interactive Distortion) 

asbobining tugmasi Интерактивный инструмент (Interactive 
Tool)guruhida joylashgan.Bu yordamida obyektlarni avvalgi turidan 
katta farh qiladiganday qilib o’zgartiradi. Bu asbob Свойства 
(Property Bar) bilan borgalikda ishlatiladi. Bunda deformatsianing 
ushta tipi mavjud: «Тяни-Толкай» (Push and Pull), Зигзаг (Zipper) 
и Скручивание (Twister). 

Bu asbob bilan ishlash boshqa interaktiv asboblardan farhi 
yoq, fahat oxiridagi olinadigan natija koplagan faktorlarga bogliq, 
tasodifiy (masalan, kursorning holatiyoki uning siljitilyatirilgan 
masofasi va h.), voqealar kutilgan 
natijani bermaydi. “Mahsulot” ning 
bir nechta turini olish imkoniyatlari 
bor va u cheksiz. 
ИИИнннтттеееррраааккктттииивввнннаааяяя   тттееенннььь   (((IIInnnttteeerrraaaccctttiiivvveee   
DDDrrroooppp   SSShhhaaadddooowww)))   aaasssbbbooobbbiii   

Интерактивная тень 
(Interactive Drop Shadow) 
asbobininng  tugmasi 
Интерактивный инструмент 
(Interactive Tool) joylashgan bulib 
,soyaning har qil effektlarini 
yoratishga muljallangan. 

Bu asbob Свойства (Property 
Bar) asboblar satridan ham 
boshqariladi. 
Направление тени (Drop Shadow 
Direction) ruyhatida quyidagicha soyalarning   ruyhati berilgan: Внутрь (Inside), По 
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центру контура (Middle). Наружу (Outside). Усредненная (Average). А в списке 
Границы тени (Drop Shadow Edges) — chegara uchun variantlari: Линейная 
(Linear), Квадратная (Squared). Инвертированная квадратная (Inverse Squared). 
Жесткая (Flat). 
RRRaaannnggg   eeeffffffeeekkktttlllaaarrriii   

CorelDRAW dasturining asasoy uzgachaligi rangli effektlar yoratish bulib 
hisoblanadi.Bu effektlar nafahat nuqtali tasvirlar,vektorli tasvirlar ushun ham 
ishlatiladi. Эффекты (Effects) menusidagi  Цветовые настройки (Color 
Adjustment) buyrugi, ruyhatni chiqaradi va bu yerda shulardan oltitasi vektorli 
obyektlarga tegishli. 

• Яркость-Контраст-Интенсивность (Brightness-Contrast-Intensity) filtri 
tasvirlarni rang tonlarini sozlaydi. Яркость (Brightness) maydoni yoriqliliq 
tushishini uzgarish diapazonini ko’rsatadi, Контраст (Contrast) maydoni— 
oshiq va toq ran tonlarini uzgarishini beradi, Интенсивность (Intensity) 
maydoni bo’lsa — oshiq tonlar uzgarishini beradi (toq ranglar uzgarmaydi). 

• Цветовой баланс (Color Balance) filtri belgilangan obyektni ranglarni 
uzgarishini  bildiradi. Bu effektni qiyin tomoni bitta rangni uzgarishi 
ranlarning balansini buzid boshqa ranglarning uzgarishiga olib keladi. 

• Гамма (Gamma) filtri  яркости va контраста nisbarlarini urtacha ton 
diapazoni qarab, soyalar va yoriqliliqni tushishini soqlaydi. Agarda hech narsa 
tanlanmasa 1 soni qobul qiliniladi, bu deganimiz tasvirga tasiri qilganda tasvir 
uzgarmaydi . Agarda gamma ranglari soni ortib borsa oqaradi, teskari bo’lsa 
qoralashadi.. 

• Цветовой тон/Насыщенность/Светлота (Hue/Saturation/Lightness) filtri 
rang toni va uning toyinganligini o’zgartiradi  

• Негатив (Invert) filtri negativ ranglarni olishga yoki nuqtali tasvirlarni olishga 
muljallangan.Oq va qora ranglar bir-biri bilan olmashtiriladi. 

• Постеризация (Posterize) filtri rangni ottenkalarini kamaytirishga, yani  
tasvirni bir nechta lokal ranglarga ajratadi. Bu usul grafikada kengnan 
foydalaniladi,masalan,plakat turida. Bu buyruq tasvirlarni trassirovkalashga 
tayorlashda ham qullaniladi. 

333DDD   EEEffffffeeeccctttsss   ggguuurrruuuhhhiii   fffiiillltttrrrlllaaarrriii   

Точечные изображения (Bitmaps)  
menusidagi  Фильтры группы 
Трехмерные эффекты (3D Effects) 
obyektlarga har xil hajm berishning 
immitatsiasini, fazoda yassi 
obyektlarni tasviri yaratadi.  
ВВВрррааащщщеееннниииеее   ввв   пппррроооссстттрррааанннссстттвввеее   (((333DDD   
RRRoootttaaattteee)))   fffiiillltttrrriii      

Вращение в пространстве (3D 
Rotate) filtri rastr tasvirni aylanishini 
taminlaydi,perspektiv deformatsiya 
immitatsyasini yaratganda 
qullaniladi.. 
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Mulohat aynasida interaktiv aylanish,По вертикали (Vertical) va По 
горизонтали (Horizontal) maydonlari aylanish diapazonlarini  -75 dan 75gacha 
o’zgartiradi. Лучшее размещение (Best fit) bayroqchasi tasvirni to’gri turtburchakga 
optimal joylashtirishini taminlaydi. 
ЦЦЦииилллиииннндддррр    (((CCCyyyllliiinnndddeeerrr)))   fffiiillltttrrriii   
 

 
Цилиндр (Cylinder) filtri tasvirlarni initatsyasini tsilindr tekisligida 

shozilishini qaraydi. 
Bu ekkita rejimda ishlaydi: Горизон-тальный (Horizontal) va Вертикаль-ный 
(Vertical). Эффект (Percentage) maydoni effekt kattaligini -100 dan  100gacha 
diapazonida aniqlaydi. Ko’rish oynasi obyekt deformatsiadan keyingi  ko’rinishi 
beriladi. 

 
EEEmmmbbbooossssss   fffiiillltttrrriii   
Тиснение (Emboss) filtri obyektlar imitatsya relef qisishiga muljallangan. Fahat bu 
filtrni  hamma rasmlarga ishlatishga bo’lmaydi,yoqari kontrastnosti va ranglar 
diapazoni katta bo’lmagan rasmlarga ishlatiladi. Mulohat oynasidagi  Глубина 
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(Depth) qisilish balandligi , Уровень (Level) — berilgan ranglar soni Направление 
(Direction) maydonida qisilishdagi burchak beriladi. 

Цвет тиснения (Emboss color) quyidagi variantlari berilgan: 
• Original color (Исходный цвет) — nuqtali tasvirda berilgan ranglar 

ishlatiladi; 
• Серый (Gray) и Черный (Black) — berilgan ranglar yoqatiladi va tasvir qora 

yoki kok turda beriladi; 
• Другой цвет (Other), hoqlagan rangni tanlaydi. 

PPPaaagggeee   CCCuuurrrlll   fffiiillltttrrriii   
Завиток угла страницы (Page Curl) 
filtri  sahifani uch ulchovli ko’rinishta 
ko’rsatadi,bu uralib turgan qogozni 
ko’rsatadi. 
Mulohat aynasida uralgan betning 
torttasidan bittasini tanlash kerak. 
Направление (Direction) da vertikal 
boyicha (переключатель Vertical) 
yoki gorizontal boyicha 
(переключатель Horizontal) 
uralganligini bildiradi. Бумага (Paper) 
maydonidaqogoz tipi beriladi: 
непрозрачная (переключатель 
Opaque) yoki прозрачная 
(переключатель Transparent), Цвет 
(Color)  maydonida – uralish rangi (поле Curl) va foni (поле Background). Ширина 
(Width) va Высота (Height) maydonlari uralish o’lchamlarini obyektning uzini 
o’lchamining foyz nisbatini bildiradi 
ПППееерррссспппеееккктттииивввааа    (((PPPeeerrrssspppeeeccctttiiivvveee)))   fffiiillltttrrriii   
Перспектива (Perspective) filtri 
perspektiv deformatsya olish 
imkoniyatini beradi. 
Mulohat oynasida ekkita kalit 
joylashgan,bular deformatsya 
turini bildiradi Перспектива 
(Perspective) turi ko’rish 
oynasida ekkita markerni har xil 
yonalishda bir baqtda 
yonaltiriladi., Сдвиг (Shear) —
ekkita markerni bitta yonalishda 
yonaltiradi. 
ДДДиииссстттооорррсссииияяя   (((PPPiiinnnccchhh///PPPuuunnnccchhh)))   fffiiillltttrrriii   
Дисторсия (Pinch/Punch) filtri 
tasvirlarni botiq yoki qavarriq 
sitrlarni deformatsyasiga 
muljallangan. 
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 Дисторсия (Pinch/Punch) maydoni mulohat oynasida egrilik daipazoni -100 dan 100 
gacha aniqlaniladi. Egrilik markazini Центр (Set Center)asbobi yordamida 
aniqlaymiz,bu tugma oynani chap tomonida joylashgan. 
СССфффееерррааа    (((SSSppphhheeerrreee)))fffiiillltttrrriii   
Сфера (Sphere) filtri "усиленным"sfera shklidagi  filtr varianti .Дисторсия 
(Pinch/Flinch), yarim sfera shklidagi deformatsiani beradi. 

Mulohat oynasidagi boshqarish utkandagi amallagra uxshaydi. 
ХХХууудддооожжжееессстттвввееенннннныыыеее    тттееехххнннииикккиии    (((AAArrrttt   SSStttrrroookkkeeesss)))ggguuurrruuuhhhiii   fffiiillltttrrrlllaaarrriii   

Художественные техники (Art Strokes) filtrlari tasviriy sanaat bilan ishlaydiganlar 
uchun muljallangan filtr bo’ladi. 
УУУгггооолллььь   (((CCChhhaaarrrcccoooaaalll)))   fffiiillltttrrriii   

Уголь (Charcoal)filtri yogach burchaklar berilgan tasvirlar immitatsyasi 
tasvirlashda foydalaniladi.Mulohat oynasida yogoch uzunligini  размер палочки 
угля (поле Size) va shtirxning chetlarinini berish kerak (поле Edge). 
Цветные мелки (Conte Crayon) filtri 
Цветные мелки (Conte Crayon) filtri kichik hajmdagi rangli yoltiraydigan 
obyektlarni tasvirlaydi. 
Цвет мелка (Conte Colors) maydonida bechta rangdagi, Цвет бумаги (Paper Color) 
maydonida esa — qogoz uchun (Пипетка (Eyedropper) asbobi bilan hoqlagan rang 
tanlanadi). Нажим (Pressure) va Текстура (Texture) maydonlari shtrix harakterini  
va don darajalarini aniqlaydi. 
ВВВоооссскккооовввыыыеее    мммееелллкккиии    (((CCCrrraaayyyooonnn)))   fffiiillltttrrriii   
Восковые мелки (Crayon) filtri harbiy bo’rlar bilan tasvirlashni taminlaydi. 
Mulohat oynasidagi (поле Size) bo’r o’lchami va obyektlarni tashqi ko’rinishlarini 
tasvirlash ishlatiladi. 
КККууубббииизззммм   (((CCCuuubbbiiisssttt)))   fffiiillltttrrr   
Кубизм (Cubist) filtri rastrli rasvirlarni jivopisdagi kubik ko’rinishdagi oxim 
ko’rinishida tasvirlaydi. 
Tasvirni o’zgartirish uchun: "кубик" o’lchamini  (поле Size) va яркость 
изображения (поле Brightness) foydalaniladi. Цвет бумаги (Paper Color) maydoni 
asos uchun yaxsi rang topib beradi. 
ИИИмммпппрррееессссссиииооонннииизззммм   (((IIImmmppprrreeessssssiiiooonnniiisssttt)))   fffiiillltttrrriii   

 Импрессионизм (Impressionist) rastr tasvirlar immitatsyasini o’zgartirishga 
va jibopisdagi imprionissizm janrigaga o’zgartiradi. 

Mulohat oynasida quyidagi inpressionlik effektlarining parametrlari berilgan: 
Стиль (Style) maydonida jivopis shtrixlarini (переключатель Strokes) va  doglar 
(переключатель Dabs), Штрих (Stroke) yoki Пятно (Dab Size) maydonlarida 
boyash qalinligi aniqlaniladi, Цветность (Coloration) va Яркость (Brightness)lar  — 
rang va yoriqliqning toyinganligini bildiradi. 
МММааассстттииихххиииннн   (((PPPaaallleeetttttteee   KKKnnniiifffeee)))   fffiiillltttrrriii   
Фильтр Мастихин (Palette Knife) tasvirlarni immitatsya qilishning maxsus belchasi 
— mastixina boyoqning ortiqchasini olib tashlashda ishlatiladi, uz ishining ustozi 
bo’lganlar esa uni chizadigan asbob xissobida ko’radi. 
Ширина лезвия (Blade Size)maydonida , Растушевка краев (Soft Edge) va Угол 
(Angle), immitatsya uchun qiymatini aniqlahs imkoniyatini beradi. 
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ПППааассстттееелллььь   (((PPPaaasssttteeelllsss)))   fffiiillltttrrriii   
Пастель (Pastels) filtri rasmlarni immitatsyasini yoratishda foydalaniladi — rangli 
bo’rlar bilan chizish yoki yupqa rang otenoklari bilan foydalaniladi. 
Mulohat oynasida ekkita tip paneli berilgan –Светлая (Soft) toza va  mayin pastellar 
va Темная (Oil) egli pastel. Размер штриха (Stroke Size) va Вариация цвета (Hue 
Variation) panellari tasvirlarni rang xarakteristikasini aniqlaydi. 
ПППееерррооо    vvvaaa      тттууушшшььь    (((РРРеееnnn   &&&   IIInnnkkk)))   fffiiillltttrrrlllaaarrriii   
Перо va тушь (Pen & Ink) filtrlari obyektlarni pero va tush yordamida chizishlarni 
taminlaydi. 
Mulohat oynasida ekkita variant shtrixi bor – Перекрестные штрихи (Crosshatch) 
va Гравировка точками (Stippling). Плотность (Density) va Нажим пера (Ink 
Pools) maydonlari rasm xatakteristikasini o’zgartiradi. 
ПППуууааанннтттииилллииизззммм   (((PPPoooiiinnntttiiilllllliiisssttt)))   fffiiillltttrrriii   
Пуантилизм (Pointillist) filtri badiy texnikani immitatsyasida foydallaniladi. 
Ranglarni oralashtirish printsipi ishlatiladi — obyektdan masofada joylashgan 
alohida rangli mazkalar, obyekt bilan qo’shilib boshqacha rang beradi. Bu rangli 
poligrafiyada ishlatiladi. 
Mulohat oynasi fahat ekkita Размер пятна (Size) va Яркость (Brightness) kiritish 
orqali puantalizm natijasini ko’rish mumkin. 
ГГГррраааффффффииитттиии    (((SSScccrrraaapppeeerrrbbboooaaarrrddd)))   fffiiillltttrrriii   
Граффити (Scraperboard) filtri bu texnikasi boyoqlarni tirnash orqali immitatsiya 
qilinadi.Tirlangan joydan oq yoki ranli boyoqlar suriladi. 

Цветная (Color) mulohat oynasidagi kaliti  rangli, Белая (White) esa  — rasm 
tagini oq bo’lishini taminlaydi. Плотность (Density) va Размер царапины (Size) 
moydonlari kerakli bo’lgan effektlarga ishlatiladi. 
НННааабббрррооосссоооккк   (((SSSkkkeeetttccchhh   PPPaaaddd)))   fffiiillltttrrriii   

Набросок (Sketch Pad) filtri 
qalam yordamida chizishni 
taminlaydi. (oddiy yoki rangli). 
Mulohat oynasidagi  Графитовый 
(Graphite) oddiy qalam bilan 
ishlashni taminlaydi, Цветной 
(Color) — esa rangli qalam bilan 
ishlaydi. Стиль (Style) maydoni 
tartibsiz qizishdan (Rough) 
Saramjon (Fine) chizish diapazonini 
beradi. Грифель (Lead) maydoni 
oddiy qalam uchun yumshoqliliq 
darajasini bildiradi, uzgarishi 
chaptan qattiq holdan (6Н) -  (6Б) 
yumchoq holigacha uzgaradi. Rangli qalamlar uchun bu Нажим (Pressure) 
uzgartiladi. Абрис (Outline) maydonida konturlar intentsivligi beriladi. 
АААккквввааарррееелллььь   (((WWWaaattteeerrrcccooolllooorrr)))   fffiiillltttrrriii   

Акварель (Watercolor) filtri suv bilan ishlatiladigan boyoqlar yordamida  
rasmlar chizishni taminlaydi. 
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Mulohat oynasida beshta maydon berilgan: Размер кисти (Brush Size), 
Зернистость (Granulation), Количество воды (Water Amount), Bleed (Растекание 
краски) и Яркость (Brightness). 
ЦЦЦвввееетттннноооййй    мммаааррркккеееррр    (((WWWaaattteeerrr   MMMaaarrrkkkeeerrr)))   fffiiillltttrrriii   

Цветной маркер (Water Marker) filtri rasmlarni rangli markerlar yordamida 
chizishni taminlaydi. Matnlarni ishidagi kerak bo’lgan joylarini belgilashda 
foydalaniladi.  

Mulohat oynasida uchta varianti berilgan bo’ladi — Обычный ( Default), 
Упорядоченный (Order) va Случайный (Random). Размер (Size) va Вариации 
цвета (Color Variation) maydonlari chizish uchun ishlatiladigan markerlar qalinligini 
ranglar kontrastrligini aniqlaydi. 
ТТТееекккссстттууурррнннаааяяя   бббууумммааагггааа    (((WWWaaavvveee   PPPaaapppeeerrr)))   fffiiillltttrrriii   
Текстурная бумага (Wave Paper) filtri rasm chiziladigan qogoz turini bildiradi; 
masalan , salfetkaga chizish va h. 
Mulohat oynasida  — rasmni rangli (переключатель Color) va oq-qora rangli 
ko’rinishta (переключатель Black & White) rejimlari mavjud, yana  (поле Brush 
Pressure) asbobni bosilish qattiqligini  aniqlash ham mumkin. 
РРРааазззмммыыытттиииеее   (((BBBllluuurrr)))   ggguuurrruuuhhh   fffiiillltttrrrlllaaarrriii   

Размытие (Blur) guruhi filtrlari aniqliqni kamaytirish va konturlarni tekislash 
uchun ishlatiladi. Dasturda toqqizta filtrt mavjud bulib ekkita parametrlaridan 
bittasini tam=nlash orqali amalga oshiriladi. 
НННааапппрррааавввлллееенннннноооеее   сссггглллааажжжиииввваааннниииеее   (((DDDiiirrreeeccctttiiiooonnnaaalll   SSSmmmoooooottthhh)))   fffiiillltttrrriii      

Направленное сглаживание (Directional Smooth) filtri bilinmas holdagi 
yuvishnii bajaradi,dastur predmet tasvirini analiz qilib va usha ko’rsatilgan 
yonalishda yuviladi. 

Mulohot oynasid Процент (Percentage) maydoni berilgan bulib effekt 
kuchu=ini aniqlaydi. 
РРРааазззмммыыытттиииеее   пппооо    ГГГааауууссссссууу   (((GGGaaauuussssssiiiaaannn   BBBllluuurrr)))   fffiiillltttrrriii      

Gaussian Blur Размытие по Гауссу (Gaussian Blur) Gauss funktsyasini 
foydalanish orqali yuviladi. 

Mulohot oynasida Радиус (Radius) yuvilish darajasini ko’rsatadi, qyimati katta 
bo’lsa yuvish ham katta bo’ladi. 
УУУдддааалллеееннниииеее   """зззааазззууубббррриииннн"""   (((JJJaaaggggggyyy   DDDeeessspppeeeccckkkllleee)))   fffiiillltttrrriii   

Удаление "зазубрин" (Jaggy Despeckle) filtri kontrast tasvirini yumshtish 
uchun foydalaniladi,agarda past kontrastda bo’lsa ketma-ket pagonq boyicha xotiraga 
saqlash oraqli amalga oshiriladi. 

Mulohot oynasidagi  По горизонтали (Width) va По вертикали (Height) 
qo’shni pixellar sonini aniqlaydi , gorizontal holda (chapdan ungga) va vertikal 
boyicha (yuqaridan pastga) yuvishlar uchun.Agarda Симметрично (Symmetn) 
bayroqchasi qoyilsa ekkita tomaonga bit xil bo’ladi. 
НННииизззкккиииййй    кккооонннтттрррааасссттт   (((LLLooowww   PPPaaassssss)))   fffiiillltttrrriii   

Низкий контраст (Low Pass) filtri chegarasini va mayda detallarni yoqatishni 
bajaradi. 

Эффект (Percentage) va Радиус (Radius) mulohat oynalarida yuvish 
parametrlari aniqlaniladi: katta qiymatlar yoriqliq va soya bilan orasidagi farni  
kamaytiradi va rasmni umumiy kontrastrligi kamayadi. 
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РРРааазззмммыыытттиииеее   ввв    дддвввииижжжееенннииииии    MMMoootttiiiooonnn   BBBllluuurrr   fffiiillltttrrriii   
Размытие в движении (Motion Blur) filtri quzgalishdagi predmetlarni tasvirlashda 
foydalaniladi. 

Mulohat oynasida  Расстояние (Distance)va  Направление (Direction) 
maydonlari yuvish parametrlarini aniqlaydi: yuvish uzunligi va qyaliq burchagi. 
Заполнение областей вне изображения (Off-image sampling) maydoni uchta 
variantdan iborot: Игнорировать пиксели вне изображения (Ignore pixels outside 
image), Использовать цвет фона (Use paper color) и Использовать краевые 
пиксели (Sample nearest edge pixel). 
РРРааадддиииаааллльььннноооеее   рррааазззмммыыытттиииеее   (((RRRaaadddiiiaaalll   BBBllluuurrr)))   fffiiillltttrrriii   

Radial Blur (Радиальное размытие) filtri predmetni aylantirishdagi 
imitatsyalarni yuvishda foydalaniladi. Aylanish markazi Центр (Set Center) orqali 
topiladi. Эффект (Amount) yuvish darajasini aniqlaydi. 
СССггглллааажжжиииввваааннниииеее   (((SSSmmmoooooottthhh)))   fffiiillltttrrriii   

Сглаживание (Smooth) filtri qo’shni pixellar orasida ton uzgachaligini 
kamaytiradi va u uz navbatida mayda detallarni yoqalishiga olib keladi.Bu filtr 
tasvirning uziga tasiri kam bo’ladi. 

Mulohat oynasida  Эффект (Percentage) tekislash darajasini aniqlaydi. 
СССмммяяягггчччеееннниииеее   (((SSSooofffttteeennn)))   fffiiillltttrrriii   
Смягчение (Soften) filtri mayda detallarni saqlagan holda yuvishni taminlaydi. 
ТТТрррааанннсссфффооокккааацццииияяя   (((ZZZoooooommm)))   fffiiillltttrrriii      

 Трансфокация (Zoom) filtri transfokatsiya(optik qurallardan foydalan) 
bo’lgan rasmlarni yuvish. Transfokatsya markazi Центр (Set Center) tugmasi 
yordamida aniqlaniladi. 

Эффект (Amount) maydoni yuvish darajasini aniqlaydi. 
ТТТрррааанннсссфффооорррмммиииррроооввваааннниииеее   цццвввееетттааа    (((CCCooolllooorrr   TTTrrraaannnsssfffooorrrmmm)))   ggguuurrruuuhhh   fffiiillltttrrrlllaaarrriii   

Трансформирование цвета (Color Transform) guruh filtrlari ekzotik 
transformatsiyalar ucnun muljallanilgan. Bu tasvirlarni ko’pincha yoshlar web 
saytlarda nashriatda ishlatadi. 
ЦЦЦвввееетттооовввыыыеее    ппплллоооссскккоооссстттиии    BBBiiittt   PPPlllaaannneeesss   fffiiillltttrrriii   

Цветовые плоскости (Bit Planes) filtri tasvir ranglarni osasiy bo’lgan RGB 
turlargacha kamaytiradi.BU filtr gradientlarni analizlagan da foydali. 
Mulohat oynaning Красный (Red), Зеленый (Green) va Синий (Blow) har bir 
rangni o’zgartirish imkoniyatiga ega.Agarda Применить ко всем плоскостям 
(Apply to all planes)  bayroqcha qoyilsa hamma tanlangan ranglar o’rnatiladi. 
ПППооолллууутттооонннооовввыыыййй    рррааассстттррр    (((CCCooolllooorrr   HHHaaalllffftttooonnneee)))   fffiiillltttrrriii   

Полутоновый растр (Color Halftone) filtri poligrafik ko’rinishda  bajarilgan 
tasvirlarni olish imkoniyatiga ega. 

Mulohat oyna Максимальный радиус растровой точки (Max dot radius)da  
poligrafik rastrni modellashtiruvchi parametrlar aniqlanadi. Голубой (Cyan), 
Пурпурный (Magenta), Желтый (Yellow) va Черный (Black) maydonlari har bir 
rangga mos qyaliq burchagini beriadi. 
ПППсссииихххооодддееелллииичччееессскккиииййй    (((PPPsssyyyccchhheeedddeeellliiiccc)))   fffiiillltttrrriii   
Психоделический (Psychedelic) filtri tasvirni elekt ranlariga: sariq, qizil, kok, yoshil 
ranglarga o’tkaziladi. 

Уровень (Level) maydoni maxsus belgilarni o’zgartiradi, buni oldindan bilish 
qiyinchilq tugturadi. 
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СССоооллляяярррииизззааацццииияяя   (((SSSooolllaaarrriiizzzeee)))   fffiiillltttrrriii      
Solarize (Соляризация) filtri fotoqogozni azgina kuygan joyini tugirlash 

Natijada negativ va pozitiv elementli tasvirlar paydo bo’ladi. 
Mulohat oynasidagi  Уровень (Level) solyarizatsya intentsivligini o’zgartiradi. 
КККооонннтттуууррр    CCCooonnntttooouuurrr   ggguuurrruuuhhh   kkkooonnntttuuurrrlllaaarrriii   

Контур (Contour)  guruh konturlari sohalardagi birdan utishlar yoki kichli 
kontrastrlarni chiziqli konturlar hisobiba qabul qilinadi. 
Выявление краев Edge Detect filtri 
Выявление краев (Edge Detect) filtri tasvirdagi kuchli kontrastrlarni ajratish va 
ularni to’gri chiziqlarga aylantirich. Bu filtr yiqari kontrastrli mayda detallarga ega 
bulagn tasvirlar bilan ishlagan da foyda beradi masalan,matnlar bilan 

Mulohat oyna Цвет фона (Background color) da uchta tipning bittasini tanlasa 
bo’ladi: Белый (White), Черный (Black) va Другой (Other). Oxirgida hoqlagan 
rangni foydalansa bo’ladi. Чувствительность (Sensitivity) maydoni kontrast 
daragasini sozlash uchun foydalaniladi. 
ВВВыыыдддееелллеееннниииеее   кккррраааеееввв    (((FFFiiinnnddd   EEEdddgggeeesss)))   fffiiillltttrrriii   

Выделение краев (Find Edges) filtri yuqaridagi, filtrga uxshash bo’ladi, 
chegaradagilarni kesib to’gri chiziq sifatida ishlatiladi. 
  Тип контура (Edge Type) mulohat oynasida ekkita variant berilgan: 
Смягченный (Soft) va Однотонный (Solid). Уровень (Level) maydonida 
yoriqlilikning intensivligini aniqlaydi. 
ОООкккооонннтттуууррриииввваааннниииеее   (((TTTrrraaaccceee   CCCooonnntttooouuurrr)))   fffiiillltttrrriii   
Оконтуривание (Trace Contour) filtri ranglarning birdan uzgargan joylarini anoqlash 
va ularni rangli konturlar bilan tasvirlash. 
ИИИмммииитттааацццииияяя   (((CCCrrreeeaaatttiiivvveee)))   ggguuurrruuuhhh   fffiiillltttrrrlllaaarrriii   

Имитация (Creative) guruh filtrlari har xil mareriallarni modellashtiradi 
masalan,mozaykalar, plitkalar,vitraj va h. 
РРРееемммееессслллааа    (((CCCrrraaaffftttsss)))   fffiiillltttrrriii   

Ремесла (Crafts) filtri har xil kasbga tegishli elementlardan tasvirlar yoratadi. 
Mulahot oynasining  Вид (Style) maydonida quyidagi variantlarni tanlash mumkin: 
Головоломка (Puzzle), Шестерни (Gear), Мраморные шары (Marble), Леденцы 
(Candy), Керамические плитки (Ceramic Tile) va Фишки для игры в покер (Poker 
Chips). 
Размер (Size) maydoni element o’lchamini o’zgartiradi, Завершенность (Complete) 
va Яркость (Brightness) maydonlari tasvirlanish elementlari va yariqliliq elementlari 
protsent nisbatida beriladi Вращение (Rotation) maydoni aylanish burchagi o’rnatish 
uchun xizmat qiladi.. 
КККррриииссстттаааллллллииизззааацццииияяя   (((CCCrrryyyssstttaaallliiizzzeee)))   fffiiillltttrrriii   

Кристаллизация (Crystalize) filtri tasvirni ranli kristallarga ajratadi. 
Mulahot oynasidagi Размер (Size) kristall o’lchamini aniqlaydi. 
Ткани (Fabric) filtri 
Ткани (Fabric) filtri har xil matolardan kollaj tayorlash uchun xizmat qiladi 
Mulahot oynasidagi Вид (Style) quyidagilarni tanlasa bo’ladi: Ручная вышивка по 
канве (Needle point), Коврик (Rug Hooking), Лоскутное одеяло (Quilt), Тесемка 
(String), Ленты (Ribbons) va Коллаж из тканей (Tissue Collage). 
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 Размер (Size) maydonida element o’lchamini o’zgartiradi, Завершенность 
(Complete) va Яркость (Brightness) elementni qaplaydigan tasvir va elementlarning 
yoriqligi foyzga nisbatan beriladi. Вращение (Rotation) maydoni elementlarning 
aylanish burchagini o’rnatadi. 
РРРааамммааа    (((FFFrrraaammmeee)))   fffiiillltttrrriii      

Pама (Frame) filtri rastr tasvirlarga ramka qoyadi.Mulohat oynasida 
quyidagilar mavjud. Вкладка Выбор (Select) ramka bilan birgalikda rasmni 
yigindisini aniqlaydi. Agarda bu olingan natijani qolganlari uchun ham ishlatmoqchi 
bo’lsag u holda “+” belgisini bosib va paydo bo’lgan oynada nomi kiritilishi kerak. 
Настройка (Modify) ramkalarni har xil turini tanlaydi. Цвет (Color) maydonida 
rangni o’zgartirish mumkin,Непрозрачность (Opacity) va Размытие/Растушевка 
(Blur/Feather) qalin   yoki ramka qalinbo’lmagan ramkalar, По горизонтали 
(Horizontal) va По вертикали (Vertical)gorizontal va vertikal ramka ulchovlari. 
Вращение (Rotate) maydoni aylanish burchagini aniqlaydi. 
Отражение по горизонтали/вертикали (Flip) tugmalari yonalishlarnini osan gina 
o’zgartiradi.ungdan- chapga yoki chapdan- ungga yoqaridan pastga va teskarisi. 
Перенести центр (Align) va Восстановить центр (Re-center) ramkani markazini 
aniqlashni va uning eski markazini qayta tiklaydi. 
Список Слияние (Blend) tasvir bilan ramkani ranglari moslik variantlari beriladi. 
(((GGGlllaaassssss   BBBllloooccckkk)))   fffiiillltttrrriii   
Стеклянные блоки (Glass Block) filtri obyektlarni  stena yoki shisha bloklaridan 
ko’rgandagi tasvirini beradi. 
Mulahot oynasida Ширина блока (Block width) va  Высота блока (Block height) 
bloklarni o’lchamlarini aniqlaydi. 
ДДДееетттссскккиииеее    ииигггрррыыы   (((KKKiiiddd'''sss   PPPlllaaayyy)))   fffiiillltttrrriii   
Детские игры (Kid's Play)  filtri har xil bolalar oyinlari beradi. 
Mulohat oyna Игра (Game) da quyidagi variantlar mavjud: Крокетные колышки 
(Lite Pegs), Строительные блоки (Building Block), Рисование пальцем (Finger 
Paint), Рисование ограниченным числом красок (Paint By Numbers). 
МММооозззаааииикккааа    (((MMMooosssaaaiiiccc)))   fffiiillltttrrriii      
Мозаика (Mosaic) filtri rangli toshlardan terilgan tasvirlar 
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Mulohat oynani Размер (Size)da elementlar o’lchamlari beriladi, Цвет фона 
(Background Color) maydonda  – orqa tomondagi rangi. Виньетка (Vignette) 
bayroqchasi rasm atrofida ellips shaklidagi formalardan foydalanish. 

 
ЧЧЧааассстттииицццыыы   (((PPPaaarrrtttiiicccllleeesss)))   fffiiillltttrrriii      

Частицы (Particles) filtri yuduzcha yoki boshqa narsalar bilan rasmlar ustini 
tultirish. 
Mulohat oyna Вид (Style)da ekkita variant berilagan: Звезды (Stars) va Пузырьки 
(Bubbles). Размер (Size) maydoni tanlangan zarrachlarni o’lchamlarini beradi, 
Плотность (Density) maydoni belgili bir yuzada ularni soni, Цветность (Coloration) 
va Прозрачность (Transparency) lar ranlarni toqligi yoki ochqligini biladiradi. Угол 
(Angle) maydoni barcha zarrachalarni berilgan burchak ostida joylashtirish. 
РРРааассспппыыылллеееннниииеее   (((SSScccaaatttttteeerrr)))   fffiiillltttrrriii   

Распыление (Scatter) filtri tasvirda piksellar chang ko’rinishida beriladi. 
Mulahot oynasida По горизонтали (Horizontal) va По вертикали (Vertical) mos 
ravishta yonalishlarini bildiradi.  
ЗЗЗааадддыыымммлллееенннннноооеее   ссстттеееккклллооо    (((SSSmmmoookkkeeeddd   GGGlllaaassssss)))   fffiiillltttrrriii      

Задымленное стекло (Smoked Glass) filtri rangli yuvilgan oynadan qaralgan 
obyektlar tasvirini beradi. 

Mulahot oynaning Цвет (Color) rangini , Оттенок (Tint)  bildiradi. Yuvilsh 
darajasi Размытие (Blurring) maydonda beriladi. 
ВВВииитттрррааажжж   SSStttaaaiiinnneeeddd   GGGlllaaassssss   fffiiillltttrrriii   

Витраж (Stained Glass) filtri rangli shisha lar yoratilgan vitraj ko’rinishidagi 
tasvirni ursatadi. 
Mulahat oynadagi Размер (Size) vitraj elemenlarini o’lchami beriladi, 
Интенсивность освещения (Light Intensity) yoriqliq tushishini bildiradi (yoriqliliq 
tushishi yuqari bo’lsa vitraj aniq ko’rinadi). 

Solder Color (Цвет перемычки) va Толщина перемычки (Solder Width) 
maydonlari har xil materiallardan vitrajlar yasaydi. Трехмерное освещение (3D 
Lighting) bayroqcha qoyilsa obyekt realroq ko’rinadi. 
Виньетка (Vignette) filtri 
Виньетка (Vignette) filtri tasvir atrofida aylana shaklini yaratadi. Mulahat oynaning 
Цвет (Color) maydonida qora ,oq yoki hoqlagan rang tanlanishi munkin, Форма 
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(Shape) maydonida — shakllardan bittasi tanlaniladi: Эллипс (Ellipse), Круг 
(Circle), Прямоугольник (Rectangle) va Квадрат (Square). 
Сдвиг (Offset) va Затухание (Fade) maydonlari vinetka qalinligi va rastushevkani 
bildiradi. 
ВВВииихххрррииитттееелллььь   (((VVVooorrrttteeexxx)))   fffiiillltttrrriii   

Вихритель (Vortex) filtri berilgan markaz atrofida suvni aylanishi yoki  
shamal bo’lishini tasvirlaydi. 
Mulahot oynasidagi  Вид (Style) yordamida quyidagilarni bittasini tanlash mumkin: 
Обычное (Brushed), Слоистое (Layered), Широкое (Thick) va Тонкое (Thin), 
Markaini aniqlashda Центр (Set Center)dan foydalanamiz. Размер (Size) maydoni 
esa shtrix uzunligini o’rnatadi. 

Внутреннее направление (Inner Direction) va Внешнее направление (Outer 
Direction) markazdagi yoki chetdagi nuqtalar aylanish yonalishini ko’rsatadi. 
ПППооогггооодддннныыыеее   яяявввлллееенннииияяя    (((WWWeeeaaattthhheeerrr)))   fffiiillltttrrriii      

Погодные явления (Weather) filtri asosan ob-hova turlarini tasvirlaydi( 
yomgir, qor, va h.). 
Mulohat oynani  Прогноз погоды (Forecast) sida bitta varianti tanlanadi: Снег 
(Snow), Дождь (Rain) yoki Туман (Fog). 
Сила (Strength) va Размер (Size) maydonlari ob-havo turuning  qanday darajada 
bo’lishi  va ularning tazliklarini bildiradi.Yomgir uchun Направление (Direction) 
maydoni kiritilgan bu ,yomgir yonalishini beradi. 
Tabait hodisalarining atmosferada tarqolishi ixtimoliy bo’ladi shu sababli Случайно 
(Randomize) tugmasi ishlatiladi. 
ДДДееефффооорррмммааацццииияяя   (((DDDiiissstttooorrrttt)))   ggguuurrruuuhhh   fffiiillltttrrrlllaaarrriii   

Деформация (Distort) guruhi filtrlari nuqtali tasvirlarni deformatsiyani har hil 
turlari silzitish, sindirish, bo’lish va h. Ishlatadi. Berilgan guruhning filtrieffektiv 
natija ko’rsatadi, sababi bu filtrlar bilan ishlagandan keyin tasvir buziladi. 
БББлллооокккиии    (((BBBllloooccckkksss)))   fffiiillltttrrriii   

Блоки (Blocks) filtri berilgan tasvirni bloklarga yoki ixtimoliy bulaklarga 
bo’ladi. 
Mulahot oynani Ширина блока (Block width) va Высота блока (Block height) 
yordamida blokning ulchivlari aniqlaniladi.Bloklar orasidagi maksimal masofa 
Максимальный сдвиг (Мах. offset (%)) maydoni yordamida beriladi.  
Blokdan tozalangan sohalar, har xil usullar bilan toltiriladi va ularning ruyhati 
Неопределенные области (Undefined Areas)da keltirilgan: Исходное изображение 
(Original Image), Негативное изображение (Inverse Image), Черный цвет (Black), 
Белый цвет (White) va Другой цвет (Other). Oxirgi turida hoqlagan rangni aniqllasa 
bo’ladi. 
СССмммееещщщеееннниииеее   (((DDDiiisssppplllaaaccceee)))   fffiiillltttrrriii   

Смещение (Displace) filtri berilgan tasvirni ekkinchi tasvirga nisbatan 
o’zgartiradi, va u silzish kartasi deyiladi (displacement map). Silzish karta qiymati 
uzgarishi shaklni uzgarishiga, rangni uzgarishigava tasvirni deformatsialanishiga olib 
keladi. Corel\Graphics9\Custom\Displace jildida silzish kartasini tuplami 
joylashgan.Uzimizni kartamizni yoratsa ham bo’ladi. 

Kartani tanlash ung tomandagi pastki burchakdagi ruyhatdan tanlaniladi, 
ko’rinishi ko’rish oynadan ko’rsatiladi. 
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Режим масштабирования (Scale mode) maydoniekkita kalitdan iborat: 
Повторение (Tile) avvalgi tanlangan kartani qaytalash, tasvirlashning hamma yuzasi 
tultiriladi, Растяжение (Stretch to fit) tasvirni katta qilib ko’rsatadi. 
Неопределенные области (Undefined areas) ruyhatidan uzumizga kerakli bo’lgan 
variantni tanlashimiz mumkin: Заполнить граничными пикселами (Repeat Edges) 
va Вставить отсеченные фрагменты (Wrap Around). 

По горизонтали (Horizontal) va По вертикали (Vertical) maydonlari vertikal 
va gorizontal silzishlarni ko’rsatadi mos ravishta pastga yoki yoqariga ham bajariladi. 
СССдддвввиииггг   (((OOOffffffssseeettt)))   fffiiillltttrrriii   

Сдвиг (Offset) filtri tasvirni gorizontal yoki vertikal silzishini bajaradi. 
Mulohat oynani По горизонтали (Horizontal) va По вертикали (Vertical) trasmni 
piksellarda yoki protsentlarda sulzitadi. Agarda protsentlarda bo’lsa Сдвиг в 
процентах от размеров изображения (Shift value as % of dimensions) bayroqcha 
qo’yish kerak bo’ladi. Неопределенные области (Undefined Areas) ruyhat uchta 
variantni taklif etadi: 

1. Вставить отсеченные фрагменты (Wrap Around)— boshatilgan joy 
tasvirning teskari tomonidan surilyatgan qismi bilan tuldiriladi. 

2. Заполнить граничными пикселями (Repeat Edges) varianti — boshatilgan 
joy chegara yonidagi piksellar bilan tuldiriladi. 

3. Вариант Цвет (Color) varianti — boshatilgan joyni Пипетка (Eyedropper) 
asbob yordamida tanlamgan rang bilan tuldiradi. 

ПППиииккксссееелллииизззааацццииияяя   (((PPPiiixxxeeelllaaattteee)))   fffiiillltttrrriii      
Пикселизация (Pixelate) filtri har xil elementlardan mozayka yoratiladi. 
Mulahot oynasini Режим пикселизации (Pixelate mode) 

maydonidamozaykani turini tanlash ushun uchta variant berilgan: Квадратная 
(Square), Прямоугольная (Rectangular) va Радиальная (Radial). Ширина (Width) 
va Высота (Height) mozayka o’lchamlarini aniqlaydi, Непрозрачность (Opacity) — 
uning tiniqligini bildiradi.Radial mozayka uchun Центр (Set Center)asbobi 
yordamida markazi tanlanadi. 
Рябь (Ripple) filtri  

Рябь (Ripple) filtri suvdagi immitatsiyani tasvirlash yoki akslanishini 
beriadi.Mulahot oynasining  Первичная волна (Primary Wave) ,Частота (Period)  
Амплитуда (Amplitude) maydonlari tulqinning kutarilish va balantligini beradi. 
Перпендикулярная волна (Perpendicular Wave) maydoni fahat amplitidasi bilan 
aniqlaniladi.  
Деформирующая рябь (Distort ripple) bayroqch qo’yish orqali defermatsiaga olib 
kelishadi, yoki tulqin tarqolish burchagini aniqlaydi. 
СССкккрррууучччиииввваааннниииеее   (((SSSwwwiiirrrlll)))   fffiiillltttrrriii      

Скручивание (Swirl) filtri tasvirni markazida ko’proq buralish bo’ladi, bunda 
chelakdagi buyoqni buralishinday ellyuziya paudo qiladi. 
Mulahot oynasini Направление (Direction) yordamida qaysi tomonga buralish 
yonalishi ko’rsatiladi: по часовой стрелке (переключатель Clockwise) yoki против 
часовой стрелки (переключатель Counter-Clockwise). Центр (Set Center) tugmasi  
hoqlagan joydan buralish markazini berish bildiradi. 
Asosiy buralsih burchagi Полные витки (Whole Rotations) da beriladi, qo’shimcha 
buralish esa — в поле Дополнительное вращение (Additional Degrees) beriladi. 
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Разбиение (Tile) filtri 
Разбиение (Tile) filtri berilgan tasvir bilan tultiradi. Bu filtr Web dizaynerlarga 
fonlar bilan ishlaganda qul keladi. 

Mulahat oynaning  Горизонтальные элементы (Horizontal Tiles) va 
Вертикальные элементы (Vertical Tiles) gorizontal yoki vertikal joylashgan 
elementlar sonini aniqlaydi. Agarda ekkita yonalish boyicha bir xil bo’lishi uchun 
qulfni yoqatish kerak. 

  
ЖЖЖииидддкккаааяяя   кккрррааассскккааа    (((WWWeeettt   PPPaaaiiinnnttt)))   fffiiillltttrrriii   

Жидкая краска (Wet Paint) filtri tasvirlarni hali yaxshi chizishni 
uzlashtiralmagan odam tomanidan chizilgan bulib unda buyoqlar oqib ketgan bo’ladi.  

Mulahat oynani Эффект (Percent)  buyoqlar oqishini uzunligini beradi, 
Влажность (Wetness) maydoni esa  — oqimdagi buyoqlarni xarakterlaydi: manfiy 
qiymat qora oqimni, musfat qiymat esa — oshiq turdagi buyoqni bildiradi.  
ВВВооодддооовввоооррроооттт   (((WWWhhhiiirrrlllpppoooooolll)))   fffiiillltttrrriii      
Водоворот (Whirlpool) filtri tasvirni har xil gaz oqimini, suvning oqimini va boshqa 
tasvirlaydigan oqimlar bilan yuviladi. 

Mulahat oynasida quyidagilar berilgan, tasvir ko’rinishiga tasir qiladigan, 
soniga va  oqim turiga tasir qiladigan faktorlar : Интервал (Spacing) maydoni 
oqimlar orasidagi masofani bildiradi, Длина струи (Smear Length) — oqim 
uzunligini bildiradi, Кручение (Twist)  — oqimlarni buralishini bildiradi, 
Детализация (Streak Detail) — detalizatsya darajasini aniqlaydi. Искривление 
(Warp) bayroqchasi oqim yonalisi bilan bir xil yonalishda bo’lgan tasvirning 
deformatsya bo’lishini bildiradi. 
Bu uzgartilgan parametrlarni xotiraga saqlash uchun mulahat oynasidagi “+” 
tordamida har birini stil qilib yozib qoyadi. 
ВВВееетттеееррр    (((WWWiiinnnddd)))   fffiiillltttrrriii   

Ветер (Wind) filtri shamolni tasvirlaydi bu obyektlarni sulzitganda yoki 
havoni tasvirlagan da ishlatiladi. 

Сила (Strength) va Непрозрачность (Opacity) maydonlari shamol kuchini va 
uning ko’rinishini bildiradi, Угол (Angle) maydoni esa — shamol yonalishini 
bildiradi. 
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ПППооомммееехххиии   NNNoooiiissseee   ggguuurrruuuhhhiii   fffiiillltttrrrlllaaarrriii   
Помехи (Noise) guruh filtrlari tasvirlarga qo’shimcha piksellarni ixtimoliy 

ravishda  qoshishni bildirib ajratilgan sohada tasvirni aniqroq qiladi. Bu filtrni asosan 
har xil matnlarni yoratganda ishlatiladi. 
ДДДоообббааавввииитттььь   шшшуууммм   (((AAAdddddd   NNNoooiiissseee)))   fffiiillltttrrriii   
Добавить шум (Add Noise) filtri piksellarni tasvirda ixtyoniy joylashishini 
taminlaydi. 

Mulahot oynasida uchta usuli berilgan: 
1. По Гауссу (Gaussian) — egri chiziq boyicha ranglarni joylashtiradi va bunda 

ranglar tasvirdagi ranglar bilan bir hil bo’lishi ham mumkin. 
2. Пиковый тип (Spike) — rang turlari yingishka egri chiziq boyicha tarqaladi. 
3. Равномерный тип (Uniform) — ranglar ixtioriy sonlarni foydalanish bilan 

tarqaladi. 
Уровень (Level) va Плотность (Density) maydoni umumiy shovqinning zichligini 
bildiradi. Цветовой режим (Color mode) uchta o’tkazgish berilganbulib ,ular  rang 
fluktuatsiani bildiradi: по интенсивности (переключатель Intensity), случайно 
(переключатель Random) va aniq berilgan rangni foydalanish  (переключатель 
Single). 
ДДДиииффффффууузззииияяя   (((DDDiiiffffffuuussseee)))   fffiiillltttrrriii   

Диффузия (Diffuse) filtri ravshalikni pasaytirish ushun ishlatiladi. 
Mulahat oynasidagi Уровень (Level), filtr intensivligini aniqlaydi. 
ПППыыылллььь   иии   цццааарррааапппииинннааа    (((DDDuuusssttt   &&&   SSScccrrraaatttccchhh)))   fffiiillltttrrriii   

Пыль и царапина (Dust & Scratch) filtri mayda narsalarni yuvish natijasida 
tasvirlad olish uchun ishlatiladi. 
Mulahot oynani Радиус (Radius) maydoni  yuvishni radiusini aniqlaydi, Порог 
(Threshold) maydoni  — yuvishning bosgishini bildiradi. 
МММаааккксссииимммуууммм   (((MMMaaaxxxiiimmmuuummm)))   vvvaaa   МММииинннииимммуууммм   (((MMMiiinnniiimmmuuummm)))   fffiiillltttrrrlllaaarrriii   

Максимум (Maximum) filtri ociq zonalarni katta qiladi, Минимум 
(Minimum) filtri — tasvirni qara joylarini katta qiladi. Natijada katta kistni ishlatgan 
holatga uxshab qoladi. 

Mulahot oynani Эффект (Percentage) maydoni filtr intentsivligini aniqlaydi, 
Радиус (Radius) maydoni esa — kengayish zonasini bildiradi (kistning kengligi). 
МММееедддиииааанннааа    (((MMMeeedddiiiaaannn)))   fffiiillltttrrriii   
Медиана (Median) filtri berilgan radiusdagi markaziy pikselni yoriqligi urtacha 
bo’lgan piksel bilan olmashtiradi va shu bilan birga yuvishni ,tasvirdagi nosozlikni 
yoqatadi. 

Mulahot oynani Радиус (Radius) maydoni 1 dan 20 piksel diapazonda bo’lgan 
yuvish radiusini aniqlaydi. 
 УУУдддааалллииитттььь    мммуууаааррр    (((RRReeemmmooovvveee   MMMoooiiirrreee)))   fffiiitttrrriii 

Удалить муар (Remove Moire) filtri tasvirlarni scanir qilganda paydo 
bo’ladigan har xil noto’griliqlarni to’grilaydi. Bulgilgan tasvirlarni qul yordamida 
to’grilash yaxshi effekt bermaydi agar berilgan filtrni foydalansak bir zumda 
quyilgan amalni bajaradi. Mulahot oynasini Эффект (Amount) maydoni «борьбы» 
darajasini bildiradi ,agarda qiymati katta bo’lsa qotaligi ham ortadi. 

Качество (Quality) maydoni sifatini tanlaydi (переключатель Better) tezlik 
katta bo’lganda (переключатель Faster). Natijani yaxshi bo’lishi uchun разрешения  
optimal bo’lishi kerak va bu qiymat Выводное значение (Output) maydonida 
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beriladi. Agarda scanerdan olingan natija разрешение 300 dpi bo’lsa, u holda natija 
разрешение 200 dpi ega bo’ladi,bu esa  berilgan tasvirni uchdan ekki qismini  beradi. 
УУУдддааалллииитттььь   шшшуууммм   (((RRReeemmmooovvveee   NNNoooiiissseee)))   fffiiillltttrrriii   

Удалить шум (Remove Noise) filtri scaner yordamida olingan tasvirlar yoki 
vedio kadrlarni qayta ishlashda paydo bo’ladigan qatoliklarni to’grilaydi. 

Mulahot oynasidagi Автоматически (Auto)gan bayroqcha qoyilgan bo’lsa 
filtrni avtomatik tarizda sozlaydi, agarda bayroqcha qoyilmasa u holda hammasi 
qolda ishlatiladi, yani Порог (Threshold)  maydonida yoriqlilik darajasini aniqlash,va 
h. Bu yerda qiymati kichik bo’lsa effekt yoqari bo’ladi. 
SSShhhaaarrrpppnnneeessssss   ggguuurrruuuhhh   fffiiillltttrrrlllaaarrriii   

Ranglarni va tonlarni o’zgartirib bo’lgandan keyin oxirgi etabida tasvirni 
umumiy tiniqligini yaxshilash kerak bo’ladi.Bu protsedura tasvirlarni har xil 
transformatsya qilgandan keyin (kichiklashtirgandan, kattalashtirgandan, burgandan 
keyin va h.) va scnerdan olingan tasvirlarda albatta ishlatish kerak. 
АААдддаааппптттииивввнннаааяяя   кккооонннтттууурррнннаааяяя   рррееезззкккоооссстттььь    (((AAAdddaaappptttiiivvveee   UUUnnnssshhhaaarrrppp)))   fffiiillltttrrriii   

Адаптивная контурная резкость (Adaptive Unsharp) filtri konturlarni 
kattalashtirish uchun qullaniladi. 

Mulahot oynasida fahat bitta Эффект (Percentage) maydoni bor , effektning 
tasir qilish darajasini aniqlaydi. 
НННааапппрррааавввлллеееннннннаааяяя   рррееезззкккоооссстттььь   (((DDDiiirrreeeccctttiiiooonnnaaalll   SSShhhaaarrrpppeeennn)))   fffiiillltttrrriii   

(Directional Sharpen) filtri konturlarni kuchaytirish uchun foydalaniladi, uning 
ayriqcha tomoni aniq berilgan yonalishdagi kontrasni o’zgartiradi. 

Mulahot oynasida  —Эффект (Percentage) maydoni , effektning tasir qilish 
doirasi berilgan. 
ЦЦЦвввееетттооовввоооййй    кккооонннтттрррааасссттт   (((HHHiiiggghhh   PPPaaassssss)))   fffiiillltttrrriii      

Цветовой контраст (High Pass) filtri birdan boshqa ranglarga utgan joylarni 
saqlagan holda va boshqa ranglarni pasaytirish orqali rasmdagi ranglar sonini 
kamaytiradi. Bu esa tasvirdagi yoriqliq tushgan joylarni aniqlashda qul keladi. 

Mulahat oynani  Радиус (Radius) maydoni chegarani enini urtatish uchun 
qizmat qiladi, Эффект (Percentage) maydoni effektning tasirini aniqlaydi. 
РРРееезззкккоооссстттььь   (((SSShhhaaarrrpppeeennn)))   fffiiillltttrrriii      

Резкость (Sharpen) filtri tasvirni ravshanligi chegaradagi ranglarni 
kontrastrligini oshirish orqali orttiradi. 

Mulahot oynani Уровень граничных контрастов (Edge level (%)) maydoni  
chegaraviy kontrastni intentsivligini aniqlaydi, Порог (Threshold) maydoni  — ton 
uzgarishinin taminlaydi. 

Сохранить цвета (Preserve Colors) bayroqcha qoyilsa ranglarni har xil 
o’zgartirishlar kiritishning oldini oladi. 

 
888...   TTTaaasssvvviiirrrlllaaarrrnnniii   iiimmmpppooorrrttt   vvvaaa   eeekkkssspppooorrrtttlllaaassshhh   

Tasvirlarni eksport yoki import qilganda quyidagi konbertorlar bo’lishi kerak — 
oldindan saqlangan malumotlarni dastur tushunadigan turiga o’tkazuvchi modullar 
bo’lishi shart. Ole texnologiyasini foydalanganda konventorlar haqida oylamasak 
ham bo’ladi.Ekkinchi tomondan bu texnologiya obyektlar bilan ishlaganda bir qancha 
cheklashlar qoyadi yani,obyektlar kloni olinmaydiganbo’ladi va h. 
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БББуууфффеееррр    оообббмммееенннааа    CCCllliiipppbbboooaaarrrddd   
Malumotlari eng oddiy olmashishi bu Clipboard yordamida amalga oshiriladi,va bu 
yordamida qiyidagi amallar bajariladi: CorelDRAW dasturidan boshqa dasturlarga 
matnlarni va grafik elementlarni olib utishni bajaradi agarda olib utilyatgan dasturda 
OLE texnologiyasi bilan ishlash imkonyati bo’lsa. 
Редактировать (Edit) menusi va asboblar panelida quyidagi amallar berilgan; 
Копировать (Copy), Вырезать (Cat), Вставить (Paste). 
"""dddrrraaaggg---aaannnddd---dddrrroooppp"""   ttteeexxxnnnooolllooogggyyyaaasssiii   
"drag-and-drop" texnologyasi ("olib borib tashlash") bir dasturdan ekkinchisiga qul 
yordamida malumotlarni olib utishlar quyidagi holatlarda amalga oshiriladi. 
• Agarda vektor obyekti bir CorelDRAW dasturda bir hujjatdan ekkinchisiga 

olib utiladigan bo’lsa. 
• Agarda vektorli obyekt ishchi stolga olib utiladigan bo’lsa. Bu yerda ishchi 

stoldan boshqa dasturga olib utiladi, masalan CorelDRAW va Corel PHOTO-
PAINT dasturlar orasida grafik malumotlar oilb utiladi. 

ОООттткккрррыыытттььь    (((OOOpppeeennn)))   vvvaaa   ИИИмммпппоооррртттииирррооовввааатттььь   (((IIImmmpppooorrrttt)))   bbbuuuyyyrrruuuqqqlllaaarrriii   

 
Menunuing Файл (File) va Открыть (Open...) buyrugi bosqa muharrirlar yordamida 
yoratilgan hujjatlarni ochadi, bu yerda fayllar vektor formatli bo’lishi kerak, masalan, 
EPS standart formati. 
Yuqaridagi byuruq bajarilgandan keyin ekranda Открыть рисунок (Ореn Drawing) 
mulahot oynasi chiqadi,bu yerda faylni qaysi jildda va qaysi fayl ekanligini ko’rsatish 
kerak. Bu erda Просмотр (Preview)dagi bayroqchni belgilash natijasida fayllar 
ichidagi malumotlar ko’rsatiladi. Agarda faylni uqich mumkin bo’lmasa yoki boshqa 
sabablarga bogliq uqilmasa ko’rish oynasida krest belgisi chiqariladi. 

Ko’rish maydoni tagida fayl haqida malumotlar chiqariladi: 
• Версия документа (File Version) satrida hujjat saqlangan dasturning versiyasi 

beriladi; 
•  Степень сжатия (Compression ratio) satrida faylni siqilish foyizini ko’rsatadi  

(vektor formati uzi ixcham o’lchami kichik bo’ladi, shunga qaramastan dastur 
faylni avtomatik tarizda siqadi.); 

• Сохранен (Last saved by) satri dasturni versyasi haqida malumot beradi 
(platformasi) va unig relizi (masalan, build 337). 
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Ключевые слова (Keywords) va Примечания (Notes) foydalanuvchiga kerakli 
faylni tez qidirib topib berishda yordam beradi. Agarda berilgan malumot faylni 
saqlagan paytda kiritilgan bo’lsa. 

Сохранить слои и страницы (Maintain layers and pages) bayroqchasi hujjatdagi 
qatlomlar ,sahifalar haqida konvertattsia 
qilishni taminlaydi,  CDR dan boshqa formatda 
bo’ladi. 
Menuning Файл (File), va Импортировать 
(Import...) buyrugi  CorelDRAW dasturidagi 
ochilgan joriy hujjatga hujjatni import qilishni 
taminlaydi va u ekkita usul bilan bajariladi: 

• Fayllar orasida boglanish saqlanadi. 
• Fayllar orasida boglanish saqlanmaydi. 

 Импортировать (Import) mulohat 
oynasi Открыть рисунок (Open Drawing) 
oynasidan farhi quchimcha funktsiyalari va 
mumkin bo’lgan faylar ruyhati katta 
bo’ladi.. 

Размер изображения (Image size) satrida rastr tasvirlarni import qilganda pikseldagi 
ulchov birligi va ranglarni terangligi bitlarda beriladi. 
Pastdagi qatorlardafayl formati, va uning uzgachligi, masalan, siqish texnologyasini 
foydalanish va h.. Agarda fayl formati eskartmalarni saqlaydigan bo’lsa uning 
matnini , Примечания (Notes) maydonidan kiritamiz. 
Связать с файлом высокого разрешения для вывода по технологии OPI (Link to 
high resolution file for output using OPI) bayroqchasi, dasturning tez ishlashi uchun 
hujjatda fayl varsiyasini past razresheniyeda yozadi, qaytandan oqigan paytda 
avvvalgi holatiga qaytaradi. 

Проверить "водяной знак" (Check for Watermark) bayroqchasi обеспечит 
запуск модуля, tasvir haqida maxfiy malumotlarni qidiradigan modullar ishga 
tushiriladi. 

Свести многослойные точечные изображения (Combine multi-layer bitmap) 
bayroqchasi ko’p qatlamli tasvirlarni konvertatsya qiladi, masalan, Adobe Photoshop 
(PSD) formatidan  yoki Corel PHOTO-PAINT (CPT) formatidan ,oddiy bi qatlomli 
qiladi, Сохранить слои и страницы (Maintain layers and pages) bayroqchasi, 
teskari, vektor obyektlarni qatlomlarga va sahofalarga ajratib beradi. 

Применить размещенный профиль ICO (Apply embedded ICC profile) va 
Извлечь размещенный профиль ICC (Extract embedded ICC profile) bayroqchlari, 
Открыть рисунок (Open Drawing) mulohat oynasiga tegishli bulib,joriy hujjatga 
import qilingan fayl rang profillarini o’rnatish yoki uni chaqirib alohida Image Color 
Matching (ICM) formatli faylga yozishni taminlaydi. Dastur quyidagi formatli 
fayllarda ranglar profillarini joylashtiradi; CRT, CDR, JPEG, PICT и EPS. 

Tasvirlarni bazi bir formatlarda joylashtirish uchun quchimcha malumotlar 
kerak bo’ladi (masalan, PS, PRN yoki PCD formatlari ). Bu holda ekranda 
quchimcha oyna paydo bo’ladi. Agarda import qilishda He выводить диалоговое 
окно фильтра (Suppress filter dialog) bayroqcha qoyilsa, import qilish joriy 
ko’rsatilgan boyicha bajariladi. 
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CorelDRAW dasturida import qilingan tasvirlarni 
o’zgartirish uchun amallar bajarilgandan keyin ekranga 
boshqacha kursor chiqariladi. Shu kursor yordamida 
tasvirni hujjatning hoqlagan joyiga joylashtirishga 
bo’ladi. Bu obyekt ustida mastablashni ham bajarsa 
bo’ladi. Agarda proportsional mastablamoqchi bo’lsak 
u holda kursor bilan sohani chizib ko’rsatish 
kerak.Agar <Alt> tugmasi bilan masshtablashtirilsa 
proportsinal bo’lmaydi. 
Agarda masshtablashda aniqliqni talab qilsa,u holda 
mulahot oynasidagi Импортировать (Import) 
ruyhatidan foydalanishga to’gri keladi.Ruyhatda uchta 
variant mavjud: 

1. Полное изображение (Full Image) tasvir hech 
qanday uzgarishsiz import qilinadi. 

2. Изменение параметров изображения 
(Resample) — ekranga mulahot oyna chiqariladi, 
bu oynada o’lchamini va import qilinyatgan obyekt разрешение si (oynani 
pastki qismida uzgartilgan va avvalgi fayllar o’lchamlari baytlarda beriladi). 

3. Кадрирование изображения (Crop) — ekranga mulahot ayna chiqariladi, 
oynada qul yordamida yoki mos bo’lgan qiymatlarni o’zgartirish bilan Сверху 
(Тор), Слева (Left), Ширина (Width) Высота (Height) import qilinadigan 
yuzani chegaralsh mumkin. 

Импортирование (Import) mulahot oynasidagi Связь с внешним изображением 
(Link bitmap externally) bayroqcha quyilishi import qilishning uzgacha rejimi bo’ladi 
yani — tasvirlar bir-biri  bilan boglangan bo’ladi (linked image). 
Uzarobogliq tasvirlar 

Import qilganda tasvirlarni boshqa hujjatlarga olib utishlar faylar o’lchami 
katta qiladi shu sababli tasvirni olib utmay fahat utish joyini ko’rsatish (ssilka ) orqali 
ham bajariladi.. Ssilka qoyilgan tasvirlar boglangan deyiladi (linked images). 
Bu turdagi importdan foydalanishning yaxshi tomoni va yomon tomoni bor. 
Yaxshi tomoni: faylni o’lchami kichik bo’ladi, CorelDRAW  dasturiga murajat 
qilmasdan paralel va mustaqil ishlatiladi, hujjatdagi hamma tasvirlarga o’zgartirish 
kiritish urniga bir marta uzgartiladi. 

Yomon tomoni tasvirlarning 
joylashgan joyi nomalun va ssilkalar 
noto’gri bo’lishi mumkin. 

Bir-biri bilan noglan tasvirlar 
bilan ishlash uchun Docker tipidagi 
panel ishlab chiqilgan va uni  
Диспетчер связей (Link Manager) 
ataydi  bu panelda tasvirning barcha 
nuqtalari bilan  boglanishini ko’rsatadi.  

Har bir satrda tasvirlarning boqlanishi haqida malumot bo’ladi, 
kichiklashtirilgan tasviri, fayl manzili va nomi,tasvir joylashgan beti. 

Panelning pastki tomonida uchta tugma joylashgan: 



 76

1. Birinchi turgma tasvir bilan orasidagi boglanishni uzdi va boglanish paneli 
satridan uchiriladi. 

2. Ekkinchi tugma eskirgan tasvirlarni yangilash uchun ishlatiladi. 
3. Uchunchi tugmaajratilgan tasvirni muharrirlash uchun ishlatiladi. 

Bu uchunchi tugma yordamida chaqiriladigan kichkina dasturcha CorelDRAW 
yordamida ishlatiladi va fayl kengaytmalari mosligiga inibor beriladi.Shuni itiborga 
olgan holda ekranga grafik dastur emas  ko’rsatadigan dastur (masalan, ACDSee) 
yoki brauzer -dasturlar(masalan , MI Explorer) chaqiriladi. 

Ung tomondagi pastdagi tugma boglanishni qo’l yordamida boshqarish uchun 
ishlatiladi, agarda tasvir ko’rsatilgan jilddan tashqarida qolsa holat satrida qizil belgi 
bilan ko’rsatiladi. Aloqani qaytatdan boqlash uchun ko’rsatgich holat satriga olib 
borib sichqonchani ung tomoni bosiladi, va ochilgan menudan Восстановить 
разорванную связь (Fix Broken Link) tanlanadi. Bu mulohot oynasini chiqaradi 
Определить местоположение точечного изображения (Locate External Bitmap) ni 
tanlash kerak . Agarda hotiradan uchirilmagan bo’lsa, u holda tasvirni manzili 
o’zgartirib qo’yish kifoya. 
Tasvirlarni eskportlash 

 
Tasvirlarni boshqa formatga eksport qilish ushun qiyidagi amallarni bajarish 

kerak. Menuning Файл (File)dan Экспортировать (Export...), tanlanadi va u ekranga 
oynani chaqiradi. 
Только выделенные объекты (Selected only) bayroqchasi qoyilsa hujjatdagi fahat 
belgilangan obyektlarni eksport qiladi. 
Сортировка типов файлов (Sort type) ruyhati Типы файлов (Files of type) 
ruyhatini tartibga soladi: По умолчанию (Default), По расширению (Extension), 
По описанию (Description), В порядке использования (Most Resently Used), 
Сначала векторные (Vector), Сначала точечные (Bitmap), Сначала текстовые 
(Text), Сначала анимированные (Animation) 
Без пробелов va специальных символов (No white spaces, special characters) 
bayroqchasi fayl nomidagibush joylarni tagini chizib yozish bilan, maxsus belgilarni 
Web sahifa fayllarida ishlatiladigan belgilarga olmashtiradi. 
Fayllar formati ruyhatidan mumkinbo’lgan bitta formati tanlaniladiva 
Экспортировать (Export) tugmasi bosilishi bilan ekranda mulahot oyna paydo 
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bo’ladi,bu oynada CDR formatidan boshqa formatga utgandagi saqaladigan 
malumotlar beriladi.  
 

999...   RRRaaassstttrrrllliii   tttaaasssvvviiirrrlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh,,,   ooo’’’zzzgggaaarrrtttiiirrriiissshhh...   
CorelDRAW dasturi vektor grafikasi  dasturlari ichidagilardan eng bir kuzga 

ko’ringanlardan biri bulib hisoblanib, va u shu sohadagi barcha imkoniotlarga ega 
bo’ladi. 
Rastrli tasvirlarni parametrlarini o’zgartirish 

 
Rastrli tasvirlarni asosiy parametrlari  geometrik ulchovlari va o’tqazish bulib 
hisoblanadi. Bu parametrlarni CorelDRAW muhitida o’zgartirishda Точечные 
изображения (Bitmaps) menusidagi Изменение параметров изображения 
(Resample...) dan foydalaniladi. 
Размер изображения (Image size) maydonidagi (поле Width)da eni boyicha qiymati 
kiritiladi va (поле Height) balandligi boyicha qyimati beriladi. 

Разрешение (Resolution) maydonida  (поле Horizontal)  gorizontal boyicha va  
(поле Vertical) vertikal boyicha razreshenyelari beriladi.. Qo’shni maydondagi 
Идентичные значения (Identical values) ga bayroqch qoyilsa u holda bir xil bo’ladi, 
aks holda har xil qiymatlar bo’ladi. 

Oynani pastki qismida fayllar o’lchamlari beriladi (строка Original image size) 
uzgartilmagan holdagisi va (строка New image size) parametrlari o’zgartirilgandan 
keyingisi. Сглаживание (Anti-alias) bayroqchasi chegaralaridagi har xil 
notekisliklarni yoqatadi. 
Vektorli tasvirlarni rastrli tasvirlarga konvertatsya qilish 

CorelDRAW dasturi vertor tasvirlarni rastrli tasvirlarga o’tkazish imkoniyatiga 
ega  
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Bu uchun obyekt tanlanib Точечные изображения (Bitmaps) menusidan 
Конвертировать в точечное изображение (Convert to Bitmap...) buyrugi 
bvajariladi. Ekranda chiqarilgan mulahot oynasida rastrli tasvirlarni parametrlari 
berish kerak, yani разрешение va rang qalinligini. 

Разрешение (Resolution) maydonida ruyhatdan hoqlagan bittasini tanlash 
kerak (72, 96, 150, 200 и 300 dpi) yoki uzumizni parametrlarni 60 dan 1000 dpi 
gacha diapazondan  berishimiz kerak  

Цвет (Color) da oltita rang va rejim modelleri berilgan: Черно-белый штрих 
(1-bit) (Black and White), 16 цветов (4-bit) (Colors 16), Градации серого (8-bit) 
(Grayscale), Индексированный цвет (8-bit) (Paletted), Цвет модели RGB (24 bit) 
(RGB Color), Цвет модели CMYK (32-bit) (CMYK Color). 

Имитация (Dithered) bayroqchasini o’rnatish katta hajmdagi ranglar 
gammasidan kamroq gammadagiga konvertizatsya qulgan da yetishmaganini bor 
ranglardan olib qoyiladi. 

 Прозрачный фон (Transparent Background) bayroqchasi obyekt 
joylashmagan sohalarni markirovkalaydi. 

Использовать цветовой профиль (Use Color Profile) bayroqchasi joriy 
bo’lgan tashqi qurilmalarni ranglar profilini xisobga oladi,masalan, rangli printer.  

Сглаживание (Anti-aliasing) bayroqchasi agarda tasvirni chegaralarini rangini 
yumshtish uchun ishlatiladi. 
Rastrli tasvirlarni boshqa ranglar modellariga o’tkazish 

Rastrli tasvirlarquyida berilgan  boshqa rangli modellarga yoki rejimlarga 
o’tkazilishi mumkin: 
• Oq –qara shtrixli tasvirlarga; 
• Kul rang gradatsiyadagi tasvirda; 
• Dupleks tasvirda;  
• RGB, CMYK yoki LAB toliq turdagi turlariga: 
• Indektsirlangan tasvirlarga (paletted). 

Boshqa turga o’tkazganga (konvertizatsya qilganda ) tasvirlarning bazi bir qismlarini 
yoqolishiga olib keladi, bu esa ranrlari ko’p bo’lgan tasvirlarni kamroq bo’lganlarga 
o’tkazganda seziladi, masalan  RGB dan CMYK ga o’tkazilganda. Qatandan 
o’tkazilganda yoqatilganlari tiklanmaydi. 

OOOqqq---qqqooorrraaa   ssshhhtttrrriiixxxlllaaannngggaaannn   tttaaasssvvviiirrrlllaaarrrgggaaa   kkkooonnnvvveeerrrtttiiizzzaaatttsssyyyaaa   qqqiiillliiissshhh   
Точечные изображения / Конвертировать в 
(Bitmaps / Convert То) menusidagi 

 
 Черно-белый штрих (Black and White) (1 bit) 
buyrugi ekranga quyidagilarni chqaradi 
Конвертировать в 1-битовое изображение 
(Convert to 1 Bit). 
Тип конвертирования (Conversion) tanlanganda 
paramertlar maydoni uzgaradi. 

• Штриховое изображение (Line Art) varianti 
tasvirning qaysi  qiymatlari oq ranga qaysilari 
qora rangga utishini taminlaydi.. 
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• Имитация со случайным разбросом (Error Diffusion) varianti. Имитация с 
помощью образцов (Ordered), Jarvis, Stucki, Floyd-Steinberg, Cardinality-
Distribution ton bosqishlarini har xil usullarini taklif qiladi. Parametr hisobida 
Интенсивность (Intensity) maydonidan kiritilgan quymatlar ixtimolik 
darajasini beradi. 

• Halftone (Растровое изображение) varianti qora ranglar uchun poligrafik 
rastrlarni eslatadigan tasvirlarni olishni taminlaydi.  

KKKuuulll   rrraaannnggg   gggrrraaadddaaatttsssiiiyyyaaasssiiidddaaagggiii   tttaaasssvvviiirrrgggaaa   kkkooonnnvvveeerrrtttsssiiiyyyaaalllaaassshhh      
Hoqlagan huxtali tasvirlar градациях серoго ko’rinishida tasvirlashga bo’ladi 

buning uchun tasvirni ajratish kerak va quyidagilar bajariladi: menuning Точечные 
изображения/Конвертировать в (Bitmaps/Convert To) va Градации серого (8-bit) 
(Grayscale) amallari bajariladi. 

Bu protsess hech qanaqa quchimchalarnin talab qilmaydi.Natijada rastrli tasvirlar 
paydo bo’ladi, har bir piksel sakkizta bit bilan beriladi,  buni 256 talik qilib 
olishga ham bo’ladi: bunda 0 qora, 255 — bo’lsa oq rangni beradi. 

DDDuuupppllleeekkksss   tttaaasssvvviiirrrlllaaarrrgggaaa   kkkooonnnvvveeerrrtttsssiiiyyyaaalllaaassshhh      
Дуплексное изображение (duotone) — bu monoxrom tonli tasvirni ekkita 
(uchta,turtta ) basmaga chiqarichning turi bulib hisoblanadi. Buda asosiy rang qora 
buyoq bo’ladi, qolgan buyoqlar esa — och (kul, och-malla, havo oyki yashil). 
Bosmaga chiqarishning bu turi ton diapazononi kengaytirish uchun va bitta rang 
ishlatilganda etishmagan tonlarni konpenstsya qiladi. 
Tasvirini yoratish uchun menuning Точечные изображения/Конвертировать в 
(Bitmaps/Convert To) va Дуплекс (8-bit) (Duotone) buyrugi bilan amalga oshiriladi. 
Ekranda mulahot oynasi ko’rinadi. 
RRRGGGBBB,,,   CCCMMMYYYKKK   иии    LLLaaabbb   rrraaannnggg   mmmooodddeeellllllaaarrriiigggaaa   kkkooonnnvvveeerrrtttsssiiiyyyaaalllaaassshhh      

Rastrli tasvirlar   RGB, Lab va CMYK  modellariga konvertizatsya qilinadi.Bu 
turlar komputer texnologyasida, ekranning grafika bilan bogliq bo’lgan joylarida 
ishlatiladi. 

Belgilangan obyektni konvertizatsya qilish uchun quyidagilarni bajarish kerak 
Цвет модели  buyrugi  RGB (24-bit) (RGB Color). (24-bit) Цвет модели Lab (Lab 
Color) yoki Цвет модели CMYK (32-bit) (CMYK Color)  buyruqlar menuning 
Точечные изображения/Конвертировать в (Bitmaps/Convert To) joylashgan. 

CMYK turiga konvertirlashda katta ahamiat berish kerak sababi u qurilmalarga 
bogliq bo’ladi. Bir xil tasvirni har qil qurilmalarga konvertirlaganda dastur har xil 
natija ko’rsatadi. 
IIInnnttteeennnsssiiivvv   rrraaannngggllliii   tttaaasssvvviiirrrlllaaarrrnnniii   kkkooonnnvvveeerrrtttsssiiiyyyaaalllaaassshhh      

Indekslangan rangli tasvirlar bir kanalli 8 bitli tasvirlardan 256 ta ranglardan 
tashkil topadi. Bunday tasvirlar fayllarni kichkina o’lchamlari  bo’lgan tasvirlarda 
ishlatiladi.Avvallari bu tasvirlar imkoniotlari cheklangan vedioadapterlar 
foydalanilgan edi endilikda Internetlarda kengnan foydalanilmoqda. 
Menuning Точечное изображение/Режим (Bitmap/Mode) sidan  
Индексированный (8-bit) (Paletted) buyrugi tanlanilsa mulahot oynasidagi  
Конвертировать в индексированные цвета (Convert to Paletted)ni bajarish kerak.   
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111000... KKKuuu’’’ppp   sssaaahhhiiifffaaallliii   hhhuuujjjjjjaaatttlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   

CorelDRAW dasturi vyorstkali dasturlarga tegishli emas, verstkali dasturlarda  
ko’p sahifali hujjatlar bilan ishlash imkoniyatlari bor. Coreldraw dasturidada ko’p 
sahifali hujjatlar bilan ishlash imkoniyati bor, va unda  999 sahifali hujjatlar bilan 
ishlashga bo’ladi. Qoplagan funktsyalarini yetishmasligi verstalchini ishini 
yengillashtiradi, katta hajmdagi hujjatlarni bitta bir- nechta sahifaga joylashtiradi, 
bunday hujjatlarga — reklama bukletlari, qisqacha bo’lgan hujjat, prays-listlar, 
kichkina broshuralar va h. 
SSSaaahhhiiifffaaa   pppaaarrraaammmeeetttrrrlllaaarrriiinnniii   qqqooo’’’yyyiiissshhh   

Sahifalarni qo’yishning asosiy buyruqlari     Компоновка (Layout) menusi va  
Параметры страницы (Page Setup...) buyrugi, natijada ekranga mulahot oynasi 
Параметры (Options)ning  Формат (Size) chiqariladi. 

 
Mulahot oynasi yoqari qismida  sahifa tipini aniqlash o’tkazgishlari berilgan— 

Традиционные форматы (Normal Paper) va Этикетки (Labels). Paper (Формат 
бумаги) ruyhatida johonda ishlatiladigan formatlar yigindisi berilgan. Agarda hech 
bir format to’gri kelmasa, u holda Ширина (Width) va Высота (Height)lardan 
foydalanib kerakli parametrlarni kiritsa bo’ladi. 

Ruyhatnin yonida ulchov birligi berilgan Сохранить параметры формата 
страницы (Save Custom Page) tugmasi  tayor bo’lgan formatli sahifani xotiraga 
saqlaydi. 

Разрешение (Resolution) maydonida ruyhatdan bitta bariant tanlaniladi yoki 
hoqlagan mumkin bo’lgan son qiymati kiritiladi. 

Использовать параметры принтера (Set From Printer) tugmasi sahifaga 
berilgan parametrlarni joriy printerga o’rnatadi. 

Параметры (Options) mulahot oynasini chap tomonidagi  satrdan 
chaqiriladigan Компоновка (Layout) bulimi sahifalarni joylashtirishini bir nechta 
variantlarini beradi uz navbatida bu hujjatni markeriga tasir qiladi. 

Компоновка (Layout) ruyhatida markerlarni oltida varianti berilgan (variantalr 
ko’rish oynasidan ko’rsatilib turiladi):  
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Разворот (Facing pages) bayroqchasi ekranda ekkita qo’shi sahifalarni 
joylashtiradi,  

Начать с (Start on) punkti Разворот (Facing pages)ga bayroqcha qoyganda 
joriy bo’ladi va  qaysi betdan aykantirishni boshlashni bildiradi, (левой (Left Side) 
chaptan yoki (Right Side)) ongdan. 

Фон (Background) hamma sahifalar uchun umumiy fonini aniqlaydi. 
Bu fon zalivka yoki nuqtali tasvir bo’lishlari ham mumkin. Ulardan bitttasini 

tanlash imkoniyati bor u uchun o’tkazgishni bittasini — Сплошная заливка (Solid) 
va Точечное изображение (Bitmap) tanlash kerak. 

SSSaaahhhiiifffaaa   qqqooossshhhiiissshhh   

Hujjat boshida uzi bitta sahifa bo’ladi.Yangi sahifalar qoshish uchun berilgan 
ekkita “+” tugmalaridan bittasi tanlaniladi,birinchisi bosilishi bilan joriy sahifa 
oldiga yangi sahifa qoyiladi,ekkinchisi bosilsa joriy sahifa keyniga yangi sahifa 
qoyiladi. 

Shu bilan birga bir nechta sahifalarni qoshishga 
ham bo’ladi u uchun menuning Компоновка (Layout) 
va Добавить страницу (Insert Page...) bosish kerak 
va ekranga mulahot oynasi chiqariladi. 

Добавить ... страниц (Insert ... pages)  
maydonida 1dan 998 gacha qyimat beriladi. Ishchi 
oynani pastki qismida sahifalar nomerlari bilan 
beriladi haqlagan sahifaga tegishli nomerini bosish 
orqali utiladi. 

До (Before) va После (After) lar joriy sahifadan oldin yoki keyin qoyiladigan 
sahifalar, rahamlari Страница (Page) da beriladi. 

Bitta sahifadan ekkinchisiga utish sahifalarni boshqarish blogi yordamida yoki  
Компоновка (Layout) menusidagi Перейти к странице (Go to Page...) buyrugi 
yordamida utiladi.Bunda paydo bo’lgan oynada utishi kerak bo’lgan sahifa nomeri 
kiritiladi. 

SSSaaahhhiiifffaaalllaaarrrnnniii   ooo’’’ccchhhiiirrriiissshhh   

Keraksiz sahifalarni albatta uchib tashlash kerak.Bu uchun menuning 
Компоновка (Layout)sidan, Удалить страницу (Delete Page...) buyrugi tanlanadi va 
nomayon bo’lgan oynadaquyidagi amallar bajariladi. 

Удалить страницу (Delete page)maydoni uchirilishi kerak bo’lgan sahifa 
nomerini kiritish kerak. По страницу ... включительно (Through to page ... 
Inclusive) maydonidagi bayroqcha belgilangan bo’lsa uchirilishi kerak bo’lgan 
sahifalarni oxirgi rahami kiritiladi. 

SSSaaahhhiiifffaaagggaaa   nnnooommm   bbbeeerrriiissshhh   

CorelDRAW daturida sahifalarni nom birish uzgasha xarakterga ega bo’ladi. 
Bu protsedurani matn muharrialari va verstka dasturlaridandagi sahifalarga nom 
berishdan farh qiladi. Sahifalarga nom berish hujjat bilan ishlashini osanlashtiradi. 

Компоновка (Layout) menuning  Переименовать страницу (Rename Page...) 
buyrugi yordamidasahifalarni nomlashga bo’ladi. 

Mulohat oynasidan kiritilgan nom moa sahifani vkladkasida chiqariladi. 
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PPPrrrooopppeeerrrtttyyy   BBBaaarrr   pppaaannneeellliiidddaaagggiii   sssaaahhhiiifffaaalllaaarrr   pppaaarrriiimmmeeerrrtttlllaaarrriii   
Agarda hech qanaqa obyekt tanlanmagan bo’lsa Свойства (Property Bar) 

asboblar panelidaquyidagi parametrlar chiqariladi va ularni o’zgartirish imkoniyati 
bo’ladi. 

Birinchi ruyhatdan sahifa formati tanlaniladi, keyingi satrdan sahifa 
o’lchamlari beriladi, ekkita tugma, sahifa orientatsyasini beradi, va ekkita birining 
ustida ekkinchisi joylashgan lar, yuqargisi hamma sahifa parametrlarini, pastkisi 
fahat joriy sahifa parametrlarini o’zgartiradi. 

Bu xossadan shuni ko’rish mumkin ki  CorelDRAW dasturida sahifalar 
o’lchamlari , orientatsyalari har xil bo’lishlarini ko’rsatadi. 
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IIIIII   bbbuuullliiimmm      :::      MMMaaacccrrrooommmeeedddiiiaaa   FFFlllaaassshhh   
111111... WWWeeebbb---dddiiizzzaaayyynnn   ,,,   WWWeeebbb   –––   sssaaayyyttt   tttuuussshhhuuunnnccchhhaaasssiii   vvvaaa   sssaaayyyttt   tttuuuzzziiillliiissshhhiii   

Bugungi kunda Internetda sayohat qilinganda ko’pgina yaxshi bajarilgan 
saytlarni ko’ramiz, bu saytlar tez vaqt oraligida komputerga  yuklanadi, chiroyli 
ko’rinishga ega, malumotlarni boblar boyicha aniq bo’lishtirib qoygan va и 
navigatsia funktsyalari qulayli qilib yaratilgan. Bu saytlarga kirib har xil malumotlar 
olishingiz, kugilingizni yazishingiz va h.  . 

Agarda siz qanaqadir bir saytda uzoq vaqtga ushlanib qolsangiz demak bu sayt 
yaxshi ishlab chiqilgan. Orqaga qaytib saytning umumiy korinishini qarab chqing. 
Tuzilishini yoki qanaqa boshqarilyatganin ko’ra alasizmi? Malumotlar engil qabul 
qilinadimi? Mamumotlarning oqimini boshqarishni tushunish  — bu saytni 
yaratishning birinchi qadami bulib hisoblanadi.  

MMMaaallluuummmoootttlllaaarrr   oooqqqiiimmmiiinnniii   rrreeejjjaaalllaaassshhhtttiiirrriiissshhh      

Ko’pgina Web sahifachilar malumotlar oqimi bilan ishlashga vaqt ajratmay, 
tasvir va matnlarni saytga joylashtirishga itibor beradi. Ko’pgina saytlar saytga 
kirivchilar sonini ko’pligi bilan maqtanish suzlari bilan kuzga tushadi,  bu saytning 
yaxshi sifatli ekanlifini ko’rsatmaydi. Saytni yaxshi ishlanganligini saytga kirivchini 
ko’p vaqtini  saytda o’tkazishi  bilan bilish mumkin. Bu degan foydalanuvchi uziga 
kerakli narsalarni saytdan topganligini bildiradi.  

Saytni effektiv qilib yaratish uchun avval malumotlat oqimini va foydalanuvchi 
yolini vizuallashtirish kerak. Boshqa suz blan aytganda uz saytingizni foydalanuvchi 
sifatida ko’rishingiz kerak. планирования  protsessi ko’p mehnatni va  vaqtni talab 
qiladi, agarda u sizga huzur bagishlasa demak saytingiz alo darajada bo’ladi.  

Frontpage asbobi yordamida saytlarni yaratish imkoniyatiga egasiz. Sayt 
qanaqa ko’rinishta va unda qanday malumotlar joylashtiriladi bu hammasi sizga 
bogliq bo’ladi.Berilgan bobda Internet va Intranetlar uchun saytlar haqida mulahazo 
yuritamiz. 

YYYaaaxxxssshhhiii   sssaaayyytttnnniii   qqqaaannndddaaayyy   yyyaaarrraaatttaaammmiiizzz   

Enr yaxshi Web saytlar bu-chiroyli ko’rinishga ega, asosiy maqsadni ixcham 
bergan  va foydalanuvchini kuttirib qoymaydigan bo’lishi kerak. Quyida yaxshi 
saytni yaratish boyicha bir nechta maslahatlar berilgan:  

Saytinizni nigaga mujallanganligini aniq bo’lishi kerak. Asosiy maqsadingiz? 
Fahat Interner ushun mi? Uzingizni maqsadingizni imkoniyati boricha aniq belgilab 
oling. Sizni sayt kompanyagizni  mahsulotlari bilan tanishtitor. Fahat siz bu 
mahsulotlarni qanday qilib olib chiqichni oylashingiz kerak. Bozorda qanday urin 
tutishi hoqlaysiz? Yuqarida berilgan sovallarga aniq qilib jobob topilsa qoyilgan 
maqsadga albatta etadi.  

Albatta uzingiz auditoriangiz haqida ham oylashingiz kerak. Sayt kimlarga 
muljallanganligi? Necha yoshga? Nima bilan chugullandi? Saytingizda qancha vaqtni 
o’tkazadi? Berilga malumotlarga, rasmalarga va boshqa elementlarga auditoria 
qanday itibor berishi hisobga olish kerak.  

Tez orada yuklanadigan elementlarni saytga qoying.Nimaga adamlar saytga 
kirmay qo’yishning birinchi sababi ko’p vaqtda yuklanishi bo’ladi. Grafik faylarni 
katta bo’lganida foydalanuvchi protsess toqtatishga intiladi shu sababli Stop 
tugmalaridan foydalangan maqul.  
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Saytni ko’rinishini chirayli qiling. Sizalbatta internetda zerikarli saytlarni ham 
ko’rgan bo’lsanglar kerak. Sayt qiziqarli bo’lishi uchun nima qilish kerak? 
Sarlavhalarni, matnlarni l ko’rinishda va ranglarni etishmovchiligidandir. Sizlar 
tartibsiz joylashtirilgan va har hil shriftlarni va ko’p ranglarda foydalangan saytlarni 
ham ko’rgan bo’lsangiz kerak. Yangi sayt yaratiatgan paytda sayt sahifalarini 
formatlashga ham itibor berish kerak.  

Hamma narsani bitta sahifaga joylashtirmaslik kerak. Sahifaga malumotlarni 
haddan tashqari ko’p joylashtirmang. Bizlar yozuvchilari yozishni yaxshi 
ko’radigani, grafik dizajnerlar effektli rasmlarni yoratishni yaxshi bilamiz. Sizning 
vazifanigiz sayt yoratuvchisi — yani ekki xil guruh odamlarni shunday qilib boqlashi 
oylash kerak Matnli va grafik malumotlarni bir qil tenglikda ushlab turish kerak. 

Sizni saytni kim oqishini va matnli malumot  ko’p bo’lsa foydalanuvchini 
zeriktirib qoyasiz shu sababli sahifangizni kerakli malumotlarni gina 
keltiring.Sahifani en tomonlaridan shegaralashda optimal foydalaning sahifani katta 
o’lchamli qiling,matnlarni jadvallarga joylashtiring Grafikalarni sahifaga 
joylashtirganda uning asosiy xizmatiga itibor bering: asosiy maqsad uchun xizmat 
qiladimi, yoki  fahat chiroyli qilishda foydalanildimi? Shuni ham itiborga olish 
kerakki chroyli grafika ham maqsad bulib topiladi. Har bir Web –sayt chiroyli 
ko’rinishi , kerakli malumotlarni uzida saqlashi kerak va ko’rish uchun qulayli 
bo’lishi kerak.  

Saytni yaratganda uni manosi bilamchi shakli esa ekkinchi bo’lishini kuzda 
tutish kerak. Faqat shakli ham chiroyli bo’lishini nazarda tutish kerak. Iziqarli 
bo’lgan malumotlarni ishkariga joylashtirmaslik kerak sababi foydalanuvchi sayt 
qiziqarli emas deb kirmay qo’yishi mumkin.Kerakli malumotlarni mumkinchiligi 
boricha ason gina ishlaydigan qilib qo’yish kerak. Sizni sayt fahat bitta bosqichdan 
iborat deb tushunmaslik kerak. Ekkinchi darajali malumotlarni bir-biri bilan 
boglangan guruhlarga joylashtiring. Masalan siz,musiqiy magazinni interaktiv 
katalogini yoratiabsiz. Bitta ruyhatga djaz musuqasini va rok musiqasini joylashtirgan 
bularmidingiz? Albatta yoq.Uzingizni saytniyaratganga mana shunaqa narsalarga 
itibor berishingiz zarur.  

Saytda sayt boyicha yurish tugmalarini qoyib chiqing. Ko’pchilik saytchilar 
saytni bulimlariga bogliq bo’lgan adreslariga tugmalar qoyadi. Bu tugmalar saytni 
barcha sahifalarida bo’ladi va  bir xil joyda joylashgan bo’ladi Bir xillik va 
kompaktlilik saytni ko’rishni engillashtiradi. Foydalanuvchi fahat mos tugmani 
bosish oraqli keyingi sayt bulimiga utiladi.  

Quyida navigatsya tugmalarini joylashtirish boyicha yorixnoma berilgan:  
- Foydalanuvchi hamma vaqtda orqaga qaytishi uchun tugmalari qoyilgan 

bo’lishi kerak. Agarda foydalanuvchi bechinchi bosqishga utgan bo’lsa utish tugmasi 
bir marta bosish orqali birinchi sahifaga qaytish kerak. Agarda foydalanuvchi Back 
tugmasini nir necha marta bosish orqali amalga oshirgan bo’lsa, u holda 
foydalanuvchi tez orada bu saytga kirishni toxtatadi.  

- Foydalanuvchilarda brauzerida grafiklarni ko’rish ishlamay qolishini ham 
itiborga olib qo’yish kerak.Shu sababli grafik tugmalar blan birga matnli tugmalarni 
ham ishlatish maqul bo’ladi. Bu esa foydalanuvchiga qylayli bo’lgan variantni 
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tanlash imkoniyatini beradi. Vaqt utishi bilan tez orada Web sahifalarda fahat grfikli 
tugmalar  qoladi.  

Sayt boyicha yurishni engillashtirish kerak. Sayt yaratganda qaysi nuqtalar 
orasiga ko’prik qo’yishni uzimizdan sorashimiz kerak. Bu javobdan ko’p narsa hol 
bo’ladi. Sizning sayt boyicha sayohat ason va qiziqarli bo’lishi ham jovabga bogliq 
bo’ladi.  

Frontpage Проводника kartasidan foydalanish kerak. Карта навигации 
(Navigation view) malumotlarni tasvirlashda qiynchilik tugdirgan paytda qul keladi. 
Ishni asosiy sahifadan boshlash va ishkari davom ettirish kerak. Bu vizual ko’rinish 
saytni tuzilishini ko’rsatadi va uni o’zgartirishda osonlik tugdiradi, qatolikga yol 
qo’yish oldini oladi. Saytni yaxshilab testdan o’tkazish kerak. Brauzerlarni har xil 
turlari mavjud va  brauzerlarda boshqacha chiqariladi. Saytni har xil brauzerlarda va  
platformalarda (Windows 95, Windows NT, UNIX и Macintosh), modemni har xil 
tezliklarida tekshirib koring. Sahifani chetiga qoyilgan tugmalar brauzerlarning birida 
aynani ortasida chiqib qoladi. Tajribali Web – dizaynerlar saytlarini bir nechta 
brauzerlarda tekchirib ko’radi. (Проверить гиперссылки) Verify Hyperlinks  
buyrugi yordamida sayt ishidagi hamma boglanishlarni tekshirib ko’riladi. Bu amal 
Проводникdan  (Hyperlink Status View) buyrugi orqali ham amalga oshiriladi  

Saytni tekshirishning ekkinshi usuli —Редактор dagi Preview In Browser 
(Предварительный просмотр в браузере) orqali bajariladi. Bu sizni sahifangizni 
vezual turda komputerda o’rnatilgan brauzerlarda tekshirib beradi. Masalan, agarda 
siz 1024х768 ekranda ishlaydigan bo’lsangiz,sahifangizni 640х480 bilan ham ko’rish 
imkoniyotini beradi.  

Agarda foydalanuvchi qiynalmasin desangiz, saytingizdan foydalanuvchi 
malumotni oson topadigan qilib qoying.. FFFrrrooonnntttpppaaagggeee   SSSeeeaaarrrccchhh   CCCooommmpppooonnneeennnttt   (((ПППоооиииссскккооовввооогггооо    
КККооомммпппооонннееенннтттааа    FFFrrrooonnntttpppaaagggeee)))   yordamda  saytdan kerakli bo’lgan mamumotlarni qidirish 
mexanizmlarini beradi.  

IIInnntttrrraaannneeettt   sssaaayyytttlllaaarrriiinnniii   rrreeejjjaaalllaaassshhhtttiiirrriiissshhh   

Bosqarmangiz Intranet saytini yoratish qiyin masal emas. Siz bunda Internet 
saytini yoratgandagidan azgina farqini kyrasiz. Birinchidan qanaqa ayditoriaga 
muljallanganligini oldindan  bilasiz, bu esa aniq va maqsad toman intilishlaringizni 
osanlashtiradi. Sizga setda qanaqa komputer turganligi ,ularni tezligi, qanday brauzer 
qoyilganligi va sizni saytga qanday ulanganligi haqida malumot beriladi. Bular 
bilgandan keyin sizga Web sayt yaratish bir muncha oson keshadi.  

Agarda sizni kompanya katta bo’lsa, sayt ham kichik bo’lmasligi kerak, u 
holda saytlarga jovobgarlar soni ham ko’p bo’ladi. Frontpage  Intranet setlarini 
boshqarishni bir-muncha engillashtiradi. 5 –bobda kengroq berilgan.  

Sizni kompanyangizga Intranet kerak mi? Ko’pgina kompanyalar hozirgacha  
ish malumotlarni (buyruqlarni, yangiliklarni, telefon rahamlari) eski usul bosmaga 
chiqarish orqali yuritadi.Bosmaga chiqarilgan holda geografik regionlarga ham 
jonatiladi. Har bir uzgarish kiritilganda qaytatdan bosmaga chiqarishga va jonatishga 
to’gri keladi. Malumotlarni jonatishni bu usuli kompanya uchun qimmatga tushib 
gina qolmay tabiat resurslari sarfloshga to’gri keladi.. 

Aksincha , intranet sayti mavjud bo’lsa, tez va oson malumotlarni 
yangilashingiz va manziliga etkazishingiz mumkin. 
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RRReeejjjaaalllaaassshhhtttiiirrriiissshhh   mmmuuuaaammmmmmooolllaaarrriii   

Intranet saytlarini yaratishda  Web sayt yaratgandagi dizayn muammolari bilan 
ham uchrachamiz. Boshlangish etabida ishni yaxshilab talqin qilinishi ko’pgina 
muammolarni oldini oladi:  

Kompanyada kim saytga dostupi bor bo’lishi? Unda qanaqa malumotlar 
joylashtirilgan bo’ladi? Malumotlar bilan hamma ishlash imkonyatiga egami? 

Saytni kim yangilaydi? Kim qanaqa bu’lim va masalalarga javob beradi? 
Saytni yoratmasdan avval, kim nima qilishini aniqlab olish zarur. Frontpage 
yordamida masalalarni bo’lishtirish imkonyoti bor, bu uchun Проводник da (Tasks 
View) masalar ruyhati mavjud. 

Qanday qilib saytni boshqarishdan chiqib ketmasligini ushlaysiz? Buni nazorat 
qilish uchun sayt malumotlariga va ularga quchimcha kirita oladigan odamlarni 
aniqlash kerak. Agarda saytga haqlogan kompanya ishchisi malumotlar kiritib va 
malumotlarni o’zgartirish imkonyatiga ega bo’lsa u holda sizning  sayt tez orada 
chalkashka turga keladi. Foydalanuvchilarni boshqarish uchun Frontpage ko’rish, 
o’zgartirish kiritish va boshqarish  imkonyotlarini beradi.  

Boshqarmangizda komputer set o’rnatilgan bo’lsa kerakli fayllarni topish yoki 
hojjatlarni ko’rishga bo’ladi, fahat bu jarayonni oddiy demaslik kerak: sababi siz 
kerakli komputer setiga ulanasiz, faylni komputeringizga nusqasini olasiz yoki uni 
boshqa komputerda ko’rishgiz, faylni ko’rish uchun mos dasturni ishga tushirish, va 
h. Bajariladi.Shu bilan bir masofadagi komputer haqida malumot olmaqchi bo’lsak 
fahat fayllar ruyhatini chiqarib beradi. Faylni qaysi joyda joylashganligini bilgan 
bilan uni setdan topish juda qiyin masalardan biri bulib hisoblanadi unig ustiga fayl 
nomini bilmasangiz uni topish haqida gap ham bo’lishi mumkin emas.  

Intranet setlari malumotlar olmashini vizual turda amalga oshiradi. Masalan 
utgan kvartal uchun  Microsoft Exceldagi tayorlangan firmani kommertsial hisobat 
hujjati ko’rmoqchi bolyabsiz Bu amal mos faylni topib ochish va komputeringizdagi 
Excelga yuklash kerak.  

Intranet paydo bo’lishi bilan xizmatchilarni fayllar haqidagi malumotni setni 
qaysi joyda joylashganligini yodga saqlamasdan bilish imkonyoti tugildi. 
Foydalanuvch fahat saytdagi kompanyani qarajatlari haqidagi sahifani topib  marta 
sichqoncha bilan murajjatga chertish kifoya.  

SSSeeerrrvvveeerrrlllaaarrr      

Saytni Intranetda joylashtirish uchun sizga Web-сервер kerak bo’ladi. Agarda 
Web-сервер belgili komputerga o’rnatilgan bo’lsa yaxshi bo’ladi, u tarmoqli serverga 
uxshash bo’ladi. Komputer tez va kuchli bo’lsa sayt ham yaxshi ishlaydigan bo’ladi.  

Web-serverni tanlash tarmoqdagi traffikga bogliq bo’ladi. Agarda sizni 
kompanya kichik bo’lsa bitta server bilan chegarlansa bo’ladi. Personal Web-serverli 
Frontpage yoki Web-server Microsoft lar katta hajmdagi malumotlarni qayta 
ishlashga muljallanmagan, katta taqmoqlarga katta malumotlarni qayta ishlaydigan 
serverlar kerak bo’ladi.  

XXXaaavvvfffsssiiizzzllliiikkk   

Internet tarmogidagi ko’pgina fayllarni himoyalash uchun standart turdagi 
tarmoq xavfsizlik vositasidan foydalanilsa bo’ladi. Agarda siz Intranetdagi belgili 
faylarni cheklangan odamlarga o’zgartirish imkoniotlarini beradigan bo’lsangiz,u 
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holda siz tarmoqda ham malumotlardan foydalanishni chegaralab qouishingiz 
mumkin. 

Oddiy tarmoq xavfsizligiga yana Frontpage tomonidan uchta quchimcha Web-
saytlardan foydalanish erkinligini beradi. Siz tomondan foydalaniladigan Web-server 
ham xavfsizlik vositalariga ega:  

--- Просмотр  
- Авторский доступ (Frontpage yordamida ko’rish, muhharirlash v .h)  
-Административный доступ: administrtorlar avtor erkinligiga ega  

ИИИнннфффооорррмммаааццциииооонннннноооеее   нннааапппооолллнннеееннниииеее   

Intranetni barcha sohalarda foydalanish mumkin:  
- Ish malumotlarini va hujjatlarini hamma erkin foydalanish imkoniyatiga ega 

bulsin. Intranet saytlari boshliq buyruqlarini tarqotishda , oquv maskanlarida  , dars 
jadvallarini tuzganda, mahsulotlar kataloglari va h. Samoradorli bo’ladi. Bu esa 
vaqtni va pulni tejaydi. – Ishchilarni kompanya yangiliklari bilan tanishtirib turish  
foydalaniladi. 

 Intranet saytlari — yangiliklar, reklamalar va h. uchun malumotlar oynasini 
ham bajaradi. 

 -Intranet ni kudalikli hayotda ham ishlatsa bo’ladi.  
- ntranet-saytini  Internet bilan boqlasa ham bo’ladi. Buning uchun 

бббррраааннндддмммааауууэээррроооввв   (((fffiiirrreeewwwaaallllll))) va PPPrrroooxxxyyy---сссееерррвввеееррроооввв orqali  Internet bilan boglasangiz 
bo’ladi.. 

Web-annimatsya yoratish vositalari. Macromedia Flash . 
Jahonda yarim million odamlar Flash tehnologyasidan chiroyli bo’lgan Web resurslar 
yaratishda foydalanadi. Dizaynerlarni Macromedia Flash grafika yaratishni yangi 
imkonyatlari uziga tortadi, professional darajadagi yaratuvchialаr bo’lsa uzlari 
hoqlagancha  skriptlarni,shakl va server imkonyotlaridan foydalanib ilovalar yoratishi 
qodir. 
Macromedia Flash  foydalanuvchi esida qoladiganday Web-saytlarni yaratadi. Bu 
vosita yordamida vektor grafikasi va rast tasvirlarni bir-biriga utish imkonyatlari bor 
obozlar qoshish, animatsyalar yaratish va h ega.  
 Macromedia Flash  Web  sahifalarni yaratganda qul keladi import qilish 
imkoniyatiga hanm ega 
Macromedia Flash  katta imkoniyatlarga ega bulib Macromedia Generator bilan ham 
uz- ora boglangan bo’ladi. 

111222...   MMMaaacccrrrooommmeeedddiiiaaa   FFFlllaaassshhh   ccchhhiiizzziiissshhh   aaasssbbbooobbblllaaarrriii   
Rasmlarni chizish uchun Flash (drawing 

tools) asboblarini foydalaning. Rasmlarni hoqlagan 
vektorli muharrirlardan Macromedia FreeHand, 
Adobe Illustrator, va  Adobe Photoshopdan rastrli 
tasvirlarni  va h. dasturlardan import qilish 
mumkin  

Flash da rasm chizish osan fahat asboblar 
yordamida,ajratish,boglash va bulaklarga bo’lish 
amallarinin bajarib bilsangiz buldi.  

Asboblar panelidan hoqlagan asbobni tanlang 
. Tanlangan asbob turiga qaray  asboblar paneli 
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ko’rinishi uzgaradi.Bu uzgarishlar tanlangan asbob bilan nima ishlash kerakligini 
ko’rsatadi. Masalan, Qalamni tanlaganigizda qalinligini, rang, chiziq styili va sizlar 
avtomat tarizda doyra (smoothed) yoki uchqir (straightened) ishlash 
imkoniyatiniberadi.  

To’gri chiziqlarni va shtrixlarni chizish 
To’gri chiziq yoki shtrixni chizish uchun qalam foydalaniadi. Chiziqlar bittalik 

elementlar bo’ladi. Штрих кисточки – sohani konturlar bilan tuldiradi.  
Qalam yordamida chizilgan chiziq. 

 Flashda chiziqlar chizganingizda egrilarni 
uzi turgilaydi, bu uzingizda havola, egrilarni 
to’grilangan  ko’rinishida yaki siz chizgan 
ko’rinishda qoldirilishi ham mumkin. Bu 
amallar menudan tanlanilib bajariladi. Shu 
bilan birga chiziq rangi,qalinligi,stylini 
tanlashingiz mumkin. Qalam yordamida to’gri 
ciziqlarni , egri chiziqlarni ham chizadi. Flash asosiy geometrik shakllarni avtomatik 
tarizda qabul qiladi, siz uzingizga kerakli bo’lgan egri chiziqni ham tanlashinghiz 
mumkin. Bularga quchimcha chiziq shaklini hoqlagan vaqtda o’zgartirishingiz 
mumkin.. Chiziqlarni uchta xossasi bor : rangi,qalinligi,styli.  

Qalamni imkoniyatlaridan foydalanib chiziqni tashqi ko’rinishini o’zgartirsa 
ham bo’ladi. Siz chiziq rangini  tanlshingiz va ruyhatdan hoqlagan rangni tanlash, 
yoki  ikonkali palitraga sichqoncha bilan chertish orqali rang tanlshimiz mumkin. 
Bulardan tashqari quyidagilardan foydalangan holda ham rang tanlash mmkin:  

Qalamni menuchasi  
 

Bu menuda quyidagilarni bajarsa bo’ladi.  
 Straighten(выпрямление) chiziqlarni va egrilarni tugralash 
xossasiga ega. Agarda siz bu optsyani tanlab va rgri chiziq 
chizib sichqonchani qoyib yubarsangiz,u zigzag ko’rinishigq 
aylanadi 

 Smooth (сглаживание) chiziqlarni to’grilash xossasiga ega 
emas fahat tekislaydi. Siz bu optsani tanlab zigzag 
ko’rinishidagi chiziqni chizsangiz, u tulqinsimon ko’rinishga 
keladi. ( silliqlanadi) 

 Ink (чернила) cizqialarni siz chizgan ko’rinishta qoldiradi. 

 Oval Oval va doyralarni chizadi. Sichqoncha yordamida 
diagonal boyicha bochlangich nuqtadan oxirgi nuqtagacha 
ko’rsatiladi.Agarda "магнит" bosilsa sizda doyra paydo 
bo’ladi, kursor atrofidagi aylana qoraroh bulib kattalashadi. 

 Rectangle kvadrad va to’griturtburchaklarni chzadi. Agarda 
"магнит" bosilga bo’lsa kvadrad paydo bo’lishdan kursor 
atrofidagi aylana qoraroh bulib kattalashadi.  

 Line boshlangich va oxirgi nihtalarda tugi chiziq 
chizadi.Agarda magnit bosilsa gorizontal yoki vertikal 
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chiziqlar paydo bo’ladi, agarda sichqonch qoyib yubarilsa 
kursor atrofidagi aylana qoraroh bulib kattalashadi   

Chiziq qalinligi  
Bu optsyadan foydalanganda  qalam uchun yana menu ochiladi. Chiziqlarni qalinligi 
soch qalinligidan 10 poitgacha (points) bo’ladi.  

 
Uzingizga kerakli bo’lgan qalinlikdagi 
chiziqni tanlash uchun menuning 
Custom tanlanadi, va ochilgan oynadan 
chiziq xossalari tanlanadi(Line Settings). 
Shu erga kerakli bo’lgan chiziq 
qalinligini kirtitish kerak. 

 
 
 
 
 
 
 
Eslatma: Chiziqlarni bir turlari ekranda boshqacha printerdan bosmadan 
chiqarganda bochqacha bulib ko’rinishi mumkin .  

Chiziq styli  
Bu asbob chizmoqchi bo’lgan chiziqni tipini bildiradi. Uzingizni stilni yaratmoqchi 
bo’lsanglar Custom tanlaniladi yoki tayor stillardan bittasi tanlanadi.  

Line Style  mulahot oynasidan "Тип" (Type )  da chiziq stili tanlaniladi.Har 
bir stil uzini xossasiga ega. Sizlar quyidagi chiziq tiplaridan bittasini 
tanlashingiz mumkin:  
 
 

 
Solid qalin chiziqni chizadi. 

 Dashed uzug chiziqni chizadi, uzik chiziqlar orasidagi masofani uzingiz 
berishingiz mumkin. 

 Dotted nuqtalarda iborot chiziqni chizadi. 
 Ragged quldan chizilgan tekis emas chiziqni chizadi.  
 Stippled har xil o’lchamli nuqtalardan iborat chiziq chiziladi. Chiziq tekis 

emas ko’rinadi. 
 Hatched kichkina bo’lgan kesmalardan iborat chiziq chiziladi.. 
Eslatma:  Solid  stilini veb saytdan ko’rgan maqul bo’ladi 

 
Agarda shtrixlarni kistochka yordamida chizsangiz  kistochka o’lchami, 

ko’rinishi, rangi va tultirish grandienlarini berish mumkin. Kistochka yaratilgan 
rasmlar orasida yoki rasmning ajratilgan elementida ishlash imkoniyati bor. 

Kistochka zalivka sohali to’gri chiziqlarni chizadi. Kistochka uchun "Buyoq"  
oddiy rang, gradient yoki tayor fayldan (bitmaps) bo’lishi mumkin.  

Buyash ushun kistning  quchimcha optsyalarni:  



 90

Fill Color yardamida rang tnalash uchun  Color oynasi ochiladi.Agarda 
uzingizni rangni yaratmoqchi bo’lsangiz  palitradan foydalaning.  

Brush Size Kistni o’lchamini o’zgartiradi. Har xil kist turlarini olish uchun 
o’lchamlari va shakllarini o’zgartirib ko’rish kerak.  

Brush Shape (нижнее выпадающее окошко) Kist shaklini o’zgartiradi.  
Pressure Modifier Agarda sizda digitayzer bo’lsa, bu optsya yordamida 

bosimni o’zgartirich imkoniyatiga ega. Испольование карандаша и дигитайзера ni 
qarang  

Kist yordamida chizish  
Bu menucha kist shtrixlari chizishda qanday qullanishini ko’radi. Asosan  Paint 
Normal  foydalaniladi boshqa optsyalari esa boshqacha effektlar yoratadi.  

 
 
 
 
 
Paint Normal zalivkalar va chiziqlar ustidan chizadi 

Paint Fills zalivka ustidan chizadi fahat chiziqlar qoldiriladi  

Paint Behind (рисование между) rasm yoq tomonida chiziladi . 

Paint Selection rasmning belgilangan sohasi ustidan chizadi. 

 
Paint Inside zalivkani siz tegingan joylarini chizadi, chizizlar enini 
qoldirib ketadi.  

Zalivak qulfi  
Bu asbob yordamida o’lchamini ,zalivka burchagini, yoki gradientni “qulflaydi”. 
Keyinga davomi ettiriladigangradient yoki zalivkalar avvalgini davomi bulid 
hisoblanadi.  

 
Chiziqni shaklini o’zgartirish 
Flash hech qanaqa chiziq shaklni 

o’zgartiradigan richaglarga ega emas. Shu 
bilan birga, "стрелка" asbobidan 
foydalanish orqali chiziqni bulaklarini 
o’zgartirishga bo’ladi. Стрелка ko’rinishi 
siz chiziqga qanday o’zgartirish 
kiritmoqchi bo’lganingizga qaray , zalivka 
yoki kistochka mazkasi uzgaradi.  

Rasm kist yordamida chizilgandan 
keyin, sochni shakli uzgardi va yana bir 
shtrix qo’shildi.  
Chiziqni kesmasini shaklini o’zgartirish uchun.  
1  Asboblar panelidan "рисование" tanlaniladi. 
2  Shaklni o’zgartirish uchun : 

 Chiziqni hoqlagan nuqtasidan tushinchasi.  
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 Ctrl tugmasi bilan yangi burchak nuqtasini yaratish tuchunchasi 
Flash chiziqlarni uzunligini kattalashtirish va kichiklashtirish mumkin. 

Bu uchun oxirgi nuqtasidan ushlan kerakli tomonga surish kerak. Agarda 
oxirgi nuqta burchak nuqta bo’lsa  u hold, u utkir burchak bo’ladi, qaysi 
tomonga tortishingizga bogliq.  

 
Kistochka shtrixi shaklini o’zgartirish  

Zalivka shaklini o’zgartirganday shtrix shaklini ham o’zgartirish 
mumkin.  

Yaqinlashish shtrix shaklini o’zgartirishni osanlashtiradi. Ko’pgina shtrixlar 
ularni konturlari ko’ringan bo’lsa tez o’zgartiriladi. Bunig uchun  View > Outlines  
tanlaysiz.  

Shtrix shakli chiziqni shaklini ,zalivkani shaklini o’zgartirganga uxshaydi.  
Kistoshka shtrixi ko’rinishini o’zgartirish:  

1 Yonalishni tanlang va o’zgartirilishi kerak bo’lgan elementga sichqonchani 
yaqinlashtiring. 

 Agarda burchak kerak bo’lsa Ctrl bilan sichqonchani bosing va qiymatini kiriting 
2 Konturni o’chirish uchun lastikni tanlang.  

 
Kistochka shtrixi oddiy va kontur rejimlarida . 

 
Chiziqlarni to’grilash va silliqlsh 

Chiziqlarni ish paytida yoki keyinroq egrilarni tekislashigiz , silliqlasingiz 
mumkin. 

Eslatma : Avtomatik turda silliqlash va tekislashni bashqarishda File > 
Assistant foydalansa bo’ladi.  

Chiziqni, egrilarni tekislash ushun Tekislash belgisini tanlang  yoki   Modify > 
Curves > Straighten bajaring. Avval tekislanganlarga bu amal tasir qilmaydi.  

Flash hoqlagan geometrik obyektlarni doyra, oval, to’griturtburchak,kvadrat, 
uchburchak, va yarim doyralarni shakllarni chizadi. Shu bilan birga bu obyektlarni 
egrilarini tekislab geometrik 
ko’rinishiga ham olib keladi.  

  Egrilarni tekislash bir necha 
yonalishlarda olib boriladi. Tekislash 
egridagi kesmalarga ham bogliq 
bo’ladi. Shakldagi kichkina chiziqlarni 
tekislashda qul keladi.  

Tekislanishni bir necha marta takrorlash chiziqlarni avvalgisidan egrilarini 
tekisroq qiladi,bu egri chiziqning kesmalari qancha darajada egri yoki to’griligiga 
bogliq bo’ladi.  

Belgilangan zalivkani yoki ergi chiziqni silliq qilish uchun:  
Yonalishni tanlab сглаживания (silliqlash) ikonkasiga sichqoncha bilan 

chertiladi yoki Modify > Curves > Smooth yordamida amalga oshiriladi.  
Иконка сглаживания: 
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Belgilangan zalivkani yoki ergi chiziqni silliq qilish uchun tekislash:  
Yonalishni tanlab выпрямления (tekislash) ikonkasiga sichqoncha bilan 

chertiladi yoki Modify > Curves > Straighten yordamida amalga oshiriladi.  
Иконка выпрямления. 

 
Ergilikni tanishni uchirib qo’yish :  
Yonalishni tanlang выпрямления (tekislash) ikonkasiga sichqoncha bilan 

chertiladi yoki Modify > Curves > Straighten yordamida amalga oshiriladi  
 

Egrilarni optimizatsya qilish 
Egrilarni silliqlashning  yana bir turi ularni optimizatsya qilish bo’ladi. Bu 

optsya egridagi chiziqlar soniga bogliq bo’lgan turda chiziqlarni va zalivkalarni 
silliqlaydi. Egrilikni optimizatsya qilsh bilan birga flesh isxodniklarni va oxirgi rolik 
o’lchamini ham optimizatsya qiladi. Bu buyruqni bir necha marta ishlatish ga ham 
bo’ladi.  

Egrilarni optimizatsya qilish:  
1  Rasmni elementini tanlab Modify > Curves > Optimize bosing.  
2  Mulahot oynasidagi Optimize Curves da silliqlanish darajasi ko’rsatiladi 

 Natija tanlangan egrilarga bogliq bo’ladi. Optimizatsya egrilarni sonini 
kamaytiradi. 

3  Quchimcha optsyalarni ishga tushiring: 

 Use Multiple Passes ishga tushirilganda egri chiziq silliq bo’lganicha protsess 
qaytalanadi. Bu silliqlanishni qayta qayta bosgan bilan bora bor. 

 Show Totals Message  qo’shish optimizatsya qilish mumkin emasligi haqida 
signal berib  oynasi shiqariladi. 

Assistentni foydalanish 
File > Assistant buyrugi assistent oynasini ochadi. Bu oynadagi chiziqlarni 

aylanish qiymatini (smoothing), chiziqlarni,egrilarni tanish va magnitlash uchun 
optsyalar beriladi.  

Har bir optsyani uchirilish va ishga qo’shish mumkin. Optsyani uzingizga maqul 
bo’lganincha qilib sozlashingiz mimkin.Erkin foydalanish darajasini ishga tushiring. 
Erkin foydalanish darajasi monitorga bogliq bo’ladi (100% 200% 300%  v .h.). Rasm 
chizganda ish stolini yaqinlashishi ish samoradarligini oshiradi.  

Har bir optsya erkin foydalanishlarga ega.  
Snap to grid ("""пппрррииибббииитттььь"""   ккк   рррааазззмммеееттткккеее))) 

Chiziqga biriktiriladigan belgilar orasidagi masofani bildiradi. O’chirish optsyasi, 
yaqin bo’lish,  normal, berilgan masofada bo’lish va hamma vaqtda biriktirish (Off, 
Must be close, Normal, Can be Distant, Always Snap) uz ichiga oladi.  

Connect lines (сссоооссстттыыыкккооовввкккааа    лллиииннниииййй)  
Chiziqni oqiriga qancha borligi optyasi. Optsyaning turlari: o’chirish, yaqin bo’lish, 
normal, masofada bo’lishi kerak (Off, Must be Close, Normal, Can be Distant.)  

Bu optsylar vertikal va gorizontal chiziqlarni tanishni bildiradi: Flash chiziqni 
ideal vertikal va gorizontalga yaqinligini bildiradi.  
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Smooth curves (((сссггглллааажжжиииввваааннниииеее   кккрррииивввыыыххх))) 
Qalam bilan chizilgan chiziqni tekislanish darajasini bildiradi(qalam optsyasi 
Straighten or Smooth bo’lishi kerak) Optsyalari :Может быть выключено, 
закругленно, нормально и сглажено (Off, Rough, Normal, and Smooth.)  

Eslatma: Tayor ergi chiziqni silliqlashingiz mumkin uni uchun  Modify > Curves 
> Smooth and Modify > Curves > Optimize foydalaning.  

Recognize lines (((рррааассспппооозззннноооввваааннниииеее   лллиииннниииййй)))   
Tanishdan oldin qanday darajada tekis bo’lishini va ideal to’gri qilib chizishni 
berish.. Variantlari: выключено,точно, нормально и приблизительно( Off, Strict, 
Normal, Tolerant.)  

Agarda  распознование линий (((RRReeecccooogggnnniiizzzeee   llliiinnneeesss) is paytida uchirilgan bo’lsa  
tanishni Modify > Curves > Straighten yordamida amalga oshirasiz.  

Recognize shapes (((РРРааассспппооозззннноооввваааннниииеее   кккрррииивввыыыххх)))   
Ovalln, doyrani, kvadratni, to’griturburchakni,burchaklarni 90 yoki 180 
gradusli,qanday darajada to’gri chizilganligini nazorat qiladi. Оptsyalari: 
Отключено, точно, нормально и приблизительно (Off, Strict, Normal, Tolerant).  

Agarda egrilarni tanish ish paytida uchirilgan bo’lsa, Modify > Curves > 
Straighten yordamida bir yoki bir0nechta egrilarni tanlab amalga oshiasiz..  

Click accuracy (((тттооочччннныыыййй    щщщееелллчччоооккк)))  
Flash obyektni tanishdan avval obyektga ko’rsatgish qanchali yaqin kelishini 
bildiradi.Optsyalari: точно, нормально и прблизительно (Strict, Normal, Tolerant.)  

Grafik elementlarni ajratish 
Flash obyektlarni ajratish uchun bir-qancha asboblarga ega.  
".стрелка " asbobi  -ajratishning universal asbobi. "рисование" panelidan asbob 

tanlaniladi yoki  А- bosing. Bush joy tugmasi yordamida hoqlagan asbobni “ стрелка 
” utishimiz mumkin.  

Ko’pgina grafik dasturlardagiday uning elementlarini  ajratish uchun  "стрелка" 
asbobini cherting. Boshqa dasturlardan farhi ekkinchi obyektni ajratilgan larga bir 
marta sichqoncha bilan chertich bilan qo’shasiz. Bu amalni SHIFT tugmasini bosib 
turib chertich bilan bajariladigan qilib sozlash ham mumkin;(edit->preferences)  

Quyida ajratishni boshqa turlari berilgan.  
 

 Bir biriga yaqin bo’lgan rasmni elementlarini ajratish uchun "стрелка" asbob 
yordamida ekki marta sichqoncha bilan chertish kerak.  

 Kvadrat sohadagi elementlarni ajratish uchun, sichqoncha yordamida kvadradni 
chizish kerak. Belgilar,matnlar hammasi ajratilgan bo’lishi uchun chizilgan 
kvadrat ishida joylashgan bo’lishi kerak. 

 Hoqlagan shakldagi sahadagi narsalarni ajratish uchun "лассо" yordamida soha 
belrilanishi kerak. Soha "лассо" yordamida chizib bulingandan keyin “лассо” 
yonalishga aylanadi va ajratilgan sohani siljitish mumkin. 

 Bir vaqtni ishida bir nechta sohalarni ajratish uchun Shifttugmasini bosing  

 Hamma qatlamlarni ajratish uchun  Edit > Select All ni tanlang , yoki Control-A  
(Windows) yoki Command-A (Macintosh) bosing. 

 Ajratishni beror etish uchun  Edit > Deselect All tanlang , yoki  Control-Shift-A 
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(Windows) yoki Command-Shift-A (Macintosh) tugmalarini bosing. 

 Ajratilgan guruh obyektlarini yoki belgilarini uzgarmas holga keltirish uchun, 
Modify > Arrange > Lock tanlang. Qilfni oshish uchun Modify > Arrange > 
Unlock All tanlang  

Ajratilgan soha matnli  ko’rinishda  chiziqlari esa "qalinroq" va matn 
ko’kinishda, guruh obyektlari, belgilari, matnlari kvadrat bilan uralgan bo’ladi. 

 
Ajratilgan elementlar boshqa elementlarni uchirmaydi va 

bo’lmaydi. Agarda bita qatlomda joylashgan rasm elementlaridan 
obyektni  ajratishni beror etsangiz u holda, obyekt ustidagi element 
bilan yopilgan soha siljitiladi va pastki elementni bo’ladi. Rasmda 
ko’rsatilgan  

Grafik elementlarni siljitilishi 
Hamma elemenlarni bir vaqtda siljitish uchun "стрелка" asbobidan foydalanmiz. 

Avval bir marta sichqoncha yordamida chertilib obyektlarni chizigini ajratamiz. 
Agarda chizigi ajratilmagan bo’lsa u holda siljitilish urniga obyektni shakli uzgaradi 
va uni siljitalmysiz. Agarda bir-nechta obyektlar ajratilgan bo’lsa u holda kerak 
bo’lmagan obyektlarda ajratishni bekor qilib keraklisin qoldirib amalni bajarishingiz 
mumkin.  

Klaviaturani yunalish tugmalarini foydalanib obyektlarni 1 piksel masofaga 
siljitish mumkin.Agarda bu amallarni Shift tugmasi bilan birgalikda ishlatsangiz 8 
pikselga siljitailadi.  

Obyektni belgili joyga siljitish uchun inspektordan foydalaning. Inspektor 
oynasidan siljitilishi kerak joyni qiymati kiritiladi. (windows->inspector)  

Agarda ajratilgan zalivkani ekkinchi zalivka ustida siljitsangiz, va keyin 
ajratishni bekor qilsangiz,rasmni ustida joylashgan qismi kesilib tushadi. Bu oddiy 
rasm chizish dasturlariga uxshash bo’ladi. 

Zalivka ustidan chiziq chizyatganingizni tushinish uchun 
chiziq chizamiz va bizning kutganimizday chiziq zalivkani ekkiga 
bulib zalivka bilan qo’shilmaydi. Flashda ,chiziqlar zalivka bilan 
qo’shilgandan keyin belgili bitta nuqtada bulinadi, natijada chiziq 
uchta qismga bulinadi, bularni keltirilgan rasmda ko’rishimiz mumkin. Chiziq 
bulimlaridan bittasini boshqasiga bogliq bo’lmagan holda shaklini o’zgartirish, 
siljitish amallarini bajarish mumkin.  
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1.Zalivka  
2.zalivka ustiga chizilgan chiziq  
3.Ekkita ergi va uchta kesma chiziq bilan zalivkani qo’shish natijasida paydo bo’lgan.  

Biriktirish va bo’lish (connection and segmentation) dasturlardagi kesish va 
qo’yish ( join и cut) amallarida farqi yoq. Bir xil egrichiziqlar biriktirilganda 
qo’shilib ketadi. Har xil rangdagilari esa alohida bo’ladi. Bu imkoniyatlarini nahob 
yaratganda foydalansa bo’ladi, kesich natijasida boshqa obyektlarni olish uchun 
ishlatiladi. Masalan, qizail kvadraddagi bargni kesish natijasida oldik: Avval qizil 
rangli kvadrad yaratildi, keyin guruhlanmaganini barg 
rasmini olib qizil kvadradga qoyamiz. Keyin bargdan 
ajratishni bekor qilamiz va qora rangli bargni suramiz. 
Qizil kvadradda esa kesilgan barg urni qoladi.  

egrichiziqlarni guruhga qo’shish natijasida biriktirish 
va bo’lish (connection and segmentation)amallari 
bajarilmaydi.  

Zalivka artibutlarini va chiziqlarni nusqasini olish 
Chiziqlarni va zalivka atributlarini yani qalinligi,rangi,gradientilaridan nusqa 

olish uchun   siyoqdon,pipetkava zalivkali chelekdan foydalaniladi. Tayor elemendan 
atributlarini nusqasini oling va pipetka yordamida va zalivkali chelak va 
siyoqdonlardan foydalanib element ustiga tashlang.  

Chiqiqni yoki zalivkani atributlarini o’zgartirish uchun:  
1 Tayor elementni atributlarini nusqasini olish uchun, pipetkani tanlang va nusqa 

qoyiladigan chiziqga yaki zalivkaga sichqoncha bilan cherting...  

 
Pipetka yordamida chiziqga chertganigizda, asbob avtomat tarizda siyoqdonga 
uzgaradi.Zalivka sohasiga chertilganbo’lsa pipetka  chelakga uzgaradi. Olingan 
nusqa chiziqga yoki zalivkaga qoyilish uchun yana bir marta chertiladi.   

2 Rangni yaki qalinligini o’zgartirish uchun (nusqadan boshqa),asboblar panelidan 
menudan  Рисование tanlanadi 

3 Atributi berilishi kerak bo’lgan chiziqga yoki zalivkaga berish uchun bir marta 
chertiladi. 

Siyoqdon 
Siyoqdon chiziqni rangni , qalinliginiva stilini o’zgartiradi. Chiziq chizing va 

siyoqdon danboshqa rang,stil,va h. tanlanadi. Oxirida chizilgan chiziqga chertish 
kerak va u chiziq uzini atributlarini uzgartiadi. Agarda bir-nechta chiziqlarni belgilab 
ciyoqdonga sichqoncha bilan chertilsa u holda barcha chiziqlar atributlarini 
o’zgartiradi  

Eslatma: Pipetka asbobi chiziqni atributlarini o’zgartirishlarga qukay bo’ladi. 
Guruhlangan chiziqlarda siyoqdondan foydalanish mumkin emas.  

Zalivkali chelak  (zalivka) asbiobi 
Zalivka asbobi yopiq sohalarni ranglar yoki gradientlar bilan toldiradi. Avval 

tultirilishi kerak joyni ko’rsatib chertish kerak. Agarda bir-nechta zalivkalarni tanlab 
keyin bu asbobga chertsangiz (ranglarini o’zgartirib) hamma elementlar rangini 
o’zgartiradi. 

 Zalivkani tashqi ko’rinishini o’zgartirish uchun chelak uchun optsyalarni 
foydalanig.  
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Fill Color (((zzzaaallliiivvvkkkaaa   rrraaannngggiii)))    (Color)  menusini chaqiradi.Rang tanlanadi. Agarda 
uzigizni rangingizni yoramoqchi bo’lsangiz (Color Palette) palitrasini sichqoncha 
bilan chertasiz.  

Gap Size (((mmmaaasssooofffaaa   ooorrraaallliiiqqqiii))) Tultirilishi kerak bo’lgan soha chiziqlar orasidagi 
masofani ko’rsatadigan menu chiqariladi. Agarda avtomatik tarizda tultirish tanlansa  
close tanlaniladi Agarda boshqa rang bilan tultimoqchi bo’lsangiz  Don't Close Gaps 
ni tanlang.  

Примечание: ekkita chiziq orasidagi masofa katta bo’lsa ularni eqinlashtirish 
hesh qanday yordam bermaydi fahat qul yordamida boyashga to’gri keladi.  

 
 Lock Fill (((zzzaaallliiivvvkkkaaa   qqquuulllfffiii))) Joriy zalivkani o’lchami,burchagi va markazini qulflab 
qoyadi. Agarda zalivkaga pipetka olib kelinsa qulf chiqariladi. Yangi 
rang,gradient bermoqchi bo’lsangiz qulfni ochichga to’gri keladi. 

 Transform Fill (((zzzaaallliiivvvkkkaaannniii   ooo’’’zzzgggaaarrrtttiiirrriiissshhh))) zalivkani o’lchamini, burchagi va 
markazini boshqaradi. Bu optsya tanlanganda zalivkali chelak yonalishga 
oylanadi. Doyda chizing va gradient bilan toltiring. Bu optsyani tanlab gradient 
yonalishini va oyini o’zgartiring.Agarda gradient chegarsini ko’rinmasa  u holda 
View > Work Area tanlang. 

Asbob "pipetka" 
Pipetka tayor tasvirni rangi va stili haqida malimot oladi. Sizlar pipetka asbobi 

yordamida ishlaganingizda itibor bering u fahat rang va stilni nusqalaydi.Agarda 
zalivka sohasiga sichqoncha bilan chertsangiz pipetka atrofida muyqalam belgisi 
chiqadi agarda chziqni tanlagan bo’lsangiz qalam chiqadi. Qalam va zalivkali chelak 
asboblari pipetka sichqoncha bilan chertganda pipetka nusqalagan rangni va stilni 
beradi.  

Agarda siz  Shift bilan birga pipetkani sichqoncha bilan chertsangiz u pipetka 
nusqalagan rang bir vaqt uzida  qalamda ,zalivka chelegida va matn asboblarida 
paydo bo’ladi. 

Eslatma: Pipetka guruhlangan belgilardan nusqa ola almaydi agarda  modify -
>break apart amallarni bajarmasangiz.  

Лас Zalivka va chiziqni uchiradi. Zalivkaga quyidagi optsyalarni berishingiz 
mumkin:fahat chiziqni, fahat zalivkani , fahat ajratilgan zalivkani, fahat siz ucirib 
boshlagan zalivkani uchiradigan bo’ladi. Lastikga bechta o’lchamdan bittasini 
berishga yoki shaklini o’zgartirishga bo’ladi.  

Eslatma: Lastik fahat stsenadagi chiziqlarni zalivkalarni ushiradi.U obyektlar 
guruhi,belgilarni va matnlarni o’chirish imkoniyatiga ega emasAgarda gurun 
ishidagini o’chirish kerak bo’lsa  Edit > Edit Selected или Modify > Break Apart 
amallarni bajaring.  

Lastik menusi 
Menu optsyasida lastik qanday qilib o’chirishini ko’rsatadi. Lastik ooptsyasi 

muyqalam asbobiga uxshash bo’ladi.  
 Normal optsya – chiziqlarni va zalivkalarni uchiradi. 

 Erase Fills fahat zalivkani uchiradi.Agarda chiziqga teginib ketsa u uchmaydi. 

 Erase Lines fahat chiziqlar uchiriladi. Zalivkalarga teginsa hesh qanday 
uzgarishsiz qoladi. 
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 Erase Selected Fills ajratilgan zalivkalarni uchiradi va chiziqlarni ajratilgan va 
ajratilmaganidan qatiy nazar ular uchmaydi. 

 Erase Inside Siz boshlab uchirgan zalivka sohasi uchiriladi.( agarda bosh joy 
uchirilgan bo’lsa hech narsa uchmaydi) Chiziqlar uchirilmaydi. 

Suv krani  
Chiziq bulagini yoki sohalarni uchiradi. Avval lastikga cherting va keyin kranga. 

Agarda  siz chiziqga yoki zalivkaga chertsangiz hammasi yoqalib ketadi. 
 



 98

111333   OOObbbyyyeeekkktttlllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   
 Aylanishlar va teskari qilishlar 

Bir vaqt ichida bitta yoki bir-nechta elementlarni aylantirish yoki o’lchamlarini 
o’zgartirish imkoniyatiga egasiz.  

 
Teskari qilish(Flip)  
Ajratilgan elementni teskari qilish uchun:  
Modify > Transform > Flip Vertical yoki Flip Horizontal tanlang.  
Aylanish 
Ajratilgan elementni aylantirishni bir nechta usullari mavjud. Agarda erkin 

aylanishni tanlasangiz (asboblar panelidagi рисования tugmasi) o’lchamini, qyaligini 
tomonlaridagiad berilgan aylanalarni surish orqali amalga oshirasiz.  

Soat strelkasiga qorshi 90 gradusga burish.  
Modify > Transform > Rotate Left tanlang.  
Soat strelkasi boyivha  90 gradusga burish.  
Modify > Transform > Rotate Right tanlang.  
Berilgan gradus ostida burish  
Tanlang: Modify > Transform > Scale and Rotate, -360° dan 360°  gacha son 

qiymatini bering.  
Ajratilgan elementni erkin aylantirish :  
Quyidagi berilganlar bajariladi:  

 tanlang Modify > Transform > Rotate, va narsangizni ko’rsatilgan burchak 
boyicha aylantiring 

 "стрелка" asbobini tanlang va pastga aylangan ikonchaga cherting  
va narsani ko’rsatilgan burchakga buring.  

 
Ajratilgan elementni qyia  (skew)qilish:  
Quyidagi variantlarning biri tanlaniladi:  

 Tanlang Modify > Transform > Rotate va hoqlagan tomaolari urtasidan torting. 

 Yonalishni tanlang va  burish (((RRRoootttaaattteee)))   tugmasini bosing hoqlagan tomonlari 
markazidan tortimg.  

 
O’lchamini o’zgartirish (Scaling) 



 99 

Используйте изменение размера чтобы увеличить или уменьшить рисунок 
пропроционально или чтобы вытянуть его в ширину или высоту. Изменение 
размера происходит из центра выделенного элемента на указанный 
процент.Чтобы изменить точку от которой происходит изменение размера, 
измените расположение центральной точки (center point).  

Примечание: Вы также можете использовать инспектора чтобы указать 
точный размер объекта.  

Чтобы увеличить или уменьшить выделенный элемент на 
определенный процент:  

Выберите Modify > Transform > Scale and Rotate, и введите значение 
изменения размера (scale) между 10 и 1000.  

Чтобы уменьшить выделенный элемент:  
Выберите один из следующих вариантов:  

 Выберите Modify > Transform > Scale, и потяните за любой угол. 

 Выберите стрелку и затем выберите значок увеличения размера , и 
потяните за любой из углов по направлению к центру.  

 
Tanlanganelementni chozish:  

 Tanlang Modify > Transform > Scale va markazdan hoqlagan yonalshda torting 

 "стрелка" asbobini tanlang va  kattalashtirish (kichiklashtirish) belgisini bosing. 
Markazdan hoqlagan burchak ostiga torting 

 
Berilgan elementni o’lchamini o’zgartirsh paytida tesksri qilish:  
Urtacha belgidan pastga markaz tomon torting (rasmda berilgan).(chaoga, 

ungga yuqariga markaz tomon) 
Eslatma: Agarda siz o’lchamini kattalashtirgan bo’lsangiz yoki katta 

obyekt bilan ishlasangiz berilgan to’griturtburchakni tortiladiganlarini  
ko’rmasligingiz mumkin bu holda  View > Work Area foydalaning  

Obyektlarni tekislash 
Modify > Align ekkita yoki bir-nechta ajratilgan obyektlarni tekislaydi. Tekislah 

elementlar enini va boyini bir xil bo’lishi uchun o’lchamlarini o’zgartirishi mumkin. 
O’lchami eng katta elementga qaray tanlaniladi. Shu bilan birga obyektlarni ung 
tomonga, markazdan,chap tomonga,yuqari tomonga bir xil masofada qilib tekislaydi. 
Align to Page optsyasi bir-biriga va sstenaga nisbatan to’grilaydi.  

Bir nechta obyektlar tekislanganda , Flash ularni en tomonlari ,markazi nima 
yoqin bo’lsa ushga nisbatan qiladi. Sizni obyektlarni qanday tartibda kiritgani 
ahamyati yoq.  

 
объекты без выравнивания 
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Объекты выравнены по верхней точке  

Eng yaxshi varianlaridan biri obeklarni avval nusxasini olish kerak, va guruhga 
oling. Bu esa tekislagandan keyin muharrirlash va alohida qolishga yordam 
beradi.Agarda ajratilgan obyektlardan  bir-biri bilan biriktirilsa yoki bir-biriga yaqin 
bo’lsa natija kutganimizday bo’lmaydi.Bir-biri ustida joylashgan elementlar 
tekislashdanva o’lchamlarini uzgartgandan  keyin bulaklarga bulinadi. 

Obyektlarni tekislash uchun:  
1 Tekislanishi kerak obyektlar ajratiladi. 
2 Modify > Align tanlang. 
3 Mulahot oynasidan optsyani tanlab  OK tugmasini bosing 

.  

 
Kesib olish, yoqatish, nusqasini olish va obyektlarni qo’yish. 

Sizlar Flashda obyektlarni kesish (((cccuuuttt))) yoqatish   (((dddeeellleeettteee))), nusqasini olish (((cccooopppyyy))) 
va qo’yish   (((pppaaasssttteee))) amallarini bajarilish boshqa dasturlarga uxshahs bo’ladi.  

Buferda nusxalangan obyektlar, siliqlanadi(aaannntttiiiaaallliiiaaassseeeddd))), va boshqa dasturda ham 
Flashga uxshash bo’ladi.  

Obyektlarni kesilgani va nusqalari berilgan rolikni (((mmmooovvviiieee)))   yoki boshqa rolikni  
stsenalarga yoki qatlomlarga (((lllaaayyyeeerrrsss)))qoyilishi mumkin. Obyektlarni qo’yishni ekkita 
turi mavjud bittasi ko’rsatilgan joyga (((PPPaaasssttteee   iiinnn   PPPlllaaaccceee))), ekkinchisi  (((PPPaaasssttteee))), ishci 
maydoniga qoyiladi. 

Boshqa rolikdan (((mmmooovvviiieee)))   olingan grafika yoki  dasturlar joriy freymga (((fffrrraaammmeee)))   
joriy qatlomiga    (((lllaaayyyeeerrr)))   qoyiladi.Flashga grafik element qnday bulib qoyilishi uning 
tipiga,optsyasiga bogliq bo’ladi 

  
 Matn muharriridagi matn matnni obyekti hisobida qoyilqdi 

 Grafik dasturdagi vektor guruhi guruh tarizida qoyiladi,qaytatdan guruhdan ajratib 
muharrirlash mumkin. Flashda ham yoqaridagiga  uxshash bo’ladi. 

 Rasrl tasvirlar ham guruhlangan obyekt bulib qoyiladi.Qiyidagi amal yordamida 
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rastr tasvirdan vektorga utiladi Modify > Trace Bitmap . 
Eslatma: Flash 3 dagi FreeHand 8 dan grafikani nusqasini olish va qo’yishda 

FreeHand Export Preferences da CMYK va RGB  ga o’zgartiring.  
Ajratilgan elementni o’chirish:  

 Del yoki Backspace tugmalari bosiladi.

 Menudan Edit > Clear ni tanlang. 

 Menudan Edit > Cut ni tanlang. 
Ajratilgan fayldan nusqa olish:  

 Ctrl-tugmasini bosib obyektni bir oynadan ekkinchisiga olib utish kerak 

 Menudan Edit > Duplicate tanlang. 

 Menudan  Edit > Copy tanlang. 
Belgili joyga obyektni joylashtirish:  

1  (((CCCuuuttt))) yordamida obyektni kesib oling yoki (((cccooopppyyy))) obyektni nusqasini oling.  
2  Nusqalarni original obyekt bilan olmashtirmaslik uchun boshqa sloyga 

(((lllaaayyyeeerrr)))utamiz. 
3  Menudan  Edit > Paste in Place tanlang. 

 
Obyekt nusqalangan  joyga tushadi fahat bosqa sloyda bo’ladi. Bu obyektlarni 
joylashgan joylari bir xil fahat boshqa sloylarda va stsenalarda bo’lganlar bilan 
ishlashda qulay bo’ladi. 

  
Ishchi maydonining markaziga obyektlarni qo’yish:  

1 Obyektni (((CCCuuuttt)))   kkkeeesssiiibbb    oling yoki  (((cccooopppyyy)))nnnuuusssqqqaaasssiiinnniii    oling.
2 Menuda  Edit > Paste bajaring. 
 Obyekt ishchi maydoni markazida paydo bo’ladi 

Maxsus uerniga qo’yish buyrugi (Paste Special) 
Paste Special buyruq (Clipboard) dagi malumotlarni berilgan formatda qoyib 

beradi. Boshqa rolikdan malumotlarga murajaatni ham bajarish  mumkin.Paste 
Special mulohat oynasi quyidagi optsyalarni uz ichiga oladi:  

Source (((ииисссхххооодддннниииккк))) malumotlar manbayi nominiva ularni joylashgan joyoni 
ko’rsatadi.  

Paste   (((вввссстттааавввииитттььь)))   rasmga malumot olmashish buferidagilarni qoyadi  
Paste Link (((вввссстттааавввииитттььь   ссссссыыылллкккууу))) rasmga malumot olmashish buferidagilarni 

qoyadi va shu bilan birga berilgan malumot manbayiga murajjat qilishni yaratadi 
shuning natijasida malumotlar avtomatik tarizda yangilanib  turiladi.  

As   (((кккаааккк))) Qoyiladigan malumot tipini bildiradi.: Obyektni o’zgartirish uchun 
obyektni va malumotlarni  Object  yordamida qoyiladi. Obyektni nomi obyekt 
yaratilgan muharrirga bogliq bo’ladi. Flashda obyektni o’zgartirish uchun Modify > 
Break Apart ni bajaring.  

Flash yordamida rasmlarni muharrirlash uchun muharrirlagichga konvertirlash 
uchun (((PPPiiiccctttuuurrreee))) (((MMMeeetttaaafffiiillleee))) tanlash kerak. Formatlanmagan matnlarni qo’yish uchun 
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(((TTTeeexxxttt   ((()))AAASSSCCCIIIIII))) tanlang . Formatlangan matnni qo’yish TTTeeexxxttt   (((NNNaaatttiiivvveee)))   yordamida 
bajariladi. FLASHda rasmni bulagini qo’yish uchun  FFFlllaaassshhh   DDDrrraaawwwiiinnnggg  tanlang. 

Display As Icon   (((пппооокккааазззааатттььь   кккаааккк   ииикккооонннкккууу))) Rasmda murajaatni ikoncha shaklida 
ko’rsatadi.  

Result (((рррееезззуууллльььтттаааттт))) Tanlangan amalni natijasini ko’rastadi.  
Change Icon   (((ииизззмммееенннииитттььь   ииикккооонннкккууу))) Change Icon murajaat oynasini ko’rsatadi. 

Boshqa ikonchani tanlash uchun optsyani mulahot ko’rinishidagi oynadan 
foydalanig.Bu yerda optsya agarda  Display As qishilgan bo’lsa ishlaydi.  

 
111444...   RRRaaannnggglllaaarrr   bbbiiilllaaannn   iiissshhhlllaaassshhh   

Ranglarni yaratish va muharrirlash 
Rangni,tiniqlilik datajasini  o’zgartirish  uchun (((CCCooolllooorrrsss)))   oynasidan 

foydalanamiz. Joriy asbob uchun rang va gradient oynani pastki qismida ko’rsatilgan. 
Agarda Flashni birinchi marta ishlatyatgan bo’lsangiz, (((CCCooolllooorrr))) menuchasidagi ranglar 
jadvali berilgan rolikda ishlatish imkonyatiga ega.  

 
Flash rolik Colors da berilgan ranglardan ko’p bo’lishi mumkin.Rolikdagi 

ranglar sizning vediokartangizga (256, ming, yoki million) bogliq bo’ladi.  
Rangni  yaratish yoki uzgaritrish:  

1  Palitraga sichqoncha bilan chertiladi yoki menudanWindow > Color lar bajariladi. 
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2  Цельный (((SSSooollliiiddd   ))) ga chertilganda toq rangdagi ranglar palitradan chiqariladi. 
3  Siz o’zgartirmoqchi bo’lgan rangni tanlang 
4  Rangni quyidagi usul bilan o’zgartiring: 

 Rangga ochiq yoki toq bo’lishini taminlash uchun, rang oynasidan krestikni 
oralashtiring 

 Tiniqligini sozlash uchun tiniqlik richagidan foydalanig va tiniqliq bo’lmagan
qyimatini foyiz qisobida kiriting(100 bo’lsa – butunlay tiniq emas rang). Yarim
tiniq bo’lgan qizil rang quyidagicha ko’rinishda bo’ladi: 

 
 Sizlar qizil rang qiymatini- R, yoshil rang qiymatini- G, va  kuk rang qiymatini- B 
kerakli rangni olish uchun o’zgartirishingiz mumkin.  

5  Ranglarni o’zgartirishni tugatgandan keyin quyidagilarni bajaring: 

 Tanlangan rangni yangisi ga o’zgartirish uchun Change tugmasini bosing. 

 Palitraga yangi rang qoshish uchun New tugmasini bosing. (rang oynani pastki 
qismida chiqariladi) 

 Tanlangan rangni o’chirish uchun Delete tugmasini bosing. 

 Rolikni brauzerda chiqarish uchun  ranglarni 216 ga yaqin qilib tanlang. 
Gradientlarni yaratish va muharrirlash 

Gradientni yaratish va muharrirlash uchun (((CCCooolllooorrr))) rang oynasidan foydalanig. 
(((СССooolllooorrr)))   oynasidagi  Gradient joriy vaqtdagi ishlash mumkin bo’lgan grdientlarni 
ko’rsatadi.  
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Gradient bu ekkita yoki undan ko’p bo’lgan (16 gacha) ranglarning  bir-biriga 

utishi. Gradient    (((llliiinnneeeaaarrr))) chiziqli yoki (((rrraaadddiiiaaalll))) aylana shaklida bo’ladi. Gradientdagi 
rang bazibir darajada tiniq bo’ladi.  

Gradientni yaratish yoki muharrirlash:  
1 Palitradagi tugmaga sichqoncha bilan cherting yoki menudan Window > Colors 

bajaring. 
2 Gradientni sichqoncha yordamida cherting. 
3 Yangi gradient uchun asosini tanlang . 
4 "Тип градиента" oynasidan Radial yoki Linear dan bittasini tanlang. 
5 Rang ko’rsatgishin belgilang uni uzingiz hoqlaganday qilib o’zgartiring va uni 

rang uzgaradigan joyga siljiting. 

 

Rang ko’rsatgishi rang gradientga utadigan joyini ko’rsatadi. Yana bitta 
ko’rsatgish qo’shish uchun   "рычажок добавления градиента" foydalaning. 
Agarda ko’rsatgishni uchirmoqchi bo’lsangiz, va uni siljitib  "рычажкам 
добавления градиента (в крайний левый угол) ga joylashtiring 

 
6 Har bir rang tiniqligini ,ranglarni uzingiz hoqlaganday qilib tanlang.Buni  
Создание и редактирование цвета. Murajaatdan ko’rsa bo’ladi.  

 Gradientdagi har bir rang uzining tiniqligiga ega. 
7 Rangni quchimcha ko’rsatgishlari uchun rang va tiniqliqni tanlang. 
8 Joriy gradientni o’zgartirish uchun  Change tugmasini bosing. Yangi gradientni 

qo’shish uchun New ni bosing. Yangi qo’shilgan gradient ruyhatda eng oxiriga 
qo’shiladi. 

Tanlangan gradientni o’chirish uchun Delete tugmasini bosing.  
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"Qilflash" va zalivka va gradient shakllarini o’zgartirish 
Rastrli grafikadan har xil qiziqarli effektli yaratishda zalivkalar va gradientlar 

shaklini qilflash orqali amalga oshiriladi.  
Gradient yoki zalivka yopiq paytda, muyqalam bilan keuyingi zalivkani 

berganda u avvalgini dabomiday bulib davom etadi yani rasnga alohida 
kiritilmaydi.Yopiq gradient va zalivkalar zalivka maydonini pipetka yordamida 
nusqalagandan keyin kengaytirish uchun foydalaniladi.  

 
Yuqargi va pastki kvadratlar qilfni foydalanganda bir xil zalivka bilan tuldiriladi. 

 
Qulfni foydalanmaganda holda yuqargi va pastki kvadratlar tuldirilishi . 
  Tayor gradient yoki zalivkani tashqi ko’rinishini o’zgartirish uchu (((TTTrrraaannnsssfffooorrrmmm   

FFFiiillllll)))  zalikalarni transformmatsya qilishdan foydalaniladi. Birinchi marta gradient 
yoki zalivka berilganda rasm markaziga nisbatan markazlashtirikladi. Zalivkani 
transformatsya qilish natijasida zalivka markazini siljitish, ko’chrish, chozish 
mumkin.  

Rasmdan rangni yoqatish uchun (((RRReeemmmooovvveee   CCCooolllooorrrsss)))   dan foydalaning.  
Zalivka qulfini qanday qullaydi:  

1 Muyqalamni yoki zalivka chelagini tanlang, zalika hisobida gradientni yoki rastr 
grafikani tanlang. 

 Rastrli tasvirlarga zalivkani qullash uchun, rastrni ajratishda pipetkadan 
foydalaniladi. Keyin muyqalamni yoki zalivka chelagini tanlang. 

2 Qulfli ikonchga sichqoncha bilan cherting.  
 

3 Zalivka markazi bo’ladigan tuldirilishi kerak bo’lgan sohani quyib chqing. Boshqa 
sohalarni ham quyib chiqing. 

 Flash  zalivka yordamida tanlangan va quyishni bochlagan rasm joyini markazi deb 
hisoblab sohani tuldiradi. 

Gradient yoki zalivka shaklini o’zgartirish:  
1  Zalivka chelagini tanlang. 
2  Rangnitransformatsya qilish    (((TTTrrraaannnsssfffooorrrmmm   FFFiiillllll)))   ikonchsi sichqoncha bilan 

chertiladi...  
3  Zalivka yoki gradient quyilgan sohaga sichqoncha bilan chertiladi. 

 

Zalivkani yoki gradientni muharrirlash uchun ajratganda, zalivka markazi va en 
tomonlarida aylanalari bor kvadrat paydo bo’ladi, en tomondagi aylanalar 
yordamida shaklini o’zgartirsa bo’ladi .Kursor berilgan aylanalar birida joylashgan 
bo’lsa u uzgartitish mumkin bo’lgan funktsyaga bogliq uzgaradi.  

4  Zalivka yoki gradient shaklini quyidagicha o’zgartirish mumkin: 
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 Markaz nuqtasini o’zgartirish uchun uni  uzgarishi kerak bo’lgan  tomon surish 

kerak.  

 Zalivka enini o’zgartirish uchun en tomondagi yuqargi kvadratchadan 

foydalaning.  

 Kadratni balandligini o’zgartirish uchun  en tomonidagi pastki kvadratchadan 
foydalaning. 

  
 Gradientni yoki zalivkani aylantirish uchun, zalivka chegarasini bildiradigan to’gri
chiziqdagi dayrachni pastga yoki yuqariga aylantiring. Aylana shaklidagi 
gradientlarga ham shu amalni qullasa bo’ladi (kursor yarim aylana shaklli yonalish 
ko’rinishini oladi.).  

 
 Zalivkani o’lchamini o’zgartirich uchun urtadagi kvadratsha tortiladi.  

 
 Doyra shaklidagi zalivkani radiusini o’zgartirish uchun markazdagi doyracha 
tortiladi. 
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 Rasmni uchida qya qilish uchun, doyracha ko’rsatgichdan yuqariga yoki ong 
tonon torting.  

 
 Rastrni ko’paytirish uchun zalivkani kattalashtiring.  

 
Eslatma: Agarda katta rasmlar bilan ishlasangiz u holda ko’rsatgichlar 

ko’rinmay qolishi mumkin, ularni ko’rish uchun menuning  View > Work Area 
amallari bajariladi.  

Rasm elementidan rangni uchirich:  
1  Zalivkali guruhlanmagan elementlarni ajrating. 
2  Menuda  Modify > Transform > Remove Colors bajaring. 

 Flash zalivkani barcha ranglarini uchiradi. Qarq rang saqlanib qoladi boshqa 
ranglar oq rang bo’ladi.  

  
   

111555...   HHHaaarrraaakkkaaattt   
Motion tweening  

Tweening motion Asbobi Flash ning asosiy asboblaridan bittasi bulib 
hisoblanadi. Oddiy va samoradorli. Siz fahat birinchi kadrni(frame)  va oxirgi 
kadrni(frame)  yoratasiz (frame)  Flash bulardan annimatsya yoratadi. 

1 qadam. Belgini yorating (F8 yoki Insert -> create simbol). Uni harakat 
"motion"(движение) deb nomlang. 

2 qadam. Yuqariga yonalishini bosib stsenaga uting (yoqaridagi ong tomandagi 
"прокрутке" osmon kuk rangli yonalish, buni bosish orqali belgilarni yaratish 
oynasidan stsenaga utamiz.) F6 tugmasi yordamida kadrni boshlangich kalitini 
(keyframe) yorating. 

3 qadam. Kutuphonani (window ->library) oshing. Begini kutuphonadan kerakli 
freymga (kadr) o’tkazing (bu uchun akter(belgi) paydo bo’lganicha vertikal yolokcha 
– ko’rsatkish freymda turishi kerak , shu   paytgacha u kuk rangda bo’lgan doyrasha 
shaklida edi) 

 4-qadam  Yolakchani hoqlagan freymga o’tkazing(Bu sizni annimatsya qancha 
vqatga muljallanganligiga bogliq  10-15-20 va h.freymlardan) Annimatsya tugagan 
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joyda F6 tugmasi bosiladi ( siz akteringizni staenada boshlanishida qaysi joyida 
oxirida qaysi joyida turishini ko’rsatishingiz kerak). Siz ekkita kuk rangli doyrachaga 
ega buldingiz va akteringizni bochlangich va oxirgi turishlarini oldingiz. 

5 qadam . Freymni oxirgi kadriga yolakcha surgichni olib keling. Bilgini joyini 
o’zgartiring pastga ,yuqariga hoqlagan tomanga o’zgartiring.Uni aylantirishingiz  
(rotate) , kattalashtirishingiz (Scale) hatto qya qilishingiz mumkin( scale va 
rotate).Ko’rsatgish oxirgi kardda turganiga itibor bering.  

6 qadam. Ko’rsatkishingizni (rejjisor) freym birinchi kadriga olib keling. 
Doyrachaga ekki marta cherting (yoki sichqonchani ong tomoni bosilib  properties  
tanlaniladi). Sizni oldingizda birinchi kadrni oynasi chiqariladi. "Tweening" ni 
tanlang va menuchdan "Motion Tween" tanlang. Agarda sizni akter aylanishni 
hoqlasa "rotate"ni tanlang. Har qil qiymatlar bilan ishlab ko’ring. 

Tween Scaling –da sizni akter annitatsya vaqtida kattalashadi yoki kichiklashadi. 
Rotate clockwise soat strelkasi boyicha aylanadi (necha marta aylanishini 

oynadan ko’rsating)  
Rotate counterclockwise – soat strelkasi yonalishiga qarshi aylanadi.  
Orient to patch direct – Sizni bergan traektorya boyicha annimatsya bo’ladi. 

Buni keyingi misollarda ko’rib utamiz 
easing in – annitatsya boshida sekin oxirida , tez aylanadigan bo’ladi. 
easing out – avval tez keyin sekin  aylanadi. 

Menimcha sizlar kerakli qyimatlarni berib buldingiz va tajribasini o’tkazdingiz. OK 
tugmasini bosing. 

 Playni bosing 
Annimatsya boshlangich nuqtadan oxirgi nuqtasigacha bajarildi. 
Umumiy tuchuncha – moutsion tvinga – siz akterni (belgini) boshlangish va 

oxirgi nuqtalarini berasiz. Flash berilgan ekkita nuqta orasidagi annimatsyani uzi 
yaratadi.  

Shape tweening (morfing) 
Shape tweening juda kuchli elementlardan. Bu asbobdan to’gri foydalanishni 

ugranamiz. 
1 qadam. Yangi “spektakl”("спектакль"(movie)) yarating. File ->new yoki 

Ctrl+N yordamida  
2 qadam. To’gridan to’gri stseanaga obyektlarni soling ( bu amalni Movie clip 

yoki Graphics yaratib bulib belgilarni kutubhonadan movie ko’chrib qo’yishni 
unitmang) Hoqlagan narsangizni soling, morfing uchun quyidagi lar ham bo’ladi: 

• Flash asboblaridan hoqlagan narsani soling.  
• bmp, giff, jpeg  kengaytgichli fayllarni  import qiling. (agarda shuday 

qilmoqchi blsangiz Break apart - modify ->break apart yoki  ctrl +B bosishni 
unitmang) yoki  trace bitmap (modify->trace bitmap) bajaring. Bunday qilishi 
maslahat qilmagan bular edim sababi katta bulib ketadi. 

• Fleshni import qilingan belgilari.  
• Albatta Flashdagi matn  yoki shriftni foydalanig.  
3 qadam.Oxirgi kadrni yarating,u bosh bo’lishi kerak. (kursorni, masalan,  10( 

20, 30, 100) kadrlarga suring, sichqonchani ong tomoni bosiladi va   "insert blank 
keyframe" (bosh kadr qo’yish) bosiladi. Yoki  hoqlagan freymga sichqoncha bilan 
chertiladi  va F7 tugmasi bosiladi.Keyin (kursor oxirgi freymda turadi) boshqa rasmni 
yarating yoki gif, jpeg , bmp  faylaridan import qiling  (oxirida (trace bitmap)bajarish 
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esdan chiqmasin).Birinchi kadrda rasm bilan matnlarni birgalikda qo’yish ham 
imkoniyatlari mavjud. Fahat shuni esda tutish kerkaki birinchi va oxirgi kardlarda 
guruhlangan rasmlar, belgilar  bo’lmasligi kerak agarda guruhlangan belgilar bo’lsa 
Break apart ni bajaring.  

 4 qadam . Yana bir marta guruhlar ajratilganligini tekshiring – bu quyidagicha 
bajariladi. Rasmga sichqoncha bilan cherting –agarda  uning atrofida kvadrat paydo 
bo’lsa если  belgini uzi hech ajratilmasa – tezlik bilan  ctrl+b tugmalarini 
bosing. Agarda rasmlar birinchi va oxirgi kadrlarda “qara rangli” bulib 
ko’rinsa u holda hammasi joyida. 

5 qadam . Birinchi kadrga ekki marta sichqoncha bilan cherting (yoki 
sichqionchani ong tomoni – properties yordamida bajaring). 

6 qadam . Tweening ni tanlang. Menuchdan  "Shape tweening" 
bajaring.  

7 qadam . Distributive  optsyasi doyra shaklidagi rasmlarga qul keladi. Angular 
– ni esa burchaklari, egilishlari  ko’p bo’lgan rasmlar ushun qullaniladi. 

 Oxirida plaу (Ctrl-Enter) tugmasini bosing. 
 

111666...   BBBooossshhhqqqaaarrriiissshhh   eeellleeemmmeeennntttlllaaarrriii   
"Track as Menu" dan foydalanamiz (menyu sifatida) 

Track as menu (menyu singari tashish) sizga pastga tushuvchi menyuni yoki 
menyu osti menyuni yaratish imkonini beradi. 

  1-qadam. F8 ni bosib, belgi-tugmachani hosil qiling. Uni MENUBUTTON deb 
ataymiz. Mos ravishda unga “menyu” yozuvli tugmacha tasvirini chizamiz. 

 2-qadam. Yana F8 ni bosib, movie clipni yarating. Uni MENU deb ataymiz. 
3-qadam. Window->library ni tanlang. Movie clip ga bosing va pastga tushuvchi 

menyudan yuqori o’ng burchakdagi strelkaga bosib, Editni tanlang. Ikkita keyfreym 
qo’ying- birinchisiga “bo’sh” (empty), ikkinchisiga “to’la” (full) leybllarini beramiz 
(leyblni hosil qilish uchun sichqoncha chap tugmasini 2 marta freym doirasi ustiga 
bosing yoki sichqoncha o’ng tugmasidagi properties dan Label ni tanlang). Aynan 
Label, Comment emas, belgilanganligiga ishonch hosil qiling- ular orasida farq katta, 
sharxlar faqat shunchaki eslab qolish uchun ishlatiladi va boshqa xech qanday 
vazifani bajarmaydi. Leybllar esa, aksincha, juda katta ahamiyatga ega va Flashda 
dasturlash uchun zarur instrument hisoblanadi va usiz murakkab Tell Target 
komandasini bajarish umuman mumkin emas. 

4-qadam. Menyudagi asosiy tugmachani bosganingizda paydo bo’ladigan 
tugmachalarni yarating (tushuvchi tugmachalar –Forvard (oldinga), Back (orqaga) 
misolida). 

 5-qadam. movie clip ga qaytamiz. "empty" keyfreymini bo’shligicha qoldiring. 
Endi tshuvchi tugmachalarni (yani  Forvard va Back tugmachalarini) "to’la" (full) 
keyfreymiga joylaymiz. 

6-qadam. Har bir tugmachada (forvard - oldinga va back - orqaga) navbat bilan 
zakladka hossasini tanlang (properties)(buning uchun tugmachaga 2 marta bosing, 
Control zakladkasidagi Enable Button tanlovi uzib qo’yilganligiga ishonch hosil 
qiling) va definition bo’limida "Track as Menu Item" ni tanlang. Bo’ni har bir 
tugmacha uchun qilish kerakligini unutmang.  
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7-qadam. Endi asosiy saxnaga o’tamiz ( yuqoridagi ko’k strelkacha). 2 ta 

qatlam- insert- layerni qo’yamiz. Ularni ketma-ket nomlaymiz: eng yuqorisi - 
menubutton, o’rtanchasi- menyu ostilari, oxirgisi - Hit area. Menubutton qatlamiga 
menubutton tugmasining birinchi kadrini qo’ying. ‘Menyuosti’ o’rta qatlamining 
birinchi kadriga  movie clip ni qo’yamiz. movie clip ga ikki marta bosib, uning 
hossalarini tanlang (movie clip saxnasida kichkina aylanalar paydo bo’lsa, 
qo’rqmang- bu birinchi kadr bo’shligi tufayli) va  instance maydoniga "menu" nomini 
bering. 

   aaagggaaarrr   sssiiizzz   sssaaaxxxnnnaaadddaaa   ooo’’’zzziiinnngggiiizzznnniiinnnggg   kkkllliiipppiiinnngggiiizzznnniii   “““tttooopppaaa   ooolllmmmaaasssaaannngggiiizzz”””   ,,,    
“““mmmeeennnyyyuuuooossstttiii”””qqqaaatttlllaaammmiii   bbbeeelllgggiiisssiii   bbbooosssiiinnnggg,,,   hhhooosssiiilll   bbbooo’’’lllgggaaannn   tttuuussshhhuuuvvvccchhhiii   mmmeeennnyyyuuudddaaannn      llloooccckkk   ooottthhheeerrrnnniii   
tttaaannnlllaaannnggg...   YYYoookkkiii   ccctttrrrlll   tttuuugggmmmaaasssiiinnniii   bbbooosssgggaaannn   hhhooollldddaaa   “““mmmeeennnyyyuuuooossstttiii”””   
qqqaaatttlllaaammmiiidddaaannn   bbbooossshhhqqqaaa   bbbaaarrrccchhhaaa   qqqaaatttlllaaammmlllaaarrrgggaaa   bbbooosssiiinnnggg...   MMMaaayyydddooonnngggaaa   
sssiiiccchhhqqqooonnnccchhhaaa   ooo’’’nnnggg   tttuuugggmmmaaasssiiinnniii   bbbooosssiiinnnggg   vvvaaa   ssseeellleeecccttt   aaallllll   nnniii   tttaaannnlllaaannnggg...  

8-qadam. Menubutton qatlamini faollashtiring (unda 
qalam rasmi paydo bo’ladi).  Saxnadagi menubutton 
tugmachasiga ikki marta bosing. properties menyusidan 
action ni tanlang. "Tell Target" ni quyidagicha qo’shing: 

On (Release) 
Begin Tell Target [/menu] 
Goto and Stop [full] 
End Tell Target 
End On 

Bu menyu tugmachasini bosganda sizning menyu osti menyusini chiqarishga 
imkon beradi. Endi shunday qilish kerakki, siz sichqonchani olib ketganingizda, bu 
menyu osti menyusi yo’qolsin. 

9-qadam. F8 ni bosib yana yana bitta tugmacha (button) yarating. Uni Hit 
Area(bosish sohasi) deb atang. Edit ni bosing va 
katta rangli kvadrat chizib, faqatgina Hit sohasini 
to’ldiring.  

10-qadam. Saxnaga qayting (ko’k strelkacha 
%) va yana bitta qatlam (layer) qo’ying. Misolda 
qatlam "hit area" deb ataladi. Keyin unga sizning 
HIt Area tugmachasini qo’ying. Bu tugmachali 
qatlam (layer) boshqa qatlamlardan quyida bo’lishi 
kerak.  

11-qadam. Ko’rdingizmi-sizning tugma 
bosish sohangiz zangori rangga bo’yaldi. Bu shuni 
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bildiradiki, unda faqat bosil sohasi (hit area) bor holos. Hammasi yaxshi ishlashi 
uchun zangori rangni menyu ostini qoplamaydigan qilib, hamma yerga joylashtiring. 
Bu tugmachani bir necha marta joylashtirish mumkin, u holda har bir “zangori” 
tugmachalarga Tell target ni berishni unutmang. 

12-qadam. Zangori sohaning xossalariga (properties) bosing va Tell Targetning 
quyidagi komandalarini belgilang: 

On (Roll Over) 
Begin Tell Target [/menu] 
Goto and Stop [empty] 
end Tell Target 
End On 

Bu bilan siz shunga erishasizki, sichqonchani olishingiz bilan tushuvchi menyu 
yo’qoladi, chunki siz sichqonchani brauzerda ko’rinmaydigan shaffof zangori sohaga 
olayapsiz.  

Movie clips yana rivojlangan animatsiyalarni hosil qilish uchu yoki 
animatsiyalangan tugmachalarni yaratish uchun kerak. movie clips ni yaratish uchun 
quyidagi qadamlarni bosish kerak: 

1-qadam. F8 ni bosing va movie clipni tanlang. 
2-qadam. shape yoki motion tweening animatsiyasini yarating. 
Movie clips quyidagi hollarda ishlatilishi kerak: 
• Agar sizga animatsiya qilingan belgini animatsiya qilish kerak bo’lsa (misol – 

aylanuvchi velosiped g’ildiragi, uni velosiped chizilgan movie Clip ga qo’yamiz va 
velosipedni animatsiya qilamiz; masalan, u do’mchalar ustidan sakrab yuradi).  

• Agar sizga  Tell Targetdan foydalanish kerak bo’lsa.  
• Agar sizga qaytalanuvchi animatsiya (looping) yoki boshqa animatsiyadan 

mustaqil effektni yaratish kerak bo’lsa.  
Tell target – bu Flashdagi eng qudratli qurol Yana u Flashdagi oxirigacha 

o’rganib bo’lmaydigan qismdir. Bu komanda nima qiladi? U muviklip 
(movieclip)ning ichidagi ma’lumotni taymlaynlarga uzatadi. Bu sizga, masalan, 
butunlay boshqa-boshqa tumalarni bosib, o’nashingi va to’xtatishingiz mumkin 
bo’lgan  movie clip ni yaratish imkoniyatini beradi. 

Bu dars sizga sizning muvingizdan to’xtata oladigan, doimiy o’ynovchi 
musiqaviy lahza (loop)ni yaratishga imkon beradi. 

1-qadam. music deb nomlanuvchi movie clip yarating. Birinchi freymni bo’sh 
qoldiring va unga “blank” belgisini bering. Bir necha freym orqaga chekining va 
musik belgilik freym yarating. Freymga (10-misolda) musiqaviy fragment 
qo’ying.buning uchun ichki musiqaviy bibliotekadan (kursor 10-freymda turibdi, 
libraries -> sound ) yoki ixtiyoriy wav faylni oling (file ->import, keyin windows -
>library va yuqorida ko’rsatilgan usulda musiqani oling). Shuni nazarda tutingki, 
bibliotekadan ixtiyoriy simvolni olib kelish uchun yuqori oynachaga (belgi tasviri 
tushirilga) bosish kerak, simvollar va ularning nomlari ko’rsatilgan oynachaga emas. 
10 freymga “music” belgisi (label)ini qo’ying. 

 2-qadam. Keling saxnaga o’tamiz (o’ngdagi ko’k strelkacha). Layerni qo’ying 
(sichqoncha tugmachasini layerning o’ng tomonidagi maydonga bosing va insert-
>layer ni tanlang). Uni music layer deb ataymiz. Birinchi freymga 
bibliotekadan(windows-library) olib kelib, o’z movie clip ingizni tashlang. Agar siz 
hammasini to’g’ri bajargan bo’lsangiz, freym aylanasi to’lgan bo’ladi. Endi bevosita 
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saxnadagi movie clip ga bosing. Sichqonchaning o’ng tugmasi bilan properties ni 
tanlang va definition oynachasiga "Instance name слово music” deb yozing. 

 3-qadam.   Musiqani yoqish va o’chirish uchun 2 ta tugmacha yarating va 
ularni mos joylarga qo’ying (saxnaga, albatta). Misolda ular button nomli layerga 
joylangan. 

 4-qadam. Musoqani yoqadigan tugmachaga bosing (misolda on tugmachasi), 
movie clip bilan bajarganingiz singari, xossalarni (properties) tanlang. Unga instance 
name ni berayotgan vaqtda Action ni tanlang. Keling tugmachaga maqsadni (Tell 
Target) berishni boshlaymiz: 

On(Release) 
Begin Tell Target [/music] 
Goto and Play [music] 
End Tell Target 
End on 

Endi tugmachalar sizning misiqaviy movie clip ingizga music belgisi (label) 
qo’ulgan joyga borish va o’ynash kerakligini aytadi. Bu orqali siz “on” tugmasini 
bosilganda, musiqa o’ynashiga erishdingiz. So’zma-so’z aytganda siz movie clipga 
quyidagini aytdingiz: “sichqonchani bosilishiga bu movie clipga bor va music 
belgisiga o’yna”. 

5-rasm. Oldingi narsalarning barchasini o’chirish (off) tugmasi uchun ham 
takrorlaymiz. Faqat boshqacha qiymatlar yozamiz: 

On(Release) 
Begin Tell Target [/music] 
Goto and Stop [blank] 
End Tell Target 
End on 

O’chirish tugmachasini (off) bosganda tugmacha sizning aniq bir klipngizga 
“borish va “blank” belgisida to’xtash” kerakligini aytadi.  

Rolikni yuklash (Load movie) bu juda foydali komanda, u birinchi rolikning 
ichida ikkinchi rolik (movie)ni yuklash imkonini beradi. Ayniqsa bu siz musiqani o’z 
saytingizda foydalamoqchi bo’lganingizda qo’l keladi – musiqani alohida rolikka 
(movie) joylaysiz va uni birinchi rolikdan turib yuklaysiz yoki to’xtasasiz. 

Keling aloxida musiqaviy flash rolikni qanday yaratishni misolda ko’raylik. 
1-qadam. Doimiy o’ynovchi (looping) musiqagina bo’lgan rolikni (movie) 

yarating. Uni music.swf nomi bilan saqlang. 
2-qadam. Asosiy rolikni oching. Aytaylik, siz musiqa boshidan boshlab 

o’ynashini hoxlaysiz. Kursorni asosiy rolikdagi ixtiyoriy freymga (bizning misolda bi 
1-freym) qo’ying va birinchi kalit-kadrga (keyframe) “Load Movie”komandasini 
bering (freymga ikki marta bosing yoki  freymga o’ng tugmani bosing va Action 
Load xossasini tanlang). 

 3-qadam.  "Load Movie" maydoniga siz yuklamoqchi bo’lgan fayl nomini 
kiriting. Aytaylik u "music.swf" bo’lsin. Quyida darajalar oynachasi "Level" 
joylashgan va biz unga 1 qiymatini beramiz. Agar siz bir nechta roliklarni 
yuklamoqchi bo’lsangiz, ularga ketma-ket qiymatlar qo’ying. Bunda siz kiritgan son 
xech qabday rol o’ynamaydi (yani siz birinchisiga 1, ikkinchisiga 1000000 
berishingiz mumkin). Biz faqat bitta rolikni yuklashimiz kerak. Shunday qilib keeling 
qiymatni qoldiramiz =1. 
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 4-qadam. Endi siz asosiy rolikka kirishingiz bilan musiqa o’ynay boshlaydi. 
Hoxlasangiz ikkita tugmacha yaratishingiz mumkin.  Birinchi tugmachani bosish 
level1 qiymatli music.swf roligini yuklaydi. Ikkinchi tugmacha 1 qiymatli sizning 
musiqaviy roligingizni yuklaydi. Bu musiqani yuklash/o’chirishning yana bitta usuli. 
Xuddi shu yo’l bilan bir nechta musiqaviy roliklarni yuklashingiz va o’chirishingiz 
mumkin. Masalan, 1-tugmachani bossangiz, movie.swf fayli yuklanadi, 2-sida 
movie.swf to’xtatiladi va movie2.swf fayi yuklanadi. Flash interaktivlikni skriptlar 
ishi orqali yoki ma’lum bir holatda roliklar qilish kerakligini aytuvchi instruktsiyalar 
orqali ulaydi.  

 Script nima. 
Aktsiyalar skripti (aaaccctttiiiooonnn   ssscccrrriiipppttt) aktsiyalarni e’lon qiluvchi individual ketma-

ketlik orqali qilinadi. 
Aktsiyalarni e’lon qilish (AAAccctttiiiooonnn   ssstttaaattteeemmmeeennntttsss) gap bilan bir xil: rolikka 

instruktsiya va ma’lumotni yetkazuvchi so’zlar kombinatsiyasi. Boshqa istalgan 
tildagi kabi aktsiyalarni e’lon qilish bu e’lonni hosil qilishda bir qancha tushuncha va 
qoidalardan foydalanadi (yani insondan nimanidir so’rash uchun unga “ILTIMOS,…, 
…ni qil” deyish kerak. Mana shu ILTIMOS so’zi iltimosni bildiruvchi so’z. 
Aktsiyalar e’loni bilan ham shunday. ). Flash e’lonlarni tartib bo’yicha, birinchi 
e’londan boshlab qo’ya boshlaydi. Sizning ishingiz bu e’lonlarni tartib bo’yicha 
joylashtirish va parametrlarni to’g’ri ko’rsatish. 

Ko’p aktsiyalar faqat bitta instruktsiyaga, masalan, rolikni o’ynash 
instruktsiyasiga ega bo’ladi. Shunga qaramay aktsiyalar bir nechta e’lonlarni  
birlashtirish, ko’rsatilgan holat qachon ro’y berishini tekshirish va shundan keyingina 
aktsiyani bajarish mumkin (yani rolik 10 freym o’tmaguncha xech nima ro’y 
bermaydi. 10 freym o’tishi bilan qaysidir ko’rsatgich bo’yicha o’tish komandasi 
beriladi (get URL)). 

Siz qiymatlarni saqlash va yangilash uchun o’zgaruvchilar (vvvaaarrriiiaaabbbllleeesss) dan 
foydalanishingiz mumkin. Bo’langan nom sifatida variantlar rolik o’ynayotgan 
vaqtda o’zgarishi mumkin bo’lgan qiymatlarga ega bo’ladi. 

O’zgaruvchilar (VVVaaarrriiiaaabbbllleeesss) sonli hamda harfli ketma-ketlikka (sssrrriiinnngggsss) ega 
bo’lishi mumkin. Ma’lumotlarning eng keng tarqalgan tiplari bu URL, foydalanuvchi 
tomonidan kiritiladigan matn, matematik operatsiyalar natijalari, sichqoncha 
tugmachasini bosganda u yoki bu hodisaning necha marta bo’lishi.  

Skript aktsiyalarining biriktirilishi. 
Siz aktsiyani tugmachaga yoki freymga tugmachaning Action belgisiga aktsiyani 

ko’rsatib yoki freymlar (kadrlar) ning Properties dialog oynasi orqali biriktirib 
qo’yishingiz mumkin. 

Agar siz aktsiyani tugmachaga bog’lagan bo’lsangiz, foydalanuvchi tugmachani 
bosgandan yoki sichqoncha bilan o’tgandan keyin aktsiya bajariladi. Hodisa sizning 
roligingiz ko’rsatilgan joyga kelganda ro’y berishi uchun aktsiyani kadrga (frame) 
biriktiring. Kadrlar aktsiyasi (FFFrrraaammmeee   aaaccctttiiiooonnnsss) pauzalar hosil qilish yoki birinchi rolik 
tomonidan ikkinchi rolikni yuklash (llloooaaaddd   mmmooovvviiieee) uchun juda foydali.  

Aktsiyalarni ulash. 
“Aktsiyalar” ( Actions) panelidan tegishli aktsiyani tanlab, ulashingiz mumkin. 

Agar sizning aktsiyangiz ulashingiz mumkin bo’lgan qo’shimcha parametrlarga ega 
bo’lsa, parametrlar (((PPPaaarrraaammmeeettteeerrrsss))) paneli va bu parametrlarning o’zi yozib 
qo’yiladigan maydondan foydalaning. Parametrlarga bo’liq ravishda qiymatlar 



 114

raqamli bo’lishi mumkin yoki harflar ketma-ketligi (co’zlar, iboralar va hokazo) 
bo’lishi mumkin. Ko’pgina hollarda siz raqam yoki shartlar o’rniga ifodalarni 
(((eeexxxppprrreeessssssiiiooonnn))) ishlatishingiz mumkin. 

To’laroq interaktivlikni yaratish uchun boshqa belgilar aktsiyalari va kadrlar 
aktsiyalaridan foydalaning. Masalan, animatsiyalangan tugmachani yaratish uchun 
tugmacha (button)ning ichiga klip (movie clip) joylashtiring.  

 
111777...   RRRooollliiikkknnniii   nnnaaammmoooyyyiiissshhh   qqqiiillliiissshhh   

Siz flash rolikni tugatdingiz. Endi siz uni Webda e’lon qilishga tayyorlanishingiz 
kerak. Macromedia buni sizga oson bo’lishi uchun Aftershockni yaratdi. U kerakli 
HTML va  Javascript kodlarni va sizning roligingiz internetda ko’rinadigan bo’lishi 
uchun zarur boshqa hammani yozadi. 

 Aftershockni qaerdan olish mumkin: Aftershock Macromedia Flash 3 birga 
taklif qilinadi. 

.swf fayllarini Web uchun tayyorlash: Aftershock ni oching. Quyidagi 
tugmachani bosing: 

 
Faylingizga bo’lgan yo’lni ko’rsating, kerakli qiymatlarni kiriting (biz buni 

quyiroqda ko’ramiz) va save ni bosing. 
Tayyor rolikni Aftershockda tahrir qilish: Quyidagi tugmachani bosing va 

oldinroq Aftershock bilan yaratilgan HTML faylni tanlang (Biz buni qilishni tavsiya 
qilmaymiz, yana HTMLni yaratgan yaxshiroq, chunki Aftershock komandalarni 
ikkilantirish xususiyatiga ega va buni orqasidan Web ni ko’rishda muammolar 
chiqishi mumkin): 

 
Keling, Aftershock dagi barcha belgilashlarni ko’rib chiqamiz:Scripting, Page 

Layout, Shockwave, Alternate Image, va Java. 
Scripting: scripting ko’rsatgichi qanday doirada va qanday holatlarda rolik 

ko’rinib turishini ko’rsatadi. Sxemani (Scheme) tanlang. Izox: Java faqat Flash 2 
roliklari uchun ishlaydi. Odatda quyidagi parametrlardan foydalaniladi: 

  
Nu parametrlar siz Flash3 ni JavaScript bilan “boshqa oynada ochish”ga o’xshab 

foydalanayotgan bo’lsangiz ham o’rinli. Boshqa holatlarda oshkora ko’rsatilmagan 
parametrlar ishlatiladi. 

Sahifa rejasi (Page Layout): U sizning roligingiz brauzerlarda qanday 
ko’rinishini belgilaydi. Agar sizga rolik o’lchamini Flashda ko’rsatganingizga 
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qaraganda orttirish kerak bo’lsa, uni shu yerda bajarishingiz mumkin. Sizga to’la 
ekranli rolik kerak bo’lsa, 100% ni ko’rsating. Yana “To’la ekranli roliklarni 
yaratish” ni ham qarang. Tenglashtirish (Alignment) sizning roligingizni qaysi qismi 
ko’rsatilishini ko’rsatadi.Agar siz Flashda ko’rsatilgan o’lchamdan farqli o’lchamni 
ko’rsatgan bo’lsangiz, brauzer rolik o’lchamini shunday o’zgartiradiki, rolikning 
ko’rinishi kerak bo’lmagan ayrim qismlari ko’rina boshlaydi yoki ayrim qismlari 
qirqib olinadi. (Masalan, agar siz fon sifatida rolik o’lchamidan katta to’rtburchak  
chizgan bo’lsangiz, uning qirralari ko’rina boshlaydi. Yana agar siz ko’rinmaydiga 
sohadan boshlanadigan motion qilgan bo’lsangiz, u ham ko’rina boshlaydi). Align da 
foydalanib,siz roligingizni brauzerning biror bir tomoniga tenglashtira olasiz. URL 
lar ro’yxati va List Text qidiruv tizimlarida qayd qilingan bo’lishi kerak. 

 Shockwave: bu yerda siz sizning rolikingiz brauzerda o’zini qanday tutishini 
ko’rsatasiz.siz bu yerda sizning roligingizni bekgraundini boshqa qiymatlarni hex da 
yozib, o’zgartirishingiz mumkin! 

Playback qismi sizning roligingiz birinchi yuklashdan keyin pauza qilishini va 
sizning roligingiz doimo o’nashini (loop) hozlaysizmi yo’qmi, shuni ko’rsatasiz.  
Belgilangan “display menu” tanlovida foydalanuvchida sichqoncha o’ng tugmasi 
bosilishi bilan rolikda yaqinlashtirish, uzoqlashtirish, qayta o’ynash va h.(zoom, 
rewind) imkoniyatlarini ko’rsatuvchi menyu paydo bo’ladi. Bu tanlov 
belgilanmaganda esa foydalanuvchi faqat "About Shockwave Flash" ni ko’radi. 
Device font foydalanuvchi tizimining shriftalridan foydalanuvchi (bu tanlov nima 
uchun kerakligi unchalik tushunarli emas, chunki Flash rolikda shriftlar har qanday 
holda ham to’g’ri tasvirlanadi) juda qiziqarli tanlovdir. Quality- bu tanlov kerak, agar 
siz roligingiz silliq (smoothed) bo’lishingizni istasangiz. Auto-High rolik tezligini 
aloqa tezligiga moslash imkoniyatini beradi. Yuqori tezlikli aloqalarda rolik juda 
ajoyib ko’rinadi, tezlik pasaysa, tasvir sifati aloqa tezligiga proportsional ravishda 
yomonlashadi. Agar sizning roligingiz kichik bo’lsa, High qualitydan foydaangan 
ma’qul. Window mode da uchta tanlov bor. Odatda “window” qiymatidan 
foydalaniladi. “Opague” DHTML uchun yaxshi. Transparent (shaffof) bekgraundni 
shaffof qiladi va rolikdan turib HTMLda nima yozilganligini o’qish mumkin. Shuni 
ta’kidlash kerakki Transparent tanlovi faqat Internet Explorer 4 yoki undan yuqori 
versiyalarida ishlaydi. Scale sizga rolikning boshqa o’lchamini berish imkonini 
beradi. Exact fit (aniq to’ldirish) rolikni o’zgartirmaydi. No border rolikda bor 
bo’lgan Flashning qirralarini olib tashlaydi. Yani ayrim hollarda foydalanuvchilar 
sizning roligingizni ishchi sohasini ko’radilar (bu umuman olganda yaxshi emas). 
Default bu No border ga o’xshash, lekin ishchi soxani ko’rsatmaydi. 

Alternate Image: Agar siz animatsion yoki static gifni yaratmoqchi bo’lsangiz, 
uni shu yerda qiishingiz mumkin. Bu rasm Shockwave plaginasi bo’lmagan 
foydalanuvchilarda ko’rsatiladi. 

 Java: agar sizning roligingiz Flash 2 da qilingan bo’lsa va siz Flash Java 
Playerdan foydalanmoqchi bo’lsangiz, siz uni sozlash(настройки) da ko’rsatishingiz 
mumkin. Yana sizning roligingiz Java Playerni qaerdan olishini ham ko’rsatishingiz 
mumkin. Qoidaga ko’ra bu tanlovdan oshkora ko’rsatilmagan holda foydalanishadi. 
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III Bulim:  Adobe PhotoShop grafika va fotomontaj         
muxarriri. 

18. Adobe Photoshop dastur xakida umumiy malumot. 

     Kompyuter grafikasi 2 xil buladi: vektorli va rastrli (nuxtali). Vektorli 
grafika muxarrirlariga misol kilib Adobe Illustrator, Corel Draw va 
Macromediya Flash dasturlarni aytish mumkin. Ushbu dasturlarda rasmlar 
xar xil chiziklar va kiyshik vektorlardan iborat buladi.  

     Vektorli grafikada yaratilgan rasmlar logotip, illyustratsiyalar va 
zastavkalar yaratishda foydalaniladi. Rastrli grafika muxarrirlariga misol kilib 
Adobe Photoshop va Paint dasturlarni aytish mumkin. Ushbu dastrularda 
rasmlar mayda kvadrat - piksellardan iborat bulib mozaika xolatida rasmni 
xosil kiladi. Rastrli grafikadan rakamli fotosuratlar va skanerdon olingan 
rasmlar bilan ishlash uchun foydalaniladi. Kompyuter grafikada dyuymdagi 
piksellar soni (ppi) asosiy shart buladi. Kancha kuprok piksellar soni bulsa 
shuncha tasvir sifatlirok buladi. Masalan agar ppi=72 bulsa u xolda 1 kvadrat 
dyuymga 5184 piskel joylashadi va uning xajmi 6 Kb buladi, agar esa 
ppi=144 bulsa u xolda 1 kvadrat dyuymga 20736 piskel joylashadi va endi 
uning xajmi 21 Kb ga teng buladi. Shu bilan birga monitorning kursatish va 
printerning chikarish sifati - dyuymga piskellar soni (dpi) (72 ёki 96 dpi) va 
dyuymga chiziklar soni (Ipi) (300-2400 dpi lazerli, sepuvchi printerlar uchun 
va 75-200 lpi matritsali printerlar uchun), xamda kompyuter ranglar sifati (2, 
16, 256, 32 000, 16 000 000 ranglar soni) xam katta axamiyatga ega buladi. 
Rang xolatlari - ranglarni chikarish va kursatish yuli. Rang xolatlari 2 xil 
buladi: RGB (kizil, zangor, kuk) monitorlarda tasvik kursatishda 
foydalaniladi, CMYK (xavorang, purpur, sarik, kora) bosmada 
foydalaniladi. RGB xolatidagi ranglar soni CMYK xolatga karaganda kuprok. 

     Adobe PhotoShop dasturni ishga tushirish uchun Windows ning asosiy 
menyu tugmasini bosamiz, uning ichidan Programmı bulimini tanlaymiz va 
Adobe nomli guruxdan Adobe PhotoShop nomli buyrukni tanlaymiz. Natijada 
kuyidagi oyna xosil kilinadi: 

   Ushbu oynaning yukorisida menyu satri joylashgan. U kuyidagi kismlardan 
iborat: Fayl (File), Pravka (Edit), Risunok (Image), Sloy (Layer), 
Vıdelenie (Select), Filtr (Filter), Vid (View), Okno (Window) va 
Pomosh (Help). 

 

   Uning tagida ish kurollarning xususiyatlari soxasi (Panel Svoystv - 
Options bar) joylashgan. Agar ushbu soxa ekranda yuk bulsa uni Okno 
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(Window) menyusidagi Svoystva (Options) buyrugi ёrdamida ekranga 
chikarishimiz mumkin. 

 

   Xususiyatlar soxasi pastida ish soxasi joylashgan bulib, uning chap 
tomonida ish kurollar soxasini (panel İnstrumentov - Toolbox) kurishimiz 
mumkin. İsh soxasining ung tomonida xar xil ёrdamchi soxalar joylanishi 
mumkin: Sloi - Layers, İstoriya - History, Kanalı - Channel, Tsveta - 
Color, Stili - Style, Svoystva kisti - Brushes, Svoystva shrifta - 
Character va xokazo. Ushbu soxalarni xam Okno(Window) menyusidagi 
buyruklari ёrdamida ekranga chikarishimiz va ekrandan olib tashlashimiz 
mumkin. 

 

   Ёrdamchi soxalarni kichkinashtirishimiz xam mumkin. Buning uchun 
soxaning yukorisidagi kichkinalashtirish (svernut) tugmasidan foydalanamiz. 
Ёrdamchi soxalarda bizga eng kerakli bu ish kurollar soxasi (panel 
İnstrumentov -Toolbox) va katlamlar soxasi (Sloi- Layers). Yangi 
PhotoShop faylini yaratish ёki eski faylni kayta ochish uchun menyu 
Fayldagi Sozdat va Otkrıt buyruglaridan foydalanamiz. Fayl yaratganimizda 
ekranda kuyidagi oyna xosil kilinadi 

 

   Bu oynada uning nomini Name, turini Preset, enini Width, buyini 
Height, sifatini Resolution, ranglar xolatini, orka rangini tanlashimiz kerak 
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buladi. Xammasini tanlagach OK tugmasini bosamiz va natijada ekranda 
yangi bush ish soxa xosil kilinadi. 

19. Adobe Photoshop dasturning ish kurollari. Soxa tanlash. 

  

Dasturda ishlash uchun ёrdamchi ish kurollar soxasidagi tugmalar bilan tanishalik. U 
ekranning chap tomonida joylashadi. Agar u ekranda yuk bulsa u xolda Windows 
(Okna) menyusidagi Panel İnstrumentov - Toolbox buyrukni ishga 
tushirishimiz kerak.  

 

   Turtburchak soxa tanlash - Rectangular marquee (pryamougolnaya 
oblast) - [M] - ish soxasidagi aktiv katlamda turtburchak soxani tanlash. 

   Aylana soxa tanlash - Elliptical marquee (ellipticheskaya oblast) - [M] - 
ish soxasidagi aktiv katlamda ellips soxani tanlash. 

   Aloxida satr soxa tanlash - Single row marquee (stroka pikseley) - [M] - 
ish soxasidagi aktiv katlamda bitta satrga teng soxani tanlash. 

   Aloxida ustun soxa tanlash - Single column marquee (stolbets pikseley) - 
[M] - ish soxasidagi aktiv katlamda bitta ustunga teng soxani tanlash. 

     Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib 
turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan 
foydalanib soxa tanlasak, u xolda tanlangan soxadan olib tashlash manosini 
bildiradi. 

     Xususiyatlar satrida kuyidagilar aktiv buladi:  

• SHIFT va ALT - tugmalar xarakatlariga uxshash xolatlarni tanlash  
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• Feather - soxasi ёrdamida tanlangan soxa chegaralarini kalinligi.  
• Style - soxasi ёrdamida tanlash xolatini tanlaymiz. Normal - 

cheksiz soxa, Constrained Aspect Ratio - ёnlari kursatilgan 
proportsiyalardagi soxa tanlash, Fixed size - ёnlari kursatilgan 
kattaligidagi soxa tanlash.  

   Lasso - Lasso (Lasso) - [L] - ixtiёriy soxani tanlash. Agar tanlaganimizda 
ALT tugmasini bosib tursak, u xolda bizning lasso kupburchak lassoga uxshab 
soxa tanlaydi va ALT tumasini bosganimizda tanlangan soxa berkiladi. 

   Kupburchak lasso - Polygonal lasso (Mnogougolnoe lasso) - [L] - 
kupburchak soxani tanlash. Tanlangan soxani berkitish uchun ёki sichkoncha 
bilan ikkitali bosish kerak, ёki CTRL tugmasini bosi kuyvorishimiz kerak buladi. 

   Magnit lasso - Magnetic lasso (Magnitnoe lasso) - [L] - uxshash ranglar 
buyicha soxa tanlash. Kompyuter tanlagan nuxtani bekor kilish uchun 
Backspace tugmasini bosish kerak. 

     Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib 
turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan 
foydalanib soxa tanlasak, u xoldatanlangan soxadan olib tashlash manosini 
bildiradi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

• SHIFT va ALT tugmalar xarakatlariga uxshash xolatlarni tanlash  
• Feather soxasi ёrdamida tanlangan soxa chegaralarini kalinligi  
• Anti-Aliased optsiyasi tanlangan soxaning chegaralar rangini 

kuzga kurinmas kilib bir biriga moslash  
• Width - tanlangan soxaning chegaralar kalinligini uzgartirish  
• Edge Contrast - magnit lassoning sezguvchanligini uzgartirish  
• Frequency - magnit lassoning avtomatik ravishda kuyiladigan 

nuxtalar urtasidagi masofa  

   Sexrli taёkcha - Magic wand (Volshebnaya palochka) - [W] - bir xil rangli 
soxani tanlash. 

     Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib 
turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan 
foydalanib soxa tanlasak, u xoldatanlangan soxadan olib tashlash manosini 
bildiradi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

• SHIFT va ALT tugmalar xarakatlariga uxshash xolatlarni tanlash  
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• Tolerance - soxa tanlashda sexrli taёkchaning sezguvchanligini 
uzgartirish  

• Anti-Aliased optsiyasi tanlangan soxaning chegaralar rangini 
kuzga kurinmas kilib bir biriga moslash  

• Contiguous optsiyasi tanlangan soxa bita umumiy bulishini ёki 
bir nechta kismdan iborat bulishini taminlaydi  

• Use All Layers optsiyaci sexirli taёkchaning soxa tanlaganligi 
xama katlamlarga tegishli ёki fakat asosiy bulgan katlamga 
tegishligini taminlaydi  

     Tanlangan soxa ustidan biz xar xil xarkatlarni bajarishimiz mumkin. 
Masalan xotiraga kirkib olib ёki nusxa olib yangi katlamga uni kuyishimiz 
mumkin. Ёki uni xajmini uzgartirish va aylantirishimiz mumkin. Va nixoyat uni 
ish soxa buylab siljitishimiz mumkin. 

   Xarakatlanuvchi - Move (peremeshenie) - [V] - tanlangan soxani ish 
soxa buylab xarakatlantirish. 

     Agar ALT tugmani bosib xarakatlanishni boshlasak, u xolda tanlangan 
soxaning nusxasi olinib u xarakatlanadi. Agar esa SHIFT tugmasidan 
foydalansak, u xolda tanlangan soxa fakat vertikal va gorizontal 
xarakatlanadi. Tanlangan soxani klaviaturadagi yunalish strelkalari ёrdamida 
xam xarakatlantirish mumkin, shunda xar bita strelka bosilganida, tanlangan 
soxa 1 pikselga siljiydi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

• Auto Select Layer soxasi - sichkoncha ёrdamida aktiv bulmagan 
katlamni aktiv kilish.  

• Show Bounding Box - tanlangan soxa chegaralarida ramka xosil 
kilish. Ushbu ramka ёrdamida rasmni chuzish va aylantirish 
mumkin buladi.  

   Kadrlovchi - Crop (Kadrirovanie) - [C] - faylning kerak emas kismlarni 
kirkib olib rasmni kichkinalashtirish. Buning uchun kerakli soxani tanlab 
ENTER tugmasini bosamiz, agar tanlanishni bekor kilmokchi bulsak ESC 
tugmasini bosshimiz kerak. 

   Bulish pichokchasi - Slice (Narezka) - [K] - tasvirni bir nechta kismga 
bulib chikib uni İnternetda kismlarga bulingan xolatda chikarish uchun 
tayёrlab kuyadi. 

   Bulinishlarni sozlash - Slice select (Vıbor moduley) - [K] - bir nechta 
kismga bulingan tasvirni sozlash (bulaklarni chuzish). 
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     Xususiyatlar satrida kuydagilar aktiv buladi:  

• Style soxasi ёrdamida tanlash xolatini tanlaymiz. Normal - 
cheksiz soxa, Constrained Aspect Ratio - ёnlari kursatilgan 
proportsiyalardagi soxa tanlash, Fixed size - ёnlari kursatilgan 
kattaligidagi soxa tanlash.  

• Show Slice Numbers - kismlarni nomerlarini kursatish ёki 
kursatmaslik  

• Line Color - bulinish chegaralarini rangini uzgartirish  
• Promote To User Slice - bulinishlarni avtomatik gorizontal va 

vertikal davomlash  
• Slice Options tugmasi - bulakchaning xususiyatlarini uzgartirish 

va sozlash.  

20. Adobe Photoshop dasturning ish kurollari. Rasm taxrirlash. 

   Kalam - Pensil (karandash) - [B] - kalam ёrdamida chizish. 

   Muykalam - Paintbrush (kist) - [B] - chizish asosiy ish kuroli. Agar 
muykalamdan foydalangan vaktda Shift tugmasini bosib sichkoncha bilan 
chizsak, u xolda tugri chiziklar chiziladi. Shift tugma ёrdamida sichkoncha 
bosib nuxtalarni bir biri bilan boglash xam mumkin. Muykalam bilan chizilgan 
chiziklar kalamga karaganda chegaralari anik kurinmaydi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush - kalam turini va kalinligini tanlash  

•       Mode chiziklarni rasm ustida ёzilish xolatini uzgartirish  

•       Opacity chiziklar kurinmaslik darajasini uzgartirish  

•       Auto Erase - kalam fakat bush soxada chizishi mumkinlagini urnatish  

•       Wet Edges (mokrıe kraya - "xul chegaralar") akvarel bilan chizish 
effekti  

   Nusxa oluvchi Shtamp - Clone Stamp (kopiruyushiy shtamp) - [S] - 
rasmning boshka kismiga uxshash soxalar yaratish. Nusxa oluvchi soxani 
tanlashda Alt tugmadan foydalanamiz. 

   Nakshli Shtamp - Pattern Stamp (shtamp uzora) - [S] - siz Patterns 
soxasida tanlangan naksh bilan kursatgan soxani tuldirish. Agar uzi naksh 
yaratmokchi bulsangiz u xolda birinchidan turtburchak soxa tanlash ish kuroli 
bilan (Rectangular Marquee) naksh joylashgan soxani tanlaymiz, ikkinchidan 
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menyu Pravka (Edit) ga kirib uning ichidagi Naznachit uzor (Define Pattern) 
buyrukni tanlaymiz va natijada shu naksh Patterns soxasida paydo buladi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush - kalam turini va kalinligini tanlash  

•       Mode chiziklarni rasm ustida ёzilish xolatini uzgartirish  

•       Opacity chiziklar kurinmaslik darajasini uzgartirish  

•       Aligned - nusxa olingan soxani sichkoncha xarakatidan keyin 
uzgarishi ёki.  

•       Use All Layers optsiyaci sexirli taёkchaning soxa tanlaganligi xama 
katlamlarga tegishli ёki fakat asosiy bulgan katlamga tegishligini 
taminlaydi  

   Oldingi xolatga kaytish - History Brush (kist predıstorii) - [Y] - bu ish kurolni 
tanlashdan oldin siz kaytish kerak bulgan xolatni Predıstoriya (History) 
ёrdamchi soxada tanlab belgilab kuёishingiz kerak. Keyin esa ushbu ish kurol 
bilan xamma shu xolatdan keyin xarakatlarni kursatilgan soxada uchirishingiz 
mumkin buladi. 

   Effektli oldingi xolatga kaytish - Art History Brush (kist predıstorii so 
spetseffektami) - [Y] - oldingi xolatga kaytish ish kuroliga uxshash bulib, farki 
fakat oldingi xolatga kaytishda xar xil spetseffektlardan foydalaniladi. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush - kalam turini va kalinligini tanlash  

•       Mode chiziklarni rasm ustida ёzilish xolatini uzgartirish  

•       Opacity chiziklar kurinmaslik darajasini uzgartirish  

•       Style spetseffekt xolatini tanlash  

•       Fidelity - ranglardan foydalanish xolati. 100% - rasmdagi ranglar, 
0% - ranglar ixtiёriy olinadi  

•       Area - İsh kurolning tasir etish soxasi tanlash  

•       Spacing - ish kurolni fakat uxshash rangli soxalarda ishlash ёki xar 
xil rangli soxalarda xam ishlash.  
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   Aerograf - Airbrush (aerograf) - [J] - puliverizator xolatiga uxshash chizish 
ish kuroli. Agar aerografdan foydalanish vaktda Shift tugmasini bosib 
sichkoncha bilan chizsak, u xolda tugri chiziklar chiziladi. Shift tugma 
ёrdamida sichkoncha bosib nuxtalarni bir biri bilan boglash xam mumkin. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush - kalam turini va kalinligini tanlash  

•       Mode chiziklarni rasm ustida ёzilish xolatini uzgartirish  

•       Pressure - kraska sepish kuchi.  

   Uchirgich - Eraser (lastik) - [E] - asosiy katlamda rasm uchirish. Shift tugma 
ёrdamida sichkoncha bosib nuxtalarni bir biri bilan boglash xam mumkin. 

   Orka rangni uchirgichi - Background Eraser (lastik fona) - [E] - fakat orka 
rangni uchirish. 

   Sexirli uchirgich - Magic Eraser (volshebnıy lastik) - [E] - uxshash rangli 
soxalarni uchirish. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Uchirgich xolatlarini tanlash - muykalam (Paintbrush - kist), 
aerograf (Airbrush - aerograf), kalam (Pensil - karandash), blok 
(Block - blok). Blok xolatida sichkoncha kursori 16x16 piksel kvadrat 
kurinishida buladi. Blok kattaligi xech uzgarmaydi, shuning uchun 
rasmni 1600% masshtabida kurganimizda ushbu blok rasmning 1 piksel 
kattaliga teng buladi.  

•       Tolerance sezguvchanligi - rang uchirishda sezguvchanligini 
uzgartirish  

•       Protect Foreground Color oldingi rang uchirilishidan ximoyalanish.  

•       Uchirish yuli (Limits) - fakat cheklangan soxa ichida, 
(Discontiguous) bir xil rangli, (Contiguous) muykalam urtasidagi 
rangli, (Find Edges) uxshash rangli chegaralari.  

•       Sampling Uchiriladigan rang tanlash xolatini uzgartirish.  

•       Anti-Aliased Chegaralarni ёyilishi - uchiriladigan soxa chegaralar 
xolatini uzgartirish.  

•       Use All Layers optsiyaci sexirli uchirgich tasiri xama katlamlarga 
tegishli ёki fakat asosiy bulgan katlamga tegishligini taminlaydi  
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•       Opacity uchirish darajasini uzgartirish  

   Gradient rang berish - Gradient (gradient) - [G] - gradient ёki bitta rangdan 
boshkasiga utish rangi bilan tanlangan soxani tuldirish. 

   Orka rang berish - Paint Bucket (kovsh) - [G] - belgilangan soxani bitta 
rang ёki naksh (tayёr va biz yaratgan) bilan tuldirish. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Gradient Editor gradient rangli xolatlarini uzgartirish  

•       Gradient turlari: chizikli (Linear Gradient), radial (Radial 
gradient), burchakli (Angular gradient), oyna aksli (Reflected 
gradient), rombli (Diamond gradient)  

•       Revers gradientda birinchi va ikkinchi ranglarni urni bilan 
almashtirish  

•       Dither gradient rang bilan tuldirilishda chiziklar kurinishini uchirish  

•       Transparency rangsiz soxaga tuxsat berish belgisi.  

•       Rang bilan tuldirilish turini tanlash rang-Foreground ёki naksh-Pattern  

•       Pattern tuldirilish nakshini tanlash  

•       Mode rang bilan tuldirilish xolatini uzgartirish  

•       Opacity rang bilan tuldirilgan soxaning kurinmaslik darajasini 
uzgartirish  

•       Tolerance Sezguvchanligi (dopusk) - rang bilan tuldirilishda 
chegaralarga sezguvchanligini uzgartirish  

•       Anti-Aliased Chegaralarni ёyilishi - rang bilan tuldiriladigan soxa 
chegaralar xolatini uzgartirish.  

•       Contiguous - fakat chegaralangan soxani rang bilan tuldirish  

•       Use All Layers optsiyaci rang bilan tuldirilishda xama katlamlarda 
soxa chegaralarini aniklashni taminlaydi  

   Kontrast kamaytirish - Blur (razmıtie) - [R] - kontrastni kamatirish ёki 
ranglarni ёyish. 
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   Kontrast kupaytirish - Sharpen (rezkost) - [R] - kontrastni kupaytirish ёki 
ranglarni aniklashtirish. 

   Rang tortish - Smudge (razmazıvatel) - [R] - rang ёyish ёki tortish. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush - sichkoncha kurinishi turini va kalinligini tanlash  

•       Mode ranglarni uzgartirish xolatini sozlash  

•       Pressure ёyish kuchini uzgartirish  

•       Use All Layers optsiyaci ёyilish tasiri xama katlamlarga tegishli ёki 
fakat asosiy bulgan katlamga tegishligini taminlaydi  

•       Finger Painting rangga botirilgan barmok bilan chizish efektiga 
utish.  

   Ochrok kilish - Dodge (osvetlitel) - [O] - tasvir ranglarini ochrok kilish. 

   Tukrok kilish - Burn (zatemnitel) - [O] - tasvir ranglarini tukrok kilish. 

   Rang xullash - Sponge (gubka) - [O] - tasvir ranglarini kuchaytirish . 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Brush- sichkoncha kurinishi turini va kalinligini tanlash  

•       Range tasir kursatish lozim bulgan ranglar turini tanlash (Shadows - 
tuk ranglar, Midtones - xamma ranglar va Highlights -och ranglar).  

•       Exposure ranglarni ochaytirish kuchini uzgartirish.  

•       Mode ranglarni uzgartirish xolatini sozlash (Desaturate - kamaytirish 
ёki Saturate - kupaytirish).  

•       Pressure ish kurolning tasirining kuchini uzgartirish.  

21. Adobe Photoshop dasturning ish kurollari. Matn va grafik shakllar yaratish. 

   Matn - Type (tekst) - [T] - tasvirga matn kushish. Ushbu ish kurol ishlatilgandan 
keyin yangi katlam paydo buladi (Text Layer). 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       oddiy matn ёki matn chegaralari xolati  
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•       matn yunalishini uzgartirish  

•       matn xarflar shaklini uzgartirish  

•       matn xarflar kurinishini zgartirish (kalin, ёtik, tagi chizikli)  

•       matn xarflar kattaligini uzgartirish  

•       matn chegaralar turini uzgartirish  

•       matn abzatsda joylanishi: chap, urta ёki ung tomon buyicha  

•       matn rangini uzgartirish soxasi  

•       Warp Text - matn kiyshaytirish xolatlari  

•       Palettes tugmasi - matn xususiyatlarini uzgartirish oynasi bilan ishlash  

   Turtburchak - Rectangle (pryamougolnik) - [U] - turtburchak chizish. 

   Aylanasimon turtburchak - Rounded Rectangle (skruglёnnıy pryamougolnik) - [U] 
- aylanasimon turtburchak chizish. Xususiyatlar satrida burchaklar radiusini 
uzgartirish soxasi - Radius paydo buladi. 

   Aylana - Ellipse (ellips) - [U] - aylana chizish. 

   Kupburchak - Polygon (mnogougolnik) - [U] - kupburchak chizish. Kupburchak 
tomonlarning sonini Sides soxa ёrdamida kursatish mumkin. 

   Chizik - Line (liniya) - [U] - tugri chizik chizish. Chizik kalinligini Weight soxa 
rdamida uzgartirish mumkin. 

   Maxsus shakllar - Custom Shape (proizvolnaya figura) - [U] - xar xil tayёr shakllar 
chizish. Xususiyatlar satridagi Shape soxasi ёrdamida kerakli shaklni tanlashimiz 
mumkin. 

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       shakl chizilish xolatini uzgartirish tugmalari (yangi katlamda - Create New 
Shape Layer, fakat yul - Create New Work Path, aktiv katlamda - Filled 
Region)  

•       shakl turini tanlash tugmalari.  

•       shakl chizish yullari (Unconstrained - ixtiёriy, Square - teng tomonli, Fixed 
Size - kursatilgan razmerli, Proportional - proportsiyali).  

•       Layer Style - rang bilan buyash turi  
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   Kul - Hand (ruka) - [H] - agar rasm ekranga tulik sigmasa u xolda bu ish kurolni 
tanlab sichkoncha ёrdamida rasmni siljitish mumkin. Rasmni ekranning ung va pastki 
kismlarda joylashgan kurib chikish soxalar orkali xam siljitish mumkin, ammo bu ish 
kurol ёrdamida siljitish kulayrok va bu ish kurolni xoxlagan vaktda "bush joy" 
(probel) tugmasini bosib turib vaktinchaga ёkib turish mumkin. Bush joyni 
kuyvorsangiz ish kurol yana avvaldagi xolatga kaytadi.  

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Actual Pixels [Ctrl+Alt+0] - 100% ekran xolatiga utish tugmasi , ushbu 
xolatda rasmning 1 piksel ekrandagi 1 pikselga mos buladi  

•       Fit On Screen [Ctrl+0] - tulik ekran xolatiga utish tushmasi. Bu tugma 
ёrdamida rasm oyna xajmigacha chuziladi.  

•       Print Size - kogozga bosma (pechatlanib) chikganda kanday chikishini 
kursatuvchi tugma.  

   Lupa - Zoom (lupa) - [Z] - ekrandagi rasmni kurish masshtab foizini uzgartirish 
mumkin. Yakinlashtirish uchun sichkoncha bilan kerakli rasm kismiga kursatib bir 
marta bosish kerak, ёki yakinrok kurish kerak bulgan soxani sichkoncha bilan bosib 
turib tanlash kerak. Agar esa uzoklashtirish kerak bulsa u xolda klaviaturada Alt 
tugmasini bosib turib sichkoncha bilan rasmga bir marta bosamiz. Ushbu ёrdamchi 
tugma xarakatlarni tezkor tugmalar orkali xam bajarish mumkin: Zoom In 
[Ctrl+Plyus] - rasmni yakinlashtirish, Zoom Out [Ctrl+Minus] - rasmni 
uzoklashtirish, Actual Pixels [Ctrl+Alt+0] - rasmni 100% ekran xolatiga utish 
tugmasi, Ctrl+Alt+Plyus - rasmni oyna bilan birgalikda kattalashtirish, 
Ctrl+Alt+Minus - rasmni oyna bilan birgalikda kichkinalashtirish, Fit On Screen 
[Ctrl+0] - rasm va oynani tulik ekran xolatiga utkazish.  

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       Resize Windows To Fit - rasmni oyna bilan birga uzgarish xolatini ёkish.  

•       Ignore Palettes - oyna kattalashganda ung tomondagi ёrdamchi soxalar 
orkasiga utish mumkinligi ёki mumkin emasligini uzgartirish.  

•       Actual Pixels [Ctrl+Alt+0] - 100% ekran xolatiga utish tugmasi , ushbu 
xolatda rasmning 1 piksel ekrandagi 1 pikselga mos buladi.  

•       Fit On Screen [Ctrl+0] - tulik ekran xolatiga utish tushmasi. Bu tugma 
ёrdamida rasm oyna xajmigacha chuziladi.  

•       Print Size - kogozga bosma (pechatlanib) chikganda kanday chikishini 
kursatuvchi tugma.  

   Pero - Pen (pero) - [P] - sichkoncha ёrdamida nuktalar orkali shaklni yaratish.  
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   İxtiёriy pero - Freeform Pen (proizvolnoe pero) - [P] - sichkoncha ёrdamida xarakat 
orkali shaklni yaratish.  

   Yangi nukta kushish - Add Anchor Point (dobavit tochku) - [net] - sichkoncha 
ёrdamida shaklga yangi burilish nukta kushish.  

   Nukta uchirish - Delete Anchor Point (udalit tochku) - [net] - sichkoncha ёrdamida 
shakldan burilish nuktasini uchirish.  

   Nukta uzgartirish - Convert Point (preobrazovat tochku) - [net] - shakl 
nuktalarining joylanishini uzgartirish (chuzish).  

   İzoxlar - Notes (zametki) - [N] - rasm ixtiёriy soxasiga matnli izox kushish.  

   Tovush izoxlar - Audio Annotation (zvukovoe opisanie) - [N] - rasm ixtiёriy 
soxasiga tovush izoxni mikrafon orkali kushish. Paydo bulgan oynada Start tugmasini 
bosib ёzishni boshlaymiz, tuxtatish uchun Stop tugmasini bosamiz, ёzish oynasidan 
chikib ketish uchun Cancel tugmasini bosamiz.  

   Tomizgich (pipetka) - Eyedropper (pipetka) - [I] - ixtiёriy rangni kayta asosiy rang 
kilib tanlash imkoniyatini yaratadi. Agar sizga orka rang kilib tanlash kerak bulsa u 
xolda Alt tugmasini bosib turishingiz shart buladi.  

   Ranglarni solishtirish - Color Sampler (sravnenie tsvetov) - [I] - Info ёrdamchi 
soxada 4 nuktalar ranglari xakidagi malumotlarni kursatish imkoniyatini yaratadi. 
Nuktani sichkoncha ёrdamida kuyamiz, uchirish uchun esa Alt tugmasini bosib turib 
sichkoncha bin nuktaga bosish kerak.  

   Chizgich- Measure (izmeritel) - [I] - rasmdagi masofani aniklash uchun kullaniladi. 
Agar Alt tugmasidan foydalanib chizgich boshidan ёki oxiridan yana bitta chizik 
chizish mumkin va u ёrdamida transportir sifatida foydalansa buladi, chunki ikkita 
chiziklar xosil kilgan burchak ulchamini kursatadi.  

     Xususiyatlar satrida kuydagilar aktiv buladi:  

•       boshlovchi nukta koordinatalari (X, Y)  

•       birinchi nuktadan ikkinchisigacha bulgan masofa vertikal va gorizontal 
buyicha (W, H)  

•       X uki buyicha egilish burchagi (A)  

•       birinchi nuktadan ikkinchisigacha bulgan masofa (D1)  

•       birinchi nuktadan uchinchigacha bulgan masofa (transportirdan 
foydalanganda) (D2)  

•       Clear - chizgichni uchirish tugmasi  
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   Ushbu tugma bir nechta amalni bajaradi:  
1) Asosiy rangni tanlash - Set Foreground Color (vıbrat tsvet perednego plana) - ustki 
turgan rang kursatkichini (turtburchagini) bir marta bosib, xosil bulgan oynadan rang 
tanlaymiz.  
2) Orka ёki ichki rang tanlash - Set Background Color (vıbrat tsvet fona) - pastki 
turgan rang kursatkichini (turtburchagini) bir marta bosib, xosil bulgan oynadan rang 
tanlaymiz.  
3) Asosiy va orka ranglarni uzgartirish Switch Foreground and Background Colors 
(pereklyuchit tsvet perednego plana i tsvet fona) [X] - asosiy va orka ranglar 
kursatkichlari (turtburchaklari) ustida joylashgan strelka ёrdamida asosiy va orka 
ranglarni uzaro urnini uzgartirish.  
4) Avtomatik asosiy va orka ranglarni kora va okga utkazish - Default Foreground 
and Background Colors (ustanovit tsvet perednego plana i tsvet fona po 
umolchaniyu) [D] - asosiy va orka ranglar kursatkichlari (turtburchaklari) tagida 
joylashgan kichkina belgilar ёrdamida asosiy rangni - kora, orka rangni esa okga 
utkazish.  

   Ekran xolati - Screen Mode (rejim ekrana) - [F] - ekran xolatini uzgartirish tugmasi. 
Birinchi standart xolat - standartnıy (Standard Screen Mode) - asosiy xolat, rasm 
oynasi, menyu satri, ish kurollar soxasi va ёrdamchi soxalar kurinadigan xolat. 
İkkinchi menyuli tulik ekran xolati - polnoekrannıy so strokoy menyu programmı 
(Full Screen Mode with Menu Bar) - tulik ekran xolati, nom satri, oyna chegaralari, 
malumotlar satri va kurib chikish soxalari kurinmaydi. Uchinchi menyusiz tulik 
ekran xolati - polnoekrannıy (Full Screen Mode) - tulik ekran xolati, oldingiga 
karaganda menyu satri xam kurinmaydigan xolat.  

   ImageReady dasturga utish - Jump to ImageReady (pereklyuchitsya v ImageReady) 
- [Ctrl+Shift+M] - ochik rasmni ImageReady dasturga utkazadi va unda taxrirlashni 
davom etishga imkoniyat yaratadi.  

22. Adobe Photoshop dasturning menyusi. Menyu Image - Obraz, Select - Vıbor 
va Edit - Redaktirovanie. 

     Rasm ranlarini, xajmini va boshka xususiyatlarini uzgartirish uchun 
maxsum menyu bulimi Image buyruklaridan foydalanish kerak. Bulardan eng 
asosiylar bilan tanishaylik:  

•       Rejim - Rejim (Mode) - buyrugi rasm rejimini uzgartirish. Asosiy 
rejimlar:  
Grayscale - kul rang xolatiga utkazish,  
Indexed Color - kursatilgan ranglar soni xolatiga utkazish (256 
gacha), 
CMYK Color - turta asosiy ranlar orkali kodlash (moviy, sarik, kora va 
kizgish ranglar), 
RGB Color - uchta asosiy ranglar orkali kodlash (kizil, yashil, kuk)  
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•       Taxrirlash - Korektirovka (Adjust) - bu bulimda joylashgan buyruklarni 
aksariyati rasmni ranglar ustidan xar xil taxrirlash amallarni bajarish 
uchun ёrdam beradi:  
Urovni - Levels - Nastroyka urovnya (nu, eto, kak bı, yarkost)  
Avtourovni - Auto Levels - To je samoe, no avtomaticheski  
Avtokontrast - Auto Contrast - Avtomaticheskaya nastroyka 
kontrasta  
Tsvetovoy balans - Color Balance - Tsvetovoy balans  
Yarkost/Kotrast - Bright/Consrast - Yarkost i kontrast  
Ottenok/Nasıshennost - Hue/Sturation - Pozvolyaet kak bı 
"smeshat" tsveta  
Zamenit tsvet - Replace Color - Mojno izmenit kakoy-to 
opredelennıy tsvet v risunke  
Variations - Eto prekrasnaya vesh dlya tex, komu len dumat. Zdes 
mojno nastroit tsvetovoy balans, kontrast i nasıshennost. Samoe 
priyatnoe, chto vam srazu pokazıvayut neskolko variantov izmeneniya. 
Ostaetsya tolko vıbrat, kakoy vam bolshe nravitsya. Posle togo, kak 
vıberete, vam predlojat eshe variantı. Krome variantov, na ekrane 
prisutstvuet isxodnoe i poluchivsheesya na dannıy moment izobrajenie.  

•       Image Size İzmenenie razmera kartinki. Mojno izmenyat s 
soxraneniem proportsiy i bez. Vıdeleniya zdes ne uchitıvayutsya.  

•       Rotate Canvas Razvorotı, povorotı, otrajeniya vsey kartinki tselikom.  

     Soxa tanlash - bu fotomontajning eng asosiy xarakatlardan biri. Shuning 
uchun bu xarakatlarga doir bulgan Select menyu bulim buyruklari bilan 
yakinrok tanishaymiz. Soxa tanlash ish kurollar bilan biz yukoridagi 
mavzularda tanishganmiz. Ushbu ish kurollar bilan rasmning ixtiriy soxa 
tanlaganimizda, u punktir chiziklar bilan chegaralanib kurinadi.  
     Agar shu tanlangan soxaga yana boshka ixtiёriy soxani kushish uchun, 
Shift tugmasini bosib kushimcha soxani tanlaymiz. 
     Agar esa shu tanlangan soxadan bir kismini tanlangandan chikarib olish 
uchun, Alt tugmasini bosib shu soxani tanlaymiz.  

     Endi Select menyusining asosiy buyruklari bilan tanishaylik.  

•       Xammasini tanlash - Vse (All) -{Ctrl+A}- butun rasm soxasini tanlash.  

•       Tanlashdan chikarish - Razotmenit (Deselect) -{Ctrl+D}- Tanlangan 
soxani bekor kilish.  

•       Tanlashni ogdarish - İnversiya (Inverse) - Tanlangan soxani 
tanlovdan chikarib, tanlanmagan soxani tanlash.  
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•       Rang orkali tanlash - Diapazon tsvetov (Color Range) - Rang asosida 
tanlash. Sexirli taёkcha rdamchi tugmaga uxshash xolatida ishlaydi.  

•       Chegaralar - Rastushevka (Feather) - tanlangan soxaning chegaralari 
kalinligini aniklash.  

•       Uzgartirishlar - İzmenit (Modify) - tanlangan soxani xar xil xolatlar 
bilan uzgartirish. Asosiy xolatlar: 
Chegaralar - Ramka (Border) - Tanlangan soxa chegaralari buyicha 
siz kursatgan xajmda tanlangan ramka soxasini yaratadi. 
Chegara silliklashtirish - Sglajivanie (Smooth) - Tanlangan 
soxaning burchakli chegaralarini yumshok va silliklashtiradi. 
Kattalashtirish - Rastyanut (Expand) - Tanlangan soxani siz 
kursatgan masofani proportsional kattalashtiradi. 
Kichkinalashtirish - Svernut (Contract) - Tanlangan soxani siz 
kursatgan masofani proportsional kichkinalashtiradi.  

•       Ёnidagilarni kushish - Smejnıe pikseli (Grow) - Ёnida joylashgan 
uxshash ranglarni xam tanlangan soxaga kushish.  

•       Uxshashlarni kushish - Sxojie pikseli (Similar) - ixtiёriy joyda 
joylashgan uxshash ranglar soxalarini tanlangan soxaga kushish.  

•       Tanlangan soxani uzgartirish - Preobrazovat vıdelenie (Transform 
Selection) - tanlangan soxani ixtiёriy xolatda chuzish va uzgartirish.  

     Tanlangan soxaning shaklini uzgartirish va u ustidan xar xil amallarni 
bajarish mumkin. Buning uchun bizga Redaktirovar - Edit menyu buyruklari 
bizga ёrdam beradi. Masalan tanlangan soxa nusxasini xotiraga olish va kirkib 
olish (Kopirovat-Copy, Vırezat-Cut), xotiradan chikarish (Vstavit-Paste). Endi 
kolgan buyruklar bilan tanishaylik:  

•       Erkin uzgartirish - Svobodnoe preobrazovanie (Free Transform)- 
ushbu buyruk natijasida tanlangan soxa ёki rasm chegaralarida maxsus 
nuxtalar paydo buladi. Ular ёrdamida tanlangan soxani chuzish, 
egeltirish, aylantirish va boshka xarakatlarni bajarishimiz mumkin.  

•       Uzgartirish - Preobrazovanie (Transform)- ushbu buyruk ichida bir 
nechta imkoniyatlar mavjud:  
Scale - İzmenenie razmerov po gorizontali i vertikali  
Rotate - Vrashenie  
Skew - Ottyagivanie odnogo iz uglov  
Distort - Ottyagivanie neskolkix uglov  
Perspective - Effekt perspektivı  
Numeric - Modifikatsiya pri pomoshi zadaniya chislennıx znacheniy  
Rotate 180 - Povorot na 180 gradusov  
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Flip Horizontal - Razvorot po gorizontali  
Flip Vertical - Razvorot po vertikali  

     Kak vidno, primeniv neskolko punktov iz etogo menyu, mojno sdelat 
ochen mnogoe. Mojno sdelat fotomontaj. Pri pomoshi vıdeleniya i 
redaktirovaniya mojno iz neskolkix fotografiy vzyat raznıe predmetı i lyudey i 
sovmestit ix na odnoy. Esli xorosho potrenirovatsya, mojno delat xoroshie 
kompromatı. Naprimer, vozmem fotografiyu bani... xotya, eto otdelnaya 
tema.  

23. Adobe Photoshop dasturning menyusi. Menyu Layer 
- Sloi va Filtr - Filtr 

 Menyu Layer Sloi: raspredeleniya izobrajeniya na sloyax, otobrajenie 
sloev v dokumente, kak pokazıvat i pryatat sloi, vıdelenie sloev, 
pereimenovanie sloev, redaktirovanie fonovogo sloya, izmenenie rejima 
otobrajeniya pozrachnıx oblastey sloya, dobavlenie novogo sloya. 
RASPREDELENİE İZOBRAJENİYa NA SLOYaX V Adobe Photoshop 
izobrajeniya mogut soderjat odin ili neskolko sloev. Novıe faylı 
sozdayutsya s sloem zadnego plana (background), kotorıy mojno 
preobrazovat v obıchnıy. Esli otskanirovat kartinku i otkrıt ee v 
Photoshop, ona pomeshaetsya na zadniy plan. Sloi v Photoshop mojno 
sravnit s listami prozrachnoy plenki s nanesennımi na nix fragmentami 
izobrajeniya - slojite takie listı stopkoy, i pered Vami polnaya kartina. 
Fragmentı mojno redaktirovat, menyat mestami ili udalyat otdelnıe listı 
plenki bez usherba dlya tselostnosti risunka. Poryadok raspolojeniya 
sloev nazıvaetsya posledovatelnostyu. Ona opredelyaet obshiy xarakter 
izobrajeniya. Chtobı kakie-to predmetı naxodilis na perednem plane i 
zakrıvali soboy drugie, prosto izmenite posledovatelnost sloev. 
OTOBRAJENİE SLOEV V DOKUMENTE İznachalno pustıe sloi 
prozrachnı. S poyavleniem na sloe izobrajeniya (pikselov) prozrachnost 
narushaetsya. Pro-zrachnıe oblasti sloya otobrajayutsya na ekrane v 
vide kletchatogo uzora. < br> PANEL LAYERS Panel Layers (Sloi) slujit 
dlya upravleniya sloyami dokumenta: pozvolyaet sozdavat novıe sloi, 
menyat mestami sushestvuyushie, udalyat ili obedinyat ix, a takje 
sozdavat interesnıe effek-tı s pomoshyu rejimov nalojeniya. 1 Esli panel 
Layers (Sloi) ne vidna, vızovite ee komandoy Window > Show Layers 
(Okno > Pokazat sloi). 2 V sluchae neobxodimosti shelknite koreshok 
Layers, i vkladka sloev vıydet na peredniy plan. 3 Shelknuv knopku 
razvertıvaniya v verxnem pravom uglu titulnoy stroki, raskroyte panel 
polnostyu. (Razmer paneli zavisit ot kolichestva sloev v dokumente.) Na 
paneli sverxu vniz otobrajayutsya vse sloi aktivnogo dokumenta. Sleva 
ot zagolovka sloya naxoditsya ego miniatyura, avtomaticheski 
obnovlyayushayasya pri vnesenii v izobrajenie izmeneniy. KAK 
POKAZIVAT İ PRYaTAT SLOİ Piktogramma "glaz" v levom vertikal-nom 
ryadu paneli oznachaet, chto dannıy sloy vidim. Shelkaya eti 
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piktogrammı, mojno pryatat ili pokazıvat svyazannıe s nimi sloi. 
Protyagivanie vdol vertikalnogo ryada vklyuchaet i otklyucha-et srazu 
neskolko sloev. 1 Protyanite po "glazam" sverxu vniz, chtobı stali vidnı 
vse sloi izobrajeniya. 2 Snova protyanite po "glazam" - sloi stanut 
nevidimımi, i izobrajenie is-cheznet s ekrana. Esli vse sloi spryatanı, 
oblast, zanima-emaya izobrajeniem, prozrachna, o chem svidetelstvuet 
kletchatıy uzor. 3 Shelkaya "glaz" naprotiv otdelnıx sloev ili 
protyagivaya srazu po neskol-kim piktogrammam sverxu vniz, popro-
buyte vıvesti na ekran razlichnıe kombinatsii sloev. 4 Protyanuv po 
vertikalnomu ryadu "glaz", otklyuchite srazu vse sloi izobra-jeniya. 
Mojno ostavit tolko odin sloy, a vse ostalnıe spryatat. 5 Pri najatoy 
klavishe ili Alt shelknite "glaz" naprotiv sloya, kotorıy Vı xotite ostavit, - 
vse ostalnıe sloi stano-vyatsya nevidimımi. 6 Chtobı snova pokazat vse 
sloi, na-jmite klavishu Option (Macintosh) ili Alt (Windows) i shelknite 
tot je "glaz". VIDELENİE SLOEV Sloi vıdelyayutsya i redaktiruyutsya po 
od-nomu. Vıdelennıy sloy nazıvaetsya ak-tivnım. Kogda sloy aktiven, 
protiv ego zagolovka v vertikalnom ryadu sprava ot "glaza" 
poyavlyaetsya piktogramma "kist". İZMENENİE POSLEDOVATELNOSTİ 
SLOEV Chtobı izmenit poryadok razmesheniya otdelnıx elementov 
izobrajeniya, dostatochno izmenit posledovatelnost slo-ev. 
PEREİMENOVANİE SLOEV Dialogovoe okno Layer Options (Para-metrı 
sloya) pozvolyaet pereimenovıvat sloi. 1 Dvajdı shelknite kakoy-libo 
sloy na pane-li Layers. 2 V otkrıvshemsya dialogovom okne Layer 
Options vvedite novoe nazvanie i shelknite knopku OK. 3 Komandoy 
File > Save soxranite rabotu. REDAKTİROVANİE FONOVOGO SLOYa Po 
umolchaniyu sloi zadnego plana (background) vsegda samıy nijniy na 
pa-neli Layers i ne mojet bıt peremeshen, a ego nazvanie otobrajaetsya 
kursivom. Pri popıtke peremestit sloy zadnego plana poyavlyaetsya 
piktogramma, predup-rejdayushaya o nevozmojnosti zadumanno-go 
deystviya. Chtobı peredvinut zadniy plan ili izmenit stepen ego neproz-
rachnosti, pridetsya snachala preobrazo-vat ego v obıchnıy sloy putem 
prostogo pereimenovaniya. 1 Dvoynım shelchkom sloya background na 
paneli Layers vızovite dialogovoe okno Make Layer (Obrazovat sloy). 2 
Vvedite nazvanie i shelch-kom knopki OK zakroyte dialogovoe okno. 
Teper sloy zadnego plana pere-imenovan, i ego mojno redaktirovat, kak 
lyuboy drugoy. İZMENENİE REJİMA OTOBRAJENİYa PROZRAChNIX 
OBLASTEY SLOYa Mı uje govorili, chto prozrachnıe obla-sti sloya ili 
izobrajeniya predstavlenı v vide kletchatogo uzora. Vı mojete iz-menit 
tsvet ili razmer kletok ili ubrat ix voobshe. 1 Uderjivaya klavishu Alt, 
shelknite "glaz" naprotiv kakogo-libo sloya, chtobı sprya-tat vse sloi, 
krome etogo. Vıberite komandu File > Preferences > Transparency & 
Gamut (Fayl > Ustanov-ki > Prozrachnost i tsvetovoy oxvat). Chtobı 
umenshit razmer kletki, v spiske Grid Size (Setka) vıberite variant Small 
(Melkaya) V spiske Grid Color (Tsveta) vıberite odin iz predlojennıx 
tsvetov. Poeksperimentiruyte s razmerom i tsvetami kletchatogo uzora. 
Prejde chem zakrıt dialogovoe okno Transparency & Gamut, v spiske 
Grid Size (Setka) vıberite variant None (He zada-na), chtobı otklyuchit 
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otobrajenie klet-chatogo uzora. Primechanie: Esli v pole Grid Size (Set-
ka) vıbrat variant None (He zadana), prozrachnıe oblasti sloya budut 
predstav-lenı belım tsvetom. Shelknuv knopku OK, zakroyte dialo-govoe 
okno. DOBAVLENİE NOVOGO SLOYa V menyu paneli Layers vıberite 
New Layer (Novıy sloy). REJİMI NALOJENİ SLOEV Normal/Normalnıy 
Dissolve/Rastvorenie Multiply/Umnojenie Screen/Osvetlenie 
Overlay/Perekrıtie Soft light/Myagkiy svet Hard light/jestkiy svet Color 
Dodge/Osvelenie osnovı Color Burn/Zatemnenie osnovı Darken/Zamena 
temnım Lighten/Zamena svetlım Exclussion/İsklyuchenie 
Hue/Tsvetovoy ton Saturate/Nasıshennost Color/Tsvetnost 
Luminosity/Yarkost Sloi v rastrovom redaktore - eto kruto! Eto daet 
vozmojnosti, kotorıe ranshe bıli tolko v vektornoy grafike. İtak, chto je 
takoe sloi? Predstavte sebe, chto u vas na stole neskolko kuskov 
okonnogo stekla, polojennıx drug na druga. Na kajdom stekle vı chto-to 
narisovali markerom (risovat karandashom na steklax mne eshe ne 
udavalos) i teper smotrite na vse eto delo sverxu. Schitayte, chto stekla 
- eto i est sloi. Sloy mojno sdelat nevidimım, t.e. vıtashit steklo iz stopki 
i ubrat ego podalshe. Sloi mojno pomenyat mestami i togda risunki 
budut perekrıvat drug druga inache. Mojno risovat tolko na odnom sloe, 
sovershenno ne zatragivaya drugix. Estestvenno, chto esli vı zakrasite 
kakoy-to sloy sploshnım risunkom bez dırok, to vı ne uvidite, chto 
narisovano na nijnix sloyax. Xotya mojno sdelat sloy poluprozrachnım. 
Esli risunki sostoyat, v osnovnom, iz liniy i nezakrashennıx oblastey, to 
u vas budet prosvechivat stol. V Photoshop skatert na stole v sero-
beluyu kletochku. Esli vam ne xochetsya sozertsat etu skatert, to 
podlojite v samıy niz sloy, polnostyu zakrashennıy belım tsvetom. 
Soxranit risunok so sloyami mojno tolko v nekotorıx spetsialnıx 
formatax. Tak chto, dlya podgotovki risunka k publikatsii v İnternet, vam 
pridetsya ego perevesti v kakoy-to drugoy format bez sloev (v GIF ili 
JPEG). Dlya rabotı so sloyami est spetsialnaya palitra Layers. Na ney 
viden spisok vsex sloev, s ix nazvaniyami i umenshennımi 
izobrajeniyami. Esli ryadom so sloem izobrajen glaz, eto znachit, chto 
sloy vklyuchen. Esli ryadom so sloem izobrajena kist, to znachit, esli vı 
budete zanimatsya redaktirovaniem, to redaktirovat vı budete imenno 
etot sloy. Bukva T oboznachaet, chto sloy tekstovıy. Tekst v sloyax 
xranitsya ne kak nabor tochek, a imenno kak tekst, kotorıy mojno 
redaktirovat (tak budet, poka vı ne solete tekst s obıchnım sloem). Esli 
stoit bukva f, znachit, na sloe est "effekt". Optsii dlya sloya mojno zadat, 
shelknuv na nem pravoy knopkoy mıshki i vıbrav v poyavivshemsya 
menyu Layer Options. Zdes mojno zadat prozrachnost sloya, rejimı 
nalojeniya i t.d. Estestvenno, sloi mojno udalyat i sozdavat novıe. Sloi 
mojno menyat mestami. Menyu Layers Dlya rabotı so sloyami est 
menyu Layers. Mnogoe iz togo, chto zdes est, mojno sdelat i v paneli 
Layers pri pomoshi xitroumnıx manipulyatsiy s mıshkoy. " New - Sozdat 
novıy sloy " Duplicate Layer - Sdelat kopiyu sloya " Delete Layer - Udalit 
sloy " Layers Option - Zadat optsii sloya " Effect > Chego_to_tam - 
Zadanie effektov mejdu sloyami (podrobnee chut nije) " Arange > 
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Chego_to_tam - Peremeshenie sloev vverx ili vniz " Merge Down - 
Sliyanie dvux sloev v odin 
§23. Effektı i filtrı Filtrı v Photoshop pozvolyayut iskajat, izmenyat, 
stilizirovat, modifitsirovat i t.p. vashi izobrajeniya. V Photoshop vxodit 
ochen bolshoy nabor filtrov, a esli daje vam ix pokajetsya malo, to 
mojno dostat i ustanovit dopolnitelnıe. Chtobı ix vızvat, vam nujno zayti 
v menyu Filter, vıbrat tam gruppu filtrov, a zatem vıbrat sam filtr. Posle 
vıbora, filtr primenitsya k vashemu risunku ili vıdelennomu uchastku. U 
mnogix filtrov est dialogi nastroek. Chasto mojno proizvodit nastroyku 
filtra i odnovremenno nablyudat rezultat. Rassmotrim osnovnıe gruppı 
filtrov, i popıtaemsya ix opisat. Xotya, esli chestno, to slovami opisat 
filtrı dovolno trudno. O nix nado ne rasskazıvat, a smotret na rezultatı. 
Tak chto, posle togo, kak zakonchite chitat etot razdel, poigrayte sami s 
filtrami. Chtobı polnostyu razobratsya so vsemi filtrami, nado potratit ne 
odin den. Chasto, chtobı vıbrat podxodyashiy filtr, prixoditsya vıbirat ix 
metodom perebora. A bıvaet ne yasno, chto je xochetsya poluchit, 
togda tem bolee mojno proizvolno vıbirat filtrı i smotret, chto 
poluchitsya. " Artistic - İmitatsiya raznıx priemov risovaniya " Blur - 
Razmıtie, razmazıvanie. " Brush Strokes - İmitatsiya rabotı kistyu. " 
Distort - Deformatsiya. " Noise - Rabota s shumom i defektami. 
Dobavlenie i udalenie. " Pixelate - Rabota s pikselyami. Obedinenie 
piksley po raznım zakonam. Stilizatsiya. " Render - Vsyakie 
iskusstvennıe effektı. Bliki, otsvetki, oblachka. " Sharpen - Delaet 
izobrajenie bolee rezkim. " Sketch - İmitatsiya vsyakix stiley i priemov " 
Stilize - Toje imitatsiya vsyakix stiley i priemov. " Texture - Sozdanie 
tekstur. 


